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Welcome to PhotoImpact
Congratulations on purchasing Ulead PhotoImpact 3.0, the standard in
imaging for Microsoft Office users. This next generation image editing
software mixes 32-bit power for Windows 95 with unmatched ease-of-use.
Using its Microsoft Office-style interface and Guided Workflow™ tools,
you'll glide easily from scanning to image enhancement to placement in
your document or presentation. Auto-processing tools let you straighten,
crop and adjust your scanned images, while the EasyPalette will allow you
to visually “Pick & Apply™” a wide range of effects, styles, textures and
gradients. Free distortion of text, extensive object and layer control and a
variety image retouching tools are just a few of the other features that make
this the perfect complement to any desktop. When words alone won't
suffice, Ulead PhotoImpact is the key to achieving your business goals.

Introduction

Introduction at a glance

User Guide Wizard ..........................................................................................................8

Installation ........................................................................................................................9

What’s new in version 3•0.............................................................................................10
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User Guide Wizard
To learn about PhotoImpact as quickly and easily as possible, use the
following user guide wizard. This will help you better locate information
which is important to you, as well as relevant to the way you work.

I never read manuals

Go to:

The on-line help. It’s there, always at hand and with quick access. It gives
you the information you want when you want it. Also, learn the quick keys,
such as the command short cut and hot keys, as these can help speed up the
way you work, particularly if you are comfortable using both your mouse and
keyboard at the same time.

I have used Ulead programs before

Go to:

What’s new, p.10. Here you will find information about the new additions to
this version. Once familiar, you can go straight to the program and start
working on your own documents. If you need some help in understanding
tools and commands, use the on-line help. It’s also a good idea to take a look
at the tutorials, both on-line and within this guide, to get a better feel for the
new enhancements.

I am a first time user

Go to:

What’s new, p.10. This will give you an overview of PhotoImpact and what it
can do for you. Once finished, try out the tutorials. These take you through
some of the more common procedures for the PhotoImpact and Album
programs. You can also try out the PhotoImpact interactive tutorial (on the
PhotoImpact CD). This shows you both basic and advanced techniques,
allowing you to interact with the program, and to learn – not just by viewing,
but also by doing.

I am an office user

Go to:

Chapter 8, Album: Getting started, p.173. This shows you how you can
integrate all your work via the Album program. Once finished, try out the
tutorial “Using Album with other programs” p.69. This provides an example
of using Album to embed files into a Microsoft Word document.
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Installation
The PhotoImpact installation program runs from within Windows and
contains complete instructions on the installation process.

To install PhotoImpact:

1. Read the license agreement that comes with the PhotoImpact package.
(The license agreement is important as it contains various legal
requirements that you need to be aware of.) If you agree to abide by it,
continue with the installation.

Note: Please take a moment to fill out the Registration card during
installation. Becoming a registered user entitles you to product update and
upgrade information, as well as technical support.

2. Turn on your computer and wait for Windows to open.

3. Insert the PhotoImpact CD into your CD drive. Windows should detect
the CD and then automatically run the installation program. If the
automatic detection feature is turned off, use Windows Explorer to run the
INSTALL.EXE program directly from your CD-ROM drive.

Follow the installation program instructions. While the program is
installing files, the installation window displays information about
PhotoImpact and the progress of the installation.

Note: To move between entry boxes in the installation program, use your
mouse or press Tab (not Enter).

Installing the Acrobat reader
An electronic copy of this user guide is also available in the Adobe Acrobat
format (PDF). To view this, first run the READER.EXE file (found with the
PhotoImpact program files) and follow the installation instructions. After
successfully installing the Reader program, use the File: Open command to
open the file USRGUIDE.PDF (found on the PhotoImpact CD). You can then
view the user guide on-line.
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Running the programs
To run the PhotoImpact programs, click on the appropriate command in the
Start: Programs: Ulead PhotoImpact 3•0 submenu. (This submenu may differ
depending on the choices you made during installation). When you are
already working in any of the programs, the easiest method to run another
PhotoImpact program is by using the Switch menu, located on the right of the
menu bar.

If you are new to using Windows 95, try creating shortcuts to the PhotoImpact
programs, done by dragging each program’s EXE file from Windows Explorer
(for example, IEDIT3.EXE) and dropping it onto your desktop. A shortcut is
automatically created and appears on your desktop. To run the program,
you simply need to double-click on the shortcut.

Running the Ulead Quick Access

After installing PhotoImpact, you will notice an extra command in the Start:
Programs: Ulead PhotoImpact 3•0 submenu called Ulead Quick Access.
Quick Access is designed to give you one click access to all your PhotoImpact
programs. Choosing this command instantly loads Quick Access onto your
Windows taskbar. Clicking on its button displays a pop-up menu
of all the PhotoImpact program commands. Choosing a command then runs
that program. Quick Access also improves loading time performance
whenever you run a PhotoImpact program and enables PhotoImpact CD
Browser’s plug-and-play capability.

Note: Place Quick Access in your Windows StartUp group to automatically load
Quick Access whenever you run Windows. (Go, Start: Settings: Taskbar and use
the Start Menu Programs tab.)

What’s new in version 3•0
There have been several significant upgrades and additions to this version of
PhotoImpact, the most notable being a name change. PhotoImpact is in fact
the latest version of our award winning program, ImagePals. When ImagePals
debuted in 1992, it was hailed as defining a new class of imaging software,
“graphics management”, and has since then consistently held onto the top spot.

With this release, ImagePals has been totally revamped to make it both
Microsoft Windows 95 and Microsoft Office compatible, as well as to make full
use of the new 32-bit operating environment. Because of this, we felt it
appropriate to signal the change with not just a new version number, but a new
name. A name that reinforces our commitment to offering innovative imaging
solutions – with impact.
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PhotoImpact
PhotoImpact is a native Windows 95 program that pioneers a whole new
approach to image editing. Now, professional results are only a mouse click
away, bringing new productivity to novices and seasoned users alike. Simply
scan in the images you need, Pick & Apply™ the effects you want, and place
the finished artwork in your document or presentation. No complex features
or unremovable changes; just intuitive imaging power for all your business
needs. The following section lists some of the product's key features:

Object-based editing now means that whenever you move a selection, paste
an image, or perform a transformation, you automatically create an object.
Objects can be freely moved and manipulated without fear of affecting other
objects or the original image. Powerful merge control and object preferences
mean you can fine tune how objects in an image interact, such as controlling
the transparency of one or applying shadows to another.
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Styles take the guesswork out of image editing by providing predefined
enhancements, or styles, that you drag-and-drop onto an image. The image
then adopts that style’s characteristics, such as a sunset or a particular hue.
You can even create your own, so if you like a particular image’s look, you can
automatically transfer that look to another image. It’s no harder than going to
a hair salon, choosing the hair style you want from a catalog and voila, your
stylist does the rest for you.

99 levels of undo and redo give you greater freedom to experiment with your
images, safe in the knowledge that you can return to any stage of your editing.

Vector-based editing allows you to convert a raster image into a vector image,
or to create a vector graphic from scratch. You can then edit that graphic and
once finished, convert it back into an object or selection.

Path-based text editing uses bezier curve technology to allow you to freely
distort text in an infinite number of ways. As objects, you can also return to
any text you have applied and correct spelling mistakes, or even change it
completely.

Auto-processing makes adjusting acquired images easier than ever before.
Now you can automatically straighten an image, remove moire patterns,
control brightness and contrast, and even crop; simply select the operations
you want performed and click OK- PhotoImpact does the rest for you.

Magic textures allow you to create an infinite number of natural and obscure
textures to use with your images. Perfect for filling areas of an image that look
flat or need an added sense of depth.

Natural painting tools are a welcome addition to PhotoImpact and allow you
to paint in the style of natural elements, such as charcoal, chalk and crayon.

Mask painting allows you to use a paintbrush to create and edit selections,
providing even greater control and flexibility over existing selection tools.

Usability enhancements are also a significant improvement over previous
versions, with the interface more intuitive and functional than ever before.
Now toolbars are floatable, and when in full screen mode, you can edit your
image free from the restraints of the program window. Tooltips make identify-
ing tools and screen elements easier, and a new Attribute toolbar brings
features previously buried in menus to the surface for one click access.
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Album
Album is the major supporting act to PhotoImpact. Just as powerful in its own
way, Album helps keep your system in order, making sure your images and
other files don’t overrun your hard disk and that you can always find exactly
what you want. The following section lists some of the product's key features:

OLE 2 support means Album is now more tightly integrated with other
PhotoImpact and office programs. For example, you will see the Album icon
in other office programs such as Microsoft Word and Powerpoint; and you can
even activate PhotoImpact from an object within a container program such as
Word, and then edit the object directly in Word’s workspace.

User definable fields now means that whenever you create an album,
you are creating a database complete with fields, or categories that you define.
No longer are you restricted to just subject and description information,
now you can arrange information under your own headings, such as sports,
date, age and marital status. An essential tool for anyone needing to reference
diverse and comprehensive information such as employee or customer records.

e-Mail support means you can now send your files over the “net”, direct from
Album. You can also send your files by fax using the Windows MAPI service.

Folder monitoring allows Album to check your system for any changes to the
number of files in a folder and updates albums accordingly.
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Compact mode is a new feature that provides you with access to Album,
while at the same time revealing background programs. In compact mode,
all Album windows are removed from view, leaving only the active album,
thereby allowing you to quickly and easily drag-and-drop thumbnails within
and between programs. This is great for incorporating your work into other
programs such as Microsoft Word, Powerpoint and Excel.

Supporting utilities
PhotoImpact 3.0 comes with four utilities that complete the entire package:
Screen Capture, Viewer, CD Browser and Explorer. Screen Capture allows you
to take any screen component and convert it into an image. This can be an
icon, a program window, text in a Word document or even another image.
Viewer is useful for seeing image files in full view, without having to first open
them in their parent program, while CD Browser allows you to view any
photo stored on a Kodak Photo CD. The Explorer utility is a new addition to
this version and allows you to visually check on the files in your system.
If Explorer comes across any compatible image and graphic formats, it displays
their contents as small thumbnails, just like Album, while using the familiar
tree directory structure found in Windows Explorer. The Explorer is great for
when you have no time to insert thumbnails into an album or wish to quickly
view the contents of a directory.

Note: For a full description of each of these programs, view their respective
on-line Helps.



Tutorial 1

Creating a travel brochure
The following tutorials show you how to use PhotoImpact’s powerful tools
and features to put together several images for inclusion into a travel
brochure for a fictitious travel agency, Worldwide Travel. Once completed,
you will then learn how to incorporate your images into a Microsoft Word
document.

This tutorial gets you started with PhotoImpact, taking you through the
basics of image editing and introduces you to some of the more common
commands and tools you will use, such as auto-processing and the selection
tools.

Tutorial contents at a glance

Preparing the first image...............................................................................................16

Preparing the second image.........................................................................................18

Preparing the third image..............................................................................................23

Preparing the fourth image ...........................................................................................30
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Before you begin
The image below shows you the type of brochure you are going to create
using PhotoImpact and a document created in Microsoft Word. Each image in
the brochure is labelled numerically. You can follow the tutorial in the
ordered sequence, or jump to the page that discusses the image you have
particular interest in.

Preparing the first image
The first image that you will look at is an image of a flower that needs to be
resized and then saved. All the images that you will be working on for the
brochure, including the flower, are stored in the SAMPLES\TUTORIAL folder
on your PhotoImpact CD-ROM. Also, while you are working through this
tutorial it is assumed that you have PhotoImpact open and active on your PC.

To resize an image:

1. Click the Open button on the Standard toolbar. The Open dialog box
appears.

2. Select the SAMPLES\TUTORIAL folder on your PhotoImpact CD-ROM and
double-click on the file labelled FLOWER. An image of a flower should now
appear in the PhotoImpact workspace.

Image 7 works on:

• Stitching
• Edge blending
• Object resize
• Object rotation
• Stamp cloning
• Text effects

- see p.49

Image 1 works on:

• Opening
• Resizing
• Saving

- see p.16

Image 6 works on:

• Mask Brush
• Colorizing

- see p.45

Image 3 works on:

• Painting
• Advanced selection tools
• Fills
• Objects

- see p.23
Image 2 works on:

• Basic selection tools
• Drag and drop
• Borders

- see p.18

Image 4 works on:

• Cropping
• Composition
• Styles
• Texture Frames

- see p. 30

Image 5 works on:

• Auto-Processing
• Cloning
• Merging objects

- see p.42
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You will notice that the image is quite large, and obviously too large for
the brochure. To resize it, we need to change its resolution. Resolution
works by controlling the spacing of pixels in an image. For example,
increasing the resolution places pixels closer together, therefore decreasing
an image’s size. Decreasing the resolution works in the opposite manner, as
it increases the spacing between pixels, therefore increasing an image’s size.

3. Click on the Unit button on the right side of the Status bar and choose
“CM” to select centimeters as the unit of measure.

4. Choose “Resolution” from the Format menu. The Resolution dialog box
opens.

The picture placeholder for the flower in the travel brochure is
approximately 4 by 4 cm. You need to change the image’s resolution so
that it  corresponds to that size. Presently the image is about 5 by 6 cm.
To determine the proper resolution use the following formula:

New Resolution = Old Resolution x (Old Dimension/New Dimension).

5. By plugging the values into the above formula a value of 53 pixels/cm is
the appropriate resolution for the flower image.

Enter 53 in the User defined entry box.

6. Click OK. The image is now resized according to the specified dimensions.
(You will not see any changes until you place the image into our Word
document at the end of these tutorials.)

Now that the image is properly sized it can be saved for later placement
into the brochure.
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To save an image:

1. Click the Save button on the Standard toolbar. The Save As dialog box
opens.

2. In the File name entry box enter the name FLOWER. (It is a good idea to
create a folder labeled tutorial on your hard disk so you can group all your
images in the one place.)

3. Click Save. The image is then saved to disk.

Before starting work on the next image, close the present image by clicking
the  on the upper right corner of the image window..

Preparing the second image
The next image that you will prepare is the company logo for the brochure.
In composing the logo you will first create a new image and use the selection
tools to grab parts of two other images and bring them together in the new
image. Finally you will create a border around the logo.

To create an image:

1. Click the New button on the Standard toolbar. The New dialog box
opens.

2. Check the User defined option in the Image size group box and enter a
width of 6.5 cm and a height of 2.3 cm.

3. In the Resolution group select Pixels/Cm in the right entry box and enter
55 in the left entry box. This will ensure that the image appears at the
proper size in the brochure.

4. Click OK. A new image window appears in the workspace filled with the
current background color.

Selecting part of the image
The next thing to do is to add some data to the empty image that you have
just created. There are two images to add; the first contains text and the
second is a picture of a fish. Together, these image elements form the logo on
the brochure. To add the text to the logo you will use the Standard selection
tool.

To create a selection using the Standard selection tool:

1. Open the image labeled COMPNAME in the SAMPLES\TUTORIAL folder on
the PhotoImpact CD-ROM.

2. Click the Standard selection tool on the Tool panel. The Attribute toolbar
changes to show all the Standard selection tool attributes.
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Before commencing, go to the Attribute toolbar and make sure that the
Rectangle option is selected in the Shape combo box, that the Fixed size
check box is not checked, and that the Draw from Center command in
the Options menu is not selected. With this configuration the Standard
selection tool allows you to freely select any rectangular area in an image.

3. Click your mouse over the upper left corner of the company name and
drag to the lower-right corner beneath the name, ensuring that the
company name appears within the selection marquee. Releasing your
mouse creates a selection area.

Performing a drag-and-drop operation
Now that you have selected the company name, you need to drag the name
onto the logo image.

To drag-and-drop from one image to another:

1. Make sure a selection tool is active (a selection tool button is depressed).

2. Drag the company name selection area from its image window onto the
right side of the logo image window. Releasing your mouse drops the name
into the image.
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Using the Magic Wand to select part of an image
After placing the company name, the next thing to do is to select the fish
and then add it to the logo image. The fish however, contains areas of white
in the background which we do not want to include in the selection.
You could trace around these white areas, but this can be a time consuming
process. A better method is to use the Magic Wand selection tool which
works by selecting colors in an image.

To use the Magic Wand selection tool:

1. Open the image FISH in the SAMPLES\TUTORIAL folder on the
PhotoImpact CD-ROM.

2. Click the Magic Wand tool on the Tool panel.  The Attribute toolbar
changes to show all the Magic Wand tool attributes.

Before commencing, go to the Attribute toolbar and enter a value of 0 in
the Color Similarity entry box. A value of 0 means that the Magic Wand
will select all colors that are exactly the same as the color you click on.
Increasing the similarity allows you to select a greater range of colors.

3. Move to the image and click on any area of the white background.
All the white surrounding the fish is now selected.

Right now the background is selected, but we want to select the fish, not
the background. This can be done easily by simply inverting the selection.

5. Click your right mouse button over the image, the Select pop-up menu
appears, and choose “Invert”. The selection area is then inverted to now
select the fish.
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Now that the fish is selected, drag it onto the left-side of the logo image’s
window using the same procedure as described for moving the company name.
After dragging, the fish is converted into an object and floats above the base
image.

Blending an object’s edges
After dragging the fish onto the logo image, you may find that the edges of
the fish appear rough or jagged. This often occurs when you select an object
and place it into a new image or change its position in its original image.
To better blend these edges into the background image, you need to edit the
object’s properties.

To blend an object’s edges:

1. Double-click on the fish to open the Properties dialog box.

2. Check the Edge blending option and enter a value of 10 in the entry box.
This will blend the edges of the fish with the background over a  distance
of 10 pixels.

3. Click OK. The fish’s edges are now blended into the background making
the fish appear as it were originally part of the logo image.

Creating a border
The last step in putting this image together is to add a black border around
the image. Before beginning, make sure that neither of the objects in the
image are selected by clicking on the base image.
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To add a border:

1. Click on the base image to select it and click the Standard selection tool
on the Tool panel.

2. Move your mouse over the image and click your right mouse button.
The Select pop-up menu appears.

3. Choose “Select All”. The entire image is now selected.
4. Access the Select pop-up menu again and this time choose “Border”.

The Border dialog box opens.

5. In the Border width entry box, type in 6, and click OK. A new 6 pixel
wide selection area is created over the original selection

Now add some color to this selection to create a border.

6. Move to the Color panel and click your right mouse button over the
background color square, the Color Picker menu appears, and select black
from one of the color squares. The Color Picker menu closes and the color
black now appears as the background color.

7. Press the Delete key. The selection area is now filled with black,
creating a border around the image.

Merging objects
The logo is finished, however, before it can be placed into the brochure you
will need to merge all the objects onto the base image. These objects were
created when you filled the border and dragged the fish and company name
onto the image. (Once an object is merged, you cannot edit it independently
from the base image.)

To merge objects onto the base image:

1. Click on an object to select it, and then click your right mouse button.
The Object pop-up menu appears.

2. Choose “Merge All”. All of the objects in the image are now merged onto
the base image.
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After the objects have been merged the logo is complete and ready to be
saved for later placement into the brochure. Click the Save button on the
Standard toolbar and save the im age as COMPANY LOGO. Finally, close the
image by clicking the   on the upper right corner of the image window..

For more information see
Selecting a border area ............................................................................................. 122
Selecting an area containing similar colors ............................................................ 134
Softening a selection edge ........................................................................................ 137
Performing OLE operations ......................................................................................... 95

Preparing the third image
In this lesson you are going to work more with selection areas and make use
of the fill tool as well as the paintbrush. The image that you are going to
work on begins as a simple drawing but through modification and some
creativity on your part ends up a colorful collage.

Painting on an image
The first thing that you are going to do is open the image of a treasure chest
and palm tree and paint a line on it. The line is being added to help define a
shoreline to separate the sand form the water that you are going to add later
to the image.

To paint a line on an image:

1. Open the image in the SAMPLES\TUTORIAL folder on the PhotoImpact
CD-ROM labeled CHEST.
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2. Click the blue triangle in the lower right corner of the Paint button on
the Tool panel, a drawer of painting tools opens, and click on the
Paintbrush tool. The Attribute toolbar changes to show all the Paintbrush
tool attributes.

Before commencing, go to the Attribute toolbar and make sure that the
Brush Size is set to 4, the Transparency is at 0, the Spacing is 10,
the Soft Edge is 0, the Merge Factor is set to Always, and that the
drawing mode is set to Freehand. With this configuration, you can freely
paint a curved black line with sharply defined edges.

3. Drag your mouse from the left side of the image to the edge of Palm Tree
island. When you release your mouse, the line is filled with the current
background color. Now draw a line from the right edge of Palm Tree island
to the lower left side of the treasure chest. Finally, draw a line from the
lower right side of the treasure chest to the right edge of the image.
Your image should look something like this:

Erasing portions of an image
Now that you have created a line separating the upper and lower portions of
the image, you need to erase the lower edge of palm tree island so as to better
blend the island into the shore. To do this you will use the Eraser tool.

To erase portions of an image:
1. Click the blue triangle in the lower right corner of the Eraser button,

a drawer of eraser tools opens, and click the Standard Eraser tool. The
Attribute toolbar changes to show all the Standard Eraser tool attributes.

Before commencing, go to the Attribute toolbar and make sure that the
Brush Size is set to 4 and then click on the color square with your right
mouse button and select white to be the eraser color.

2. Drag over the lower edge of the palm tree island. The area that the eraser
passes over becomes white.

Note: If you erase too much of the island, click the Undo button on the
Standard toolbar.
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Filling areas of an image
Now that you have created a shoreline you can fill the shore with the sand
from the around the palm tree. You do this by selecting the shore region and
filling it with the sand color. In this section you will also be adding water to
the image.

To fill part of the image with sand:
1. Select the Magic Wand tool, and, with a Color Similarity of 1, click over

the shore region to select it.

2. Select the Eyedropper tool and move it over the sand surrounding the
palm tree. Click your left mouse button to select the sand color as the
background color.

3. Choose “Fill” from the Edit menu. The Fill dialog box opens.

4. Choose the Selected Color option and click OK. The shore region is now
filled with the sand color.

    

Now you will water to the image by also using the Fill tool. This will be a
bit more involved than the previous fill procedure and will involve
modifying the size of a selection area.

To fill part of the image with water:
1. With the Magic Wand tool selected, move over the white region above

the shore and click. This selects the entire upper portion of the image.

You do not want to fill the entire area with water, only a small portion
around Palm Tree island. You therefore need to subtract from the selection
those areas you don’t want to affect.
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2. Switch to the Standard selection tool, ensuring that the Rectangle option
is selected in the Shape combo box, the Fixed Size check box is not
checked, and that the Draw from Center command in the Options button
menu is not selected.

3. Carefully position your mouse on the upper left portion of the image and,
holding down the “S” key, drag across the image and down to about the
bottom edge of the palm tree fronds. Releasing your mouse now removes
that area from your selection.

4. Switch to the Bucket Fill tool and click your right mouse button over the
color square on the Attribute toolbar. From the Color Picker menu,
select a deep blue for the water.

5. Return to the image and click over the selected region. The selection is
now filled with blue.

    

Performing a gradient fill
Now that you have created the shore and water portions of the image, it is
time to add the sky. You do this by using a Gradient Fill tool. The gradient
fill tools enable you to fill a region of an image with a smooth gradation of
color, from one color (the start) to another (the end).

To perform a gradient fill:

1. Click on the base image to select it, and using the Magic Wand tool,
select the remaining white region above the ocean.

2. Click the blue triangle in the lower right corner of the Fill button, a
drawer of fill tools opens, and click on the Linear Gradient Fill tool.
The Attribute toolbar changes to show all the Linear Gradient fill tool
attributes.

3. Choose the starting and ending colors by clicking your right mouse button
over the appropriate color squares on the Attribute toolbar. Choose a light
blue for the starting color and a dark blue for the ending color.
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4. Now drag your mouse over the selection area, moving upwards from the
bottom to the top. Notice that a line appears indicating the extent of the
linear fill. Releasing your mouse fills the selection area with a color
gradient from light to dark blue. (If you are not happy with your colors,
you can change them on the Attribute toolbar and try again.)

    

The image is nearly finished, except that the sky looks a bit empty. To remedy
this you are going to add a few ocean birds by using the Paintbrush tool.

To paint some birds:

1. Click the blue triangle in the lower right corner of the Paint button,
a drawer of fill tools opens, and click on the Paintbrush tool.

2. In the Attribute toolbar, set the Brush Size to 1 pixel.

3. Position your mouse over the sky and start dragging to paint a bird.

4. Repeat step 3 to paint more birds.
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Adding a title
The image is shaping up quite nicely. Now you need to add the brochure title
to the image. The title is stored in another image file labelled TITLE. In the
following procedure you will use the Magic Wand and the Similar command
together to select the title text.

To add the brochure title to the image:

1. Open the image file labeled TITLE in the SAMPLES\TUTORIAL folder on
the PhotoImpact CD-ROM.

2. Select the title by clicking the Magic Wand tool on a portion of the title
text. This selects only a small segment of the text.

You could continue working in this way, slowly adding to the selection,
or you can use a much quicker method with the Similar command.

3. Click your right mouse button over the image, the Select pop-up menu
appears, and choose “Similar”. The Similar dialog box opens.

4. Uncheck the Expand for current selection check box.

This allows the Similar command to expand the selected area to all
regions of the image that share a similar color range.

5. Click OK. Now all the text in the title is selected.

On its own, however, the text looks a little plain. To spice it up a bit, you
can apply a gradient fill.

6. Switch to the Elliptical Gradient Fill tool and change the starting and
ending colors to a red and yellow.

7. Drag your mouse over the selection area, moving from the center
outwards. Notice that a line appears indicating the extent of the elliptical
gradient. Releasing your mouse fills the text.

  

8. Now click on a selection tool, select the image, and drag the title onto the
upper right portion of the CHEST image.
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Creating a ragged edge
To give the image a more stylized look, you can make the edges of the image
appear ragged as well as give it a shadow to indicate some depth.

To create ragged edges:

1. Select the Paintbrush tool on the Tool panel and set the Brush Size to 10
on the Attribute toolbar.

2. Click on the white color cache square to select it as the foreground color.

3. Keeping the same stroke direction, drag your mouse in short strokes across
the edges of the image, starting at the top left corner and going clockwise.

4. Switch to the Magic Wand tool and select the white region around the
image that you have just created.

5. Click your right mouse button and choose “Invert” from the Select pop-up
menu. This deselects the white area and selects the rest of the image.

6. Access the Select pop-up menu again and choose “Convert to Object”.
The image is now converted into an object.

7. Access the pop-up menu again (this time it is the Object pop-up menu)
and choose “Add Shadow”. The Add Shadow dialog box opens.

8. Set the shadow direction to be to the right and below the image and enter
1 in both the X and Y offset entry boxes to set the shadow depth. Also set
the Edge Blending option to 1 to make the shadow appear more diffuse.

9. Click OK. The shadow is applied to the image.

Now the image is finished and can be saved for later placement into the
brochure. Click the Save button and save the image with the name
TREASURE CHEST ON BEACH. (Before saving, make sure all objects have
been merged onto the base image.) Finally, close the image.
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For more information see:
Using the painting tools ............................................................................................. 120
Erasing colors from an image ................................................................................... 124
Using the Fill tools ...................................................................................................... 127
Adding shadows to an object .................................................................................... 144

Preparing the fourth image
Working on the treasure chest image gave you some familiarity with selection
tools, objects, fills and painting. Here you are going to work on separate
image portions and then bring them together into a single composite image.
This section teaches you how to apply styles, use the quick color controls,
and add a frame to an image. Also, in the course of this lesson you will be
refining many of the techniques that you learned with the previous images.

Cropping an image
The first part of this image is a sunset and ocean scene. However, the image is
far too big for the brochure, so you will need to crop it down to the proper
size by using the Standard selection tool and the Crop command.

To crop an image:

1. Open the image file labeled SUNSET in the SAMPLES\TUTORIAL folder on
the PhotoImpact CD-ROM.

2. Click the Unit button near the lower right corner of the status bar and
choose “Cm” from the pop-up menu. This sets the measurement unit to
centimeters.

3. Click the Unit button again and this time choose “Ruler”. This displays a
ruler down the left and across the top of the image.

4. Select the Standard selection tool and make sure its shape is set to
rectangle on the Attribute toolbar.
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5. Move your mouse to the 7 cm mark on the horizontal ruler and 1 cm mark
on the vertical ruler and drag to the 13.5 cm mark on the horizontal ruler
and 8 cm mark on the vertical ruler. As you drag, a rectangular selection
marquee is created defining which areas are included in the selection.

Note: For a better view, you can press the “+” key to zoom in on the image.
This also increases the spacing on the ruler and makes it easier to specify
the proper dimensions.

 6. Choose “Crop” from the Edit menu. This discards anything outside of the
selection area, retaining only the image data within the selection.

Using the Color Balance
The image is now the right size, however the water is a bit too dark and not
blue enough. You can use the Color Balance feature to quickly correct this
color problem.

To balance the colors in an image:

1. Select the water by using the Magic Wand.

The easiest way to do this is to select the sky first and then invert the
selection. Use a color similarity of 16 and, with Select by: Area chosen in
the Attribute toolbar, drag your mouse around the sky near the edges.
Releasing your mouse selects the area.
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2. Click your right mouse button and choose “Invert” from the Select pop-up
menu. The sky is now deselected and the water selected.

3. Click the Color Balance button on the Standard toolbar. The Color
Balance dialog box opens displaying different thumbnail representations of
how the water appears with different color balance settings. (The center
thumbnail represents your image.)

4. Click on the left middle thumbnail and notice how all the thumbnails
become a stronger blue. Keep clicking the thumbnails until the center
thumbnail has the type of blue that you are satisfied with.
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5. Click OK. The water in the image is now balanced according to your
selection in the Color Balance dialog box.

Balancing the color converts the selected water into an object. To merge
the water back onto the base image, choose “Merge” from the Object
pop-up menu.

Applying a style to an image
The next thing that you will do is to add a snow-capped mountain to the
sunset image and then alter the “look” of the mountain so that it fits better
into the image.

To add the mountain to the image:
1. Open the image file labeled MOUNTAIN in the SAMPLES\TUTORIAL folder

on the PhotoImpact CD-ROM.

2. Use the Magic Wand tool with a color similarity of 32 to select the
mountain by first clicking on the yellow area above the mountain and
then inverting the selection area.

   

3. Drag the mountain to the upper right portion of the sunset image and drop
the mountain so that its right edge is aligned to the right edge of the
sunset image and its bottom edge is positioned just below the boundary
line between the sky and the ocean.

You may notice that the mountain does not “look” right. Its lighting does
not match the sunset. PhotoImpact provides a wide range of styles that are
specifically designed for this kind of problem.
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To apply a style to the mountain:

 1. Open the EasyPalette by clicking the EasyPalette button on the Standard
toolbar. The EasyPalette appears displaying the thumbnails of the most
recently selected gallery.

2. Choose the Style Gallery from the Galleries combo box. Thumbnails of
different styles appear in the palette window.

3. Scroll through the style thumbnails until you find the “Sky- Sunshine to
Sunset” style, and then drag it onto the mountain. The “look” of the
mountain then takes on a sunset style.

 

Transforming an image
The next step is to add an airplane to the image. The airplane is too large for
the image and so it will need to be resized before it can be added to the
image. The angle of the airplane also needs to be changed. To do this, you
will use the Transform tool.

To add an airplane to the image:

1. Open the image file labeled PLANE in the SAMPLES\TUTORIAL folder on
the PhotoImpact CD-ROM.

2. To select the airplane use the Magic Wand tool, with a color similarity of
128, and click over the airplane to select it.

3. Now drag the airplane onto the upper left portion of the sunset image.
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The plane blends in well with the background sky, however the airplane is
too large and needs to be flying more horizontally for this image. To resize the
airplane and bring it to the horizontal you can use the Transform tool.

To resize the airplane with the Transform tool:

1. Click the Transform tool on the Tool panel.
2. Click the Resize button on the Attribute toolbar, six control points appear

around the edges of the plane selection area, and drag on one of the
corner control points to about a third of the way to the center of the
airplane. Releasing your mouse then resizes the plane. (Holding down the
Shift key as you drag keeps the aspect ratio of the selection.)

  

To rotate the airplane:

1. Make sure the Transform tool on the Tool panel is still selected.
2. Click the Rotate Freely button on the Attribute toolbar, four control

points appear at the corners of the plane selection area, and drag on a
control point to rotate the selection area. Keep dragging until the plane
appears to fly horizontally. Releasing your mouse then rotates the selection
accordingly.

Note: If you rotated the selection area too little or too much, you can easily
drag on a control point to correct the rotation.
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Making freehand selections
The next thing to do is add a beach to the image. For this you will use the
Lasso tool to make a freehand selection of a beach in another image and then
copy that to our current image.

To freehand select the beach:
1. Open the image file labeled BEACH in the SAMPLES\TUTORIAL folder on

the PhotoImpact CD-ROM.

2. Click the Lasso selection tool on the Tool panel and ensure that Snap to
Edges option on the Attribute toolbar is not selected . This will give you
greater freedom to move the Lasso tool.

3. Carefully drag your mouse over the shoreline, starting around the middle,
and then work your way downward to the point where the shoreline meets
the edge of the image. Continue dragging across the base of the image and
upward just before the buildings begin. Finish the dragging by moving back
across the image just under the hotels that are above the shoreline to the
point where you began. Double-clicking your mouse then selects the area.

Notes:
• If you make a mistake, press the Esc key to start again, or press the

Backspace key to undo your last movement.
• If you do not wish to select the beach, you can open the file labeled

BEACHMSK in the SAMPLES\TUTORIAL folder on the PhotoImpact
CD-ROM. The beach in this image is an object that can be dragged onto
the sunset image.
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After selecting the beach you need to prepare it to be dragged onto the sunset
image by creating a surf-like effect for the beach. To do this, first make sure
that the background color is set to white.

Preparing the image:

1. Drag the selected beach off the image and drop it onto the workspace.
This creates a new image of the selected beach area surrounded by the
current background color, (which should be white).

 

2. Click the right mouse button over the beach and choose “Merge” from the
Object pop-up menu to paste the beach onto the background.

3. Click the Magic Wand tool on the Tool panel, and, with a Color
Similarity of 150, select the beach. This gives the beach a slightly white
edge. You will use this later to create a surf-like effect between the water
and the beach.

4. Drag the beach selection onto the SUNSET image and drop it on the lower
right corner so that the left tip of the beach lies on top of the right tip of
the mountain.
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Changing an object’s layering
You may notice that the beach appears to overlap part of the mountain.
PhotoImpact provides the Layer Manager allowing you to control the layer of
an object so that it can appear either above or below other objects that it
overlaps. Each object in an image is displayed in the Layer Manager as a
separate thumbnail. By dragging a thumbnail you change the layer that it
occupies. For example, dragging a thumbnail to the left or upward moves the
object to a higher layer, displacing all objects previously above it downward
one layer, and allows that object to cover up any object that it overlaps on a
lower layer.

To bring the mountain on top of the beach:

1. Open the EasyPalette by clicking the EasyPalette button on the Standard
toolbar.

2. Click the Galleries combo box and select the Layer Manager.

3. Drag the Mountain thumbnail to a position to the left of the beach
thumbnail. This causes the mountain to cover the part of the beach that it
overlaps.

    

Using the quick color controls
Now that the beach is properly positioned on the image you can modify the
beach’s appearance so that it does not look so dark. One fast way to do this is
to use the quick color controls located at the bottom of the Color panel.

To use the quick color controls:

1. Click the beach to select it.
2. Click on the right Brightness control to increase the brightness of the

beach. As you click, the brightness of the selection area is automatically
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increased. You may want to click on this control a few times to make the
beach sufficiently bright.

3. Click on the right Contrast control to increase the contrast of the beach
area. Details on the beach are a bit indistinct, but after a few clicks it will
appear much more detailed.

4. Experiment with the Red, Green, and Blue color controls to make the
beach area appear a little more yellow.

   

Applying a soft edge
Currently when you look at your image you will find the edges of the beach,
especially at the shoreline, a bit harsh. You can soften these by using the Edge
blending option in the Object Properties dialog box.

To apply a soft edge to the beach:
1. Select the beach object and the double-click. The Object properties dialog

box opens.

2. Enter 10 in the Edge Blending entry box.

3. Click OK. The beach area edges now blend more smoothly into the
surrounding ocean and land areas.

4. Click your right mouse button over the beach area and choose
“Merge All” to merge all the objects onto the base image.
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Adding a frame and shadow
The image is nearly done. To finish up you only need to add a frame and
shadow.

To add a frame and shadow:

1. Click the Frame button on the Standard toolbar. The Frame & Shadow
dialog box opens.

2. In the Frame group box, select the Magic Texture option and click the
Library button, choosing Options. This opens the Magic Texture dialog
box displaying a number of different texture styles.

3. Click on a thumbnail until you find a texture that you think best suits
your image.

4. Click OK. The Magic Textures dialog box closes and the selected texture
now appears as a small thumbnail next to the Magic Texture option.

5. In the Shadow group box, click the fourth shadow direction option, and
enter 16 in the X and Y offset entry boxes to control the depth of the
shadow.

6. Uncheck the Canvas check box to disable the canvas option and leave the
region around the frame and shadow blank.

7. Click OK. The frame and shadow are applied to the image.

 

Finally, click the Save button on the Standard toolbar and save the image as
FRONT COVER PHOTO.

For more information:
Using the color correction commands ....................................................................... 98
Styling an image ......................................................................................................... 101
Using the Transform tool ........................................................................................... 155



Tutorial 2

Finishing the travel brochure
In this tutorial you are going to use advanced PhotoImpact tools to perform
more challenging image editing on certain images for the travel brochure.
You will use tools to clone images, do gradient fills, create soft edges,
colorize an image, and perform other advanced operations as well.
At the end of this tutorial you will use drag and drop operations to place the
images into a travel brochure created in Microsoft Word and then print the
brochure.

Tutorial contents at a glance

Preparing the fifth image...............................................................................................42

Preparing the sixth image .............................................................................................44

Preparing the seventh image........................................................................................48

Putting the images into the brochure ...........................................................................54
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Preparing the fifth image
In this image you are going to use PhotoImpact’s Auto-Process commands to
quickly correct several problems in an image that you may often face when
using scanned photos.

To Auto-Process an image:

1. Open the image labeled SKIING in the SAMPLES\TUTORIAL folder on the
PhotoImpact CD.

2. Click on the Auto-Process button on the Standard toolbar. The Auto-
Process dialog box opens.

3. Click on the Auto-Straighten, Auto-Crop, Auto Focus, Auto-Brightness,
and Auto-Contrast buttons and notice how each affects the preview.

4. Click OK to apply the auto-processes in the order they were chosen.

  

Original image Straightened and Focused, brightened and
cropped contrasted
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The image is still too large for the brochure. To resize the image without
affecting the number of pixels, use the Resolution command in the Format
menu and select a new resolution of 31 pixels/cm. This will make the image
appear about half its original size when incorporated into the brochure.

Cloning an image
You can use the Clone Tool to paint image data from one location onto
another location in the same image or another image. In this image you are
going to clone some snow onto the image of the red skier in the foreground
and cause him to disappear, and then add more skiers to replace him.

To erase part of an image with the clone tool:

1. First, zoom in on the red skier so that it fills up about one third of the
window.

2. Click the blue triangle in the lower right corner of the Clone button on
the Tool panel, a drawer of clone tools opens, and click on the Image
Clone tool.

Before cloning, you need to set the cloning attributes which are displayed
on the Attribute toolbar.

3. Enter 12 in the Brush Size entry box and select Always as the Merge
option. Also, click on the Options button to ensure that the drawing mode
is set to Freehand.

4. Click your mouse, while holding down the Shift key, on the snow to the
left of the red skier. This selects the snow as the clone material.

5. Drag your mouse over the red skier. The skier is now replaced by the snow.
If you inadvertently clone the wrong material, use the Undo command in
the Edit menu, or select a smaller brush size.
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To add part of an image using the Object Clone tool:

1. Click the small triangle on the lower right corner of the Clone tool on the
Tool panel and select the Object Clone tool.

2. Click the Open button on the Attribute toolbar and select the file labeled
SKIERS in the SAMPLES\TUTORIAL folder on the PhotoImpact CD.

3. Move the cursor over the image and click wherever you would like a skier
to be placed. Continue clicking to add more skiers.

4. Make the closest skiers larger and the farthest skiers smaller by clicking
the Transform tool on the Tool panel, clicking the Resize button on the
Attribute toolbar, and dragging each skiers' control points appropriately.

    

All that is left to do now is to merge the objects and save the image for
placement into the travel brochure. Click your right mouse button on any
object and choose “Merge All” in the Object pop-up menu. Now click the
Save button to save the image as SNOW SKIERS in the TUTORIAL folder.

For more information, see:
Automatically enhancing an image ............................................................................ 90
Cloning parts of an image ......................................................................................... 125
Using the Transform tool ........................................................................................... 155

Preparing the sixth image
In this image you will use the paint tool to colorize a Grayscale image and the
Mask Brush tool to carefully select areas within the image to apply paint.

Converting an image's data type
Before you can colorize a Grayscale image, it must be converted from a
Grayscale data type to True Color.

To convert from Grayscale to True Color:

1. Open the image file labeled PARK in the SAMPLES\TUTORIAL folder on
the PhotoImpact CD. A Grayscale image of a park scene appears. Notice
that the color palette and cache colors in the Color panel appear only as
shades of gray. This indicates that the data type does not support color.
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2. Click the Data Type button on the right corner of the Status Bar. Choose
“True Color” in the pop-up menu to convert the image from Grayscale to
True Color. Notice that the Color panel now appears full of color.

Using the Mask Brush to select an area of an image
Before colorizing the image you need to use the Mask Brush to select different
portions of the image. The Mask Brush is useful here because you can use a
soft edge to make the selection edges blend into the surrounding image.

Using the Mask Brush to select an area:
1. Click the Mask Brush tool on the Tool panel. The image appears covered

by a colored mask. This mask indicates unselected areas. As areas become
selected they are cleared of the mask.

2. Enter a brush size of 12 and a soft edge of 20 on the Attribute toolbar.

Note: You may wish to zoom in on the grass area to define a more accurate
selection area.

3. Drag over the grass to removed the mask. If you accidently remove too
much of the mask, replace it by clicking your right mouse button as you
drag over the unwanted area.
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Colorizing a portion of the image
Now you can color the grass green with the Paintbrush tool using a merge
factor that paints only hue and saturation preserving the texture of the image.

To colorize the grass:

1. Select the Paintbrush tool button on the Tool panel, and set the Brush
Size to 30, the Transparency to 35, and the Merge to Hue and Saturation.

2. Click your right mouse button over a color cache square and choose
“Ulead Color Picker” from the Color Picker pop-up menu.

3. In the RGB entry boxes, enter color values of 72, 135, and 0 for red,
green, and blue, respectively. Click OK to accept the color values.

4. Select the newly modified cache color square and drag over the entire
grass selection area in one continuous stroke.

Note: If you release your mouse button and start painting again, overlapping
paint will build up making that part of the grass greener than the rest.

Now colorize the trees beneath the mountain by using a similar procedure.

To colorize the trees:

1. Carefully select the tree area with the Mask Brush using a Brush Size of 6.

2. Click the Paintbrush tool and set its Transparency to 75%. Use the Ulead
Color Picker to specify a color with red, green, and blue color values of 0,
105, and 70, respectively and then paint the trees dark green.
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In much the same way, colorize the mountain area above the trees. This is a
bit trickier as the white portion of the mountain face needs to remain white.

To colorize the mountain:

1. Carefully select the entire mountain area with the Mask Brush using a
Brush Size of 20 and a Soft Edge of 30.

2. Reduce the Brush Size to 15 and, with your right mouse button click
quickly over the white areas of the mountain face to replace the mask.

This quick clicking partially selects the white areas, allowing some paint to
be applied, but not so much as to destroy the colorization effect.

Note: You may want to zoom in on the white areas when replacing the tint.

3. Set the Paintbrush Transparency to 65%, and use the Ulead Color Picker
to specify RGB values of 0, 66, and 105, respectively.

4. Paint the mountain area with a bluish-green color.

  

Use the Mask Brush to select the soil between the grass and the water.

To colorize the soil:

1. Carefully select the area of soil between the grass and the water with the
Mask Brush. Specify a Brush Size of 6 and a Soft Edge of 10.

2. Set the Paintbrush Transparency to 80%, and use the Ulead Color Picker
to specify RGB values of 125, 58, and 0, respectively.

3. Paint over the soil area with a brown color.
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Now add some blue to the sky. You can use the Magic Wand to do this
because the colors are so dissimilar between the mountain and the sky.

To colorize the sky:

1. Click the Magic Wand button on the Tool panel.

2. Set the Color Similarity to 32 and check the Sample by Line option.

3. Drag over the sky area from left to right to select the sky.
4. Click on the Paintbrush button and set its Transparency to 80%. Use the

Ulead Color Picker to specify RGB values of 0, 255, and 255, respectively.

5. Paint over the sky area with a light blue color.

  

Now click the Save button on the Standard toolbar and save the image as
COLORIZED PARK in the TUTORIAL folder.

For more information, see:
Converting images ...................................................................................................... 152
Using the Mask Brush ................................................................................................ 135
Controlling the Merge factor ..................................................................................... 121

Preparing the seventh image
The last image is a large photograph that was scanned in two pieces with a
hand-held scanner. PhotoImpact makes putting these pieces together easy
with its Stitch feature.
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To stitch two image together:

1. Open the files labeled RESORT1 and RESORT2 in the TUTORIAL folder and
click on Resort1 to make it active.

2. Choose the Stitch command in the Edit menu. The Stitch dialog box
opens displaying “Resort1” in its display window.

3. Choose “Resort2” in the Stitch with combo box. Notice that Resort1 is to
the left of Resort2.

4. Click your mouse on the left most palm tree in RESORT2 and drag the
palm tree near the palm tree in RESORT1. Release the mouse button and
the Stitch function takes over to precisely stitch the two images into one.

Now that the image is in one piece, you can add a beach to the foreground.

Adding a beach to the foreground:

1. Open the file labeled STRIP in the SAMPLES\TUTORIAL folder on the
PhotoImpact CD.
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2. Click on the beach and drag onto the resort image as shown below.

3. The beach looks a little dim. To brighten, it click the brightness control
on the Color panel a few times.

Note: Make sure the beach is selected when modifying the brightness.

4. The edge between the beach and the grass looks too sharp. Double-click
on the beach to open the Object properties dialog box, enter a value of 10
in the Edge blending entry box and click OK. The dialog box closes and
the edges of the beach are softened onto the grass.

  

Now that the shoreline has been added, you are going to add in the resort
bungalows.

Adding in bungalows:

1. Open the file labeled BUNGALOW in the SAMPLES\TUTORIAL folder on
the PhotoImpact CD.

2. Click on the bungalow and drag it onto the grass near the beach.
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3. Now make copies of the bungalow by clicking your right mouse button on
the bungalow and choosing “Duplicate” in the Object pop-up menu. Drag
the bungalow copies around to fill the grassy area.

4. To help the bungalows look different and add perspective, click the
Transform tool on the Tool Panel and then click the Resize button on the
Attribute toolbar. Control points appear around the selected bungalow.
Drag a corner control point inward to make the selected bungalow smaller.

To flip a bungalow horizontally, click the Rotate button on the Attribute
toolbar and choose “Flip Horizontally” in the menu that appears.

Note: To transform more than one bungalow switch to a selection tool,
select another bungalow and then switch back to the Transform tool.

  

Now use the Object Clone tool to add some trees around the bungalows.

Adding foliage with the Object Clone tool:

1. Click the blue triangle in the lower right corner of the Clone button
on the Tool panel and select the Object Clone tool in the drawer that
appears.

2. Click the Open button on the Attribute toolbar and select the file labeled
TREES in the SAMPLES\TUTORIAL folder on the PhotoImpact CD.

3. A crosshair appears over the resort image. Click the crosshair to add trees.

  

After adding the bungalows and foliage, these objects need some shading to
help them fit into the image properly. To do this quickly, first group all the
objects and then apply a shadow to them.
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To apply a shadow to all the bungalows and foliage:

1. Open the EasyPalette and click the Galleries combo box to choose the
Layer Manager. Thumbnails of all the objects appear.

2. Click the first foliage thumbnail, scroll the Layer Manager window down
to the last bungalow thumbnail and hold the Shift key as you click the last
bungalow. All the foliage and bungalows are now selected.

  

3. Click the Menu Commands button to the right of the Galleries combo
box and choose “Group” in the menu that appears. All the selected objects
are now grouped together and can be acted upon collectively.

4. Click your right mouse button on a selected thumbnail and choose “Add
Shadow” in the menu that appears. The Add Shadow dialog box opens.

5. Choose the lower left corner for the shadow direction and enter an X
offset of 1 and a Y offset of 3 to control the shadow depth. Click OK.
The shadows are applied to all the selected thumbnails.

  

Next, you will add a balloon to the upper right corner to hide the branches
that drop onto the image from above.

Adding a balloon:
1. Open the image labeled BALLOON in the SAMPLES\TUTORIAL folder on

the PhotoImpact CD.

2. Select the balloon and drop it onto the upper right corner of the resort.
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Now add some curved text to the image with the Text tool.

Adding in text effects using the Text tool:

1. Click the Text tool on the Tool panel.
2. Click the cursor over the image and type “Mystery Island” in the text

entry box that appears. Make sure that the Font, Size, and Style on the
Attribute toolbar are set to your preference. (The example uses a Bahamas
font, size of 54 with an italic style). Click OK in the Text entry box and
the text appears over the image.

3. Click the cursor just under the newly displayed text and type “- where
dreams become reality!” in the Text entry box and click OK. Make sure
the font size is small enough to allow the text to fit across the image.

4. Click the Mode combo box on the Attribute toolbar and choose Path.
This displays the text as a path with control points that allow you to
change the text shape. Move the cursor over a control point on the
Mystery Island text, notice that the cursor becomes a crosshair, and drag a
control point to change the shape and curvature of the text.

  

5. Drag different control points over the two text blocks to shape them in
much the same manner as in the images below.

  

6. Now that the text is shaped properly, click the Mode combo box and
choose “Object.” This fills the text and converts it into an object. To give
it some life, you are next going to fill it with a magic gradient.



TUTORIAL TWO54

7. Click on a Selection tool in the Tool Panel and move the cursor over the
unselected text block (one text block is already be selected). Press the Ctrl
key as you click on the unselected text. Both should now be selected.

8. Open the EasyPalette and choose Gradient Gallery in the Galleries combo
box. Select a gradient of choice and drag it onto the image to fill the text.

  

Finally, merge objects and save the image as RESORT in the TUTORIAL folder.

For more information, see:
Stitching images together .......................................................................................... 167
Managing object layers .............................................................................................. 141
Adding text to an image ............................................................................................. 130

Putting the images into the brochure
Now that the images have been completed, you need to add them to the
travel brochure. The brochure is comprised of two letter-sized pages divided
into three columns, allowing the document to be printed on both sides of one
sheet and folded in thirds to make the brochure. The brochure also includes
several empty gray boxes, to help identify where each image is to be placed.

To open the brochure:
1. With PhotoImpact open, start Microsoft Word and open the file labeled

BROCHURE in the SAMPLES\TUTORIAL folder on the PhotoImpact CD.
The brochure opens displaying pre-written text and picture placeholders.
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2. Tile PhotoImpact and Word so that you can see both the placeholder
(the first gray box on the upper left corner of page 1, column 1) and the
PhotoImpact workspace.

To drag-and-drop the flower image:

1. All the edited images should be in a folder on your hard disk labeled
Tutorial. Click the Open button on the Standard toolbar and select the
image labeled FLOWER in that TUTORIAL folder.

2. Click your right mouse button on the flower and choose “All.”

3. Drag the image onto the placeholder on the top right corner of the first
column of page 1.

Now, repeat this procedure to place the Company Logo into the brochure.
Just open the image COMPANY LOGO, select the entire image, drag it from
PhotoImpact, and drop it onto the placeholder on the top left corner of
the first column of page two.
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Next, open the image TREASURE CHEST ON BEACH and drag it onto the
lower placeholder in the third column on the first page.

Now, place FRONT COVER PHOTO onto the placeholder on the upper
portion of the third column on the first page.
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The next image to place is the one labeled SNOW SKIERS. Drag it onto the
brochure placeholder located on the lower portion of the first column on
the first page of the brochure.

 

Next, open the image labeled COLORIZED PARK and drag it onto the
placeholder in the middle of the first column of page two of the brochure.
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The last image that you need to place is largest one and labeled RESORT.
Drag it onto the placeholder on the upper half of the second and third
column of page two of the brochure.

With all of the images placed, the brochure is ready to be printed out and
folded. Load letter-sized paper into your printer and choose the Print
command in Word’s File menu. In the Print range group select Current
page to print out only the first page. After printing, turn the page over and
print the second page of the brochure on the back of the first page. This
may take a few practice runs to get the proper orientation if you are unsure
how your printer handles paper.

To fold the brochure, lay the brochure with the second page face up on a
flat surface. Carefully fold the right third of the page over the center third
and then fold the left third over the center third. You should finish with
the front cover of the brochure facing upwards.



Album
This tutorial introduces you to the Album program and takes you step
by step through the process of working with albums and manipulating
thumbnails. You will begin by learning how to create an employee database
for a fictitious company, Worldwide Travel, creating your own customized
fields and performing both simple and complex searches. You will also learn
how to use Album as an OLE server, incorporating your work into a
Microsoft Word document.
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Cataloging your files
The first thing you will want to do in Album is to catalog some of the files on
your system as thumbnails in an album. This is the most basic task in Album,
and one that you will repeat many times.

To create a new album

1. Click the New button on the Standard toolbar or choose “New” [CTRL+N]
from the File menu. The New dialog box opens displaying a number of
templates.

Templates are predefined examples of what you can use an album for.
Each template has a list of fields associated with it. These fields may or
may not be relevant to your work at hand but being fully customizable,
you can easily edit them to better suit your needs. (Editing templates is
explained more fully on p.196.)

2. From the Album template list box, select General Purpose (if it is not
already selected).

3. In the Title entry box, enter a title of your choice and then click OK.
The album is created and you are prompted to start inserting thumbnails.

When you insert thumbnails, you need to specify the files you want to be
collected into the album. You can do this by selecting individual files or
all the files contained within a folder.

4. Click on the Files tab (if it is not already selected) and locate the folder
containing the files you want to catalog. (To insert an entire folder of files,
click on the Folder tab.)
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5. Drag your mouse over the files you want to insert in the File name list
box. (If inserting a folder, select the folder from the Folder list box.)

To select additional files, hold down the Ctrl key and click on a filename.
To select a range of files, click on the first filename in the range, and then
with the Shift key held down, click on the last filename in the range.

6. Click Insert. The selected files are now inserted into the album.

You may need to wait a few moments for the files to be inserted. After the
insertion process has finished, you will see thumbnails of each of the files
displayed in the album. The appearance of each thumbnail may differ
depending on the type of file inserted.

For more information, see:
Creating an album ...................................................................................................... 177
Inserting thumbnails ................................................................................................... 198

Creating a database
From the previous lesson you learned how easy it is to create albums and
catalog files. Albums, however, can do much more than simply keep track of
your files. They can also be fully-fledged databases that allow you to append
all sorts of information to thumbnails using fields, all of which are
customizable and can be searched on or printed out as a reference.

To create an employee database:

In this example you are going to learn how to create an employee database.
The thumbnails in this album will be the pictures of the employees, and the
fields will contain information about each employee.

1. Open the New dialog box by clicking the New button on the Standard
toolbar or by choosing “New” [CTRL+N] from the File menu. The New
dialog box opens.

2. From the Album template list box, select Personnel File. The Total fields
list box changes to display the fields associated with this template.

3. In the Title entry box, enter “Employee”. This will be the name for the
database that appears in the album’s title bar.

Having selected an album template and named the album, you are now
ready to insert thumbnails. However, before you do this, you will first need
to edit the fields in the template so that they better suit your needs.
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To add and remove fields

Fields are powerful, yet very easy to manage, and can be as simple or complex
as you make them. Essential to fields is the field type which defines the type
of data a field can accept. For example, a field whose field type is Number,
can only accept numeric data.

1. From within the New dialog box, click on the Customize button. The
New dialog box opens with three tabs: General, Field, and Advanced.
(“Employee” should automatically be placed in the Title entry box here if
you entered it earlier. If you did not enter it earlier for whatever reason,
please enter it now. )

2. To modify the fields of the template, click on the Fields tab. All the fields
currently associated with the personnel database now appear in the Total
fields list box.

In this example, we want to remove the fields, Previous Employer, Last
Year’s Salary, Date Resigned/Discharged, Reason Resigned/Discharged,
Performance Review Date, and Keyword.

3. Select Previous Employer in the Total fields list box, (you may have to
scroll to locate it), and then click Remove. The field Previous Employer is
now removed. Next, try and remove the other fields you don’t want by
repeating this procedure. (You can of course choose to remove other fields
depending on the type of database you want to create.)

Now that you have removed all unnecessary fields, you’ll need to add one
new field, Age, to your employee database.
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4. In the Field name entry box, type “Age” and select Number from the Field
type combo box. (This identifies the field “Age” as one that will contain
numeric data.)

5. Click Add. The field, Age, is added to the bottom of the Total fields list
box.

To edit a list type field

List type fields are different from other field types in that the data for them
must come from a predefined list of values. Furthermore, all thumbnails can
only be assigned one value.

1. Select Department in the Total fields list box (you may have to scroll
to locate it) and then click Edit List. The Edit List dialog box opens
displaying existing values.

For your company, Worldwide Travel, there are only four departments,
Sales, Marketing, Publication, and Accounting. This means that you need
to remove the values Personnel, Product Team and R&D from the current
value list, and then add Sales and Publication.

2. Click on the value Personnel and then click Remove. The value Personnel
should now be removed from the current value list. Now, do the same for
the values, Product Team and R&D.

3. In the New value entry box, type in “Sales” and click Add. Sales now
appears in the list box. Repeat the same procedure to add the value,
Publication. Once finished, the list should now contain four values:
Accounting, Marketing, Publication and Sales.
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4. Click OK. The Edit List dialog box closes and you are returned to the
New dialog box. To begin inserting thumbnails, click OK again; your
Personnel album is created and you are prompted to start inserting thumb-
nails. (For more on inserting files, refer to number 4 in the lesson “To
create a new album” p.60.) To use the sample files provided, choose the
SAMPLES\TUTORIAL folder on the PhotoImpact CD-ROM and select the
files ALBTUT1 to ALBTUT10.

To enter field information:

Now that you have created an album database, the first thing you will want
to do is enter information into the fields of the album. Before you start,
make sure that your employee database album is active by clicking on its
title bar. (To use the sample employee database provided, open the file,
EMPDB in the SAMPLES\TUTORIAL folder on the PhotoImpact CD-ROM.)

1. Click the Data Entry Mode button on the Standard toolbar, or choose
“Data Entry” from the View: Mode submenu. The current album view
changes to show the data entry view.

The order of the fields is determined at the time the album was first
created. This order may not always be the most convenient for viewing or
entering data. To change this order, you need to drag the fields to new
positions.

2. Click on the field, Job Title, and drop it on top of any field at the bottom
of the album window. This moves the field Job Title down to the position
where you dropped it. Next, try moving the other fields around until the
first six appear in the order shown below.
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3. Now that the fields are in the correct order, you can go ahead and enter
the personnel information into the appropriate fields. To enter informa-
tion, simply click in the appropriate field and begin typing. (To move to
the next thumbnail, click on the forward button at the top of the album.)

If you try typing inside a List type field, a dialog box opens displaying all
the values available in that list. For example, if you try and type inside the
Gender field, a dialog box opens with the two values, Female and Male.
Selecting a value and clicking OK then places that value into the Gender
field.

LAST NAME FIRST NAME DEPARTMENT GENDER DATE OF BIRTH AGE

Quick Felicia Sales Female 11/30/39 55

Alvaro Vanessa Accounting Female 04/26/57 38

Hawkins David Publication Male 07/13/61 34

Delisle Patricia Accounting Female 03/01/70 25

Simpson Kalvin Marketing Male 01/16/52 43

Webber Erica Marketing Female 12/29/33 61

Jones Robert Sales Male 05/15/37 58

Williams Joseph Publication Male 10/16/65 30

Young Leith Accounting Female 03/14/74 21

Schulte Curtis Marketing Male 09/23/41 54

Note: If you are entering a lot of information, you may find it easier to first use
a word processor to enter all your information and then import it into an album,
see p.205. This way you can spell check your work first.

For more information, see:
Creating an album ...................................................................................................... 177
Editing an album’s properties ................................................................................... 196
Entering field data ...................................................................................................... 201
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Searching
Once you have your employee database set up and all the employee informa-
tion entered, you can then locate specific persons or groups. For the employee
database that you have just created, this is not a tough task. However, if you
have several hundred employees to keep track of and need to be able to
provide their information upon request, this may not be so simple.

To performing a search with the search toolbar:

The manager of Worldwide Travel wants to review the records of all
employees between the ages of 55 and 65 for consideration of a special bonus
scheme. (To use the sample employee database provided, open the file, EMPDB
in the SAMPLES\TUTORIAL folder on the PhotoImpact CD-ROM.)
1. In the Search toolbar, click the Search type combo box (first on the left),

and select Age.

2. Move to the Search operator combo box and select Within. This confines
the search to only look for people whose age lies within the Age range
specified in the neighboring entry boxes.

3. Type in 55 in the first entry box and 65 in the second entry box.
4. Click on the Perform search button on the Search toolbar. The search

begins, and the thumbnails of Felicia Quick, Erica Webber and Robert
Jones should now be displayed.

To performing a complex search:

For more complex searches, such as those that require more than one criteria,
you will need to use the Search command in the Thumbnail menu.
For example, you have been asked to find all female employees who are in the
Sales, Accounting, or Publication departments, and have first names that
contain either “fbi” or “cia”.

1. Choose “Search” [CTRL+F] from the Thumbnail menu. The Search dialog
box opens.

2. In the Search criteria group box, select “Gender” from the Search type
combo box.

3. Select Contains in the Search operator combo box, if it is not already
selected, and then enter Female in the Query entry box.

4. To add the criteria to the Search criteria window, click Add. (Do not click
OK yet: you will be adding to this criteria.) The criteria should now
appear in the Search criteria window.
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Next, you need to locate all employees in the Sales, Accounting and
Publication departments. Since there are only four departments in total
(Marketing being the other), it is easier to say that you want all employees
who are not in the Marketing department.

5. Select Department from the Search type combo box, and leave the search
operator as Contains. In the Query entry box, type in “Marketing” and
check the Not and the And logical operators. (Not tells the search to skip
Marketing, while And places the criteria with the existing criteria in the
search window.)

6. Click Add. The new criteria is added after the previous criteria in the
Search criteria window.

Now, for the final part of this search, you need to find all employees with
first names that contain “fbi” or “cia”.

7. Select First Name from the Search type combo box, (leave Contains as
the search operator), and click on the Edit Criteria button. The Edit
Criteria dialog box opens.

8. Enter “fbi” into the Search criteria entry box and then select Or from the
Operators combo box. The operator Or is placed is placed in the Search
criteria entry box. Now repeat this same procedure, except this time type
in “cia” after the Or operator in the Search criteria entry box.

9. Click OK. The Edit Criteria dialog box closes and you return to the
Search dialog box. To add this criteria to the Search criteria window,
click Add.

The Search criteria window now has the three criteria which you want to
perform your search on.

10.Click OK. The Search dialog box closes and the thumbnails of all the
employees that meet the search criteria are displayed. If you did everything
correctly, you should have the thumbnails for Felicia Quick and Patricia
Delisle displayed in your album.

For more information, see:
Locating thumbnails ................................................................................................... 215
Performing a search ................................................................................................... 217
Using the Search toolbar ........................................................................................... 219
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Working with marks
In Album, fields are not the only way to label thumbnails. You can also label
thumbnails with marks. Unlike fields, marks are visual, that is they work on
the surface rather than behind it. This is especially useful when you want to
scroll through the thumbnails quickly and locate certain thumbnails without
having to select each thumbnail to see the field data associated with it.

To demonstrate how to assign marks, let’s return to our employee database
example. Using marks, you will indicate which staff members in the database
are salaried, or contract. (You will need to use the mark panel to assign marks.
If the mark panel is not open, click your right mouse button anywhere on a
toolbar and choose the Mark Panel command.)

To label thumbnails with marks:

Before assigning marks, it is a good idea to first give them a label or
description. This makes it easier to remember what distinguishes one mark
from another. (To use the sample employee database provided, open the file,
EMPDB in the SAMPLES\TUTORIAL folder on the PhotoImpact CD-ROM.)

1. Double-click on any letter in the Mark panel. The Edit Marks dialog box
opens.

2. Select the letter “A” from the Marks list box. (This will be used to
identify the thumbnails of salaried employees.) In the Mark name entry
box, type in “salaried” as the description.

3. Select the letter “C” and then type in “contract” in the Mark name entry
box. (This will be used to identify the thumbnails of contract employees.)

4. Click OK. The Edit Marks dialog box closes and you are returned to the
Album workspace and the descriptions salaried and contract appear next
to their respective marks in the mark panel.

To assign marks to thumbnails:

1. Click on the letter “A” in the Mark panel and then click the Assign
Marks button.

2. Move your pointer onto the album, notice that the pointer changes to a
mark pointer, and place the pointer on a thumbnail and click once. The
letter “A” is immediately shown next to the index number on the thumb-
nail slide. (You can now try and mark several other thumbnails.) To assign
the mark, “C”, click on the letter in the Mark panel and repeat this
procedure. If you have made a mistake or wish to try again, you can
remove the mark by clicking on the thumbnail again.
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3. Once you have finished assigning marks, click the Stop button on the
Mark panel.

To search for a marked thumbnail:

After marking thumbnails, you may find it necessary to search for them.
Apart from browsing through the album, you can use the Mark panel’s
built-in search features.
1. Click on the letter “A”, and with the Ctrl key held down, click on “C”.

The letters “A” and “C” are now selected.

2. Click the View Mark button on the Mark panel and choose Or from the
menu. This immediately displays all the thumbnails with either “A” or “C”
as marks. (Choosing And searches for all thumbnails which have both “A”
and “C”.)

For more information, see:
Assigning marks ......................................................................................................... 219
Viewing marks ............................................................................................................. 221

Using Album with other programs
This lesson provides an example of how you can use Album so that it fits
hand in glove with your other office suite programs. For example, you need to
introduce all the members of the Accounting department at Worldwide Travel
in a newsletter that’s coming out the end of this month. Using Album’s search
facilities, you should be able to easily locate these staff. (If you have trouble
doing this, refer to the lesson on using the Search toolbar, p.66)
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To place thumbnails into Microsoft Word:

If your search was successful, the thumbnails Vanessa Alvaro, Patricia Delisle
and LeithYoung should appear in the employee album. (To use the sample
em ployee database provided, open the file, EMPDB in the
SAMPLES\TUTORIAL folder on the PhotoImpact CD-ROM.) The next step is
to drag these thumbnails from the album to the Microsoft Word document
containing the newsletter. (If you have Microsoft Word, run Word, and open
the sample file, NEWSLETT, in the SAMPLES\TUTORIAL folder on the
PhotoImpact CD-ROM.)

1. Click the Compact Mode button on the status bar or choose “Compact
Mode” from the View menu. The program window disappears from view,
leaving only the active album and toolbars visible.

It is much easier to move thumbnails between programs using compact
mode, as you can better see the target program or programs. (You can still
access all of Album’s menu commands by clicking the Display Menu
button.)

2. Drag the thumbnail for Vanessa Alvaro to the word document and drop it
into the box labelled “Employee 1”. The photo should now appear in the
newsletter document. Now, do the same for Patricia Delisle and Leith
Young.

Congratulations, you have now finished your newsletter!

For more information, see:
Drag-and-drop thumbnails to other programs ........................................................ 187
Working in compact mode ......................................................................................... 189



Chapter 1

PhotoImpact fundamentals
This chapter and the next describe the basic commands and features you
will use most often in PhotoImpact. As such, both chapters do not go into
advanced image editing or enhancement techniques, but do give you the
information you need to understand the fundamentals of PhotoImpact.

This chapter begins with a discussion of the PhotoImpact preferences and
then examines common file operations such as opening and saving a file,
recovering from mistakes, and printing out your images.

Chapter contents at a glance
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Customizing the way you work
One of the first commands in PhotoImpact that you will want to get
familiar with is the Preferences command in the File menu. This allows you
to customize the way PhotoImpact looks, as well as operates, so that it better
suits your work habits. When you choose the Preferences command, a dialog
box opens allowing you to set various options specific to PhotoImpact as well
as those common to its supporting programs.

PREFERENCES DIALOG BOX: PHOTOIMPACT TAB

The PhotoImpact tab allows you to modify the way the program operates.
You can, for example, set the measurement unit to inches instead of pixels,
give yourself more levels of undo, perform enhancements at higher quality
levels, and automatically load external plug-in effects.

Measurement unit  can be in pixels, inches, or centimeters. All image size
information and ruler measurements are based on this setting. (This can also be
changed by clicking the Measurement Unit button on the Status bar.)

Enable undo allows you to take advantage of the multiple undo/redo
feature in PhotoImpact and to set the number of undo levels that you wish to
make available (up to 99 levels). As PhotoImpact allocates more memory for
each level of undo/redo, you may find that too high a level adversely affects
performance. In such cases, try setting the level of undo/redo to a lower value,
such as 3 or 4. You can, of course, disable Undo, but this means that any
editing done to an image is final.

Number of recently opened files specifies the number of files listed at the
bottom of the File menu (up to 9). By clicking on a name from the list you
immediately reopen that file in the workspace.
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Generation quality  allows you to set the quality of any effects and filters.
A higher quality results in better image reproduction but may take longer to
calculate.

Highlight inactive selections and objects  displays, or hides, a dark border
around objects and selections that are not active. Check this option if you have
trouble keeping track of objects in an image.

Display a confirmation message when saving displays, or hides,
a confirmation message whenever you save a file containing objects to a
non-UFO format, or for when saving a file to a format that involves a
compression scheme where image data is lost, such as JPEG.

Display quick samples  allows you to display, or hide, the sample thumb-
nails that appear whenever you open an enhancement or effect dialog box.

Load plug-in effects during initialization  automatically adds any plug-in
filters installed on your system to the Effect menu each time you run
PhotoImpact.

PREFERENCES DIALOG BOX: ASSOCIATE TAB

The Associate tab allows you to determine which file format is associated,
or linked, to PhotoImpact. For example, you can specify that all BMP files be
associated to PhotoImpact. The next time you double-click on a BMP file in
Windows Explorer, it will open up in PhotoImpact, irrespective of which imaging
program it may have originally been created in.

Associate file extension with PhotoImpact list box displays all the file
formats supported by PhotoImpact. To associate a file format to PhotoImpact,
click on the checkbox of the appropriate format’s file extension.

Add Ulead Quick Viewer to Explorer  allows you to add the Viewer
command to the right mouse button pop-up menu of Windows Explorer.
The next time you display this menu, choose the Viewer command to run the
Viewer utility of PhotoImpact for quickly viewing image files.
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Common preferences options
Each program in the PhotoImpact package has a Preferences dialog box that
shares the following tabs: Memory, Display, and Photo CD. Changes you make
to any option in these tabs are reflected in all the programs, irrespective of
which program you change them in. For example, if you calibrate your
monitor in PhotoImpact, all other programs will have the same calibration.

Note: The Album Preferences command has a submenu of two commands,
Album and General. Album opens a dialog box just for Album program related
features, whereas General opens a dialog box of all the shared features.

PREFERENCES DIALOG BOX: MEMORY TAB

The Memory tab gives you the opportunity to specify folders that provide
additional working space when working with files. You can also determine how
much space is allocated on the hard disk for virtual memory as well as how
much space is allocated in RAM for use by all Ulead programs.

Define additional folders for virtual memory  allows you to specify the
folder used by the PhotoImpact programs as additional working space. For
example, when you don’t have enough RAM, the PhotoImpact programs can use
extra memory from the hard disk (virtual memory) as temporary RAM. The first
folder shown in the Memory tab is the TEMP folder defined by the SET TEMP
statement in your AUTOEXEC.BAT file. If you have more than one drive on your
system, you can specify more than one temporary folder in the available entry
boxes. If not, leave the entry boxes empty.

Hard disk indicates the space available on your hard disk. (The folder
specified in the Define additional folders for virtual memory section must be
located on this hard disk.)
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Limit hard disk usage to  allows you to specify how much memory you want
to allocate to the PhotoImpact programs for use as virtual memory. If you want to
run other programs in the background, then choose about ½ the maximum
amount. To use PhotoImpact defaults, leave this option unchecked.

Limit RAM usage to  allows you to specify how much memory you want to
allocate to the PhotoImpact programs for use in RAM. If you want to run other
programs in the background, then choose about ½ the maximum amount. To use
PhotoImpact defaults, leave this option unchecked.

PREFERENCES DIALOG BOX: DISPLAY TAB

The Display tab allows you to modify the way images are displayed as well as
calibrate (adjust) your monitor. You should calibrate your monitor whenever you
change monitor, display adapters or the environment in which you work,
(as lighting and temperature can also affect a monitor’s performance).

Hi-Color dithering  allows you to improve the display of True Color images
when you are in Hi-Color display mode.

View images with a common palette  displays all images using the system
palette. This is only enabled when you are in 256-Color display mode and makes
your work quicker as there is no need to repaint any of the images with a new
palette. This option is particularly useful when preparing CD-ROM based titles
and you need to see how images appear in 256-Color display modes.

Ignore background quality  is enabled when in 256-Color display mode and
improves performance by not repainting any background images when you
change views. (Do not check this option if you need to identify background
images.)

Monitor gamma  allows you to calibrate your monitor for the optimum display
of images. (For more information, see the procedure on the following page.)
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To calibrate your display:

1. Choose “Preferences” from the File menu, the Preferences dialog box
opens, and click on the Display tab.

At the bottom of the tab are two grayscale squares. The top square is a
chequered pattern of black and white pixels, which when viewed from a
distance, give the feeling of 50% gray. The bottom square is 50% gray as
your monitor currently shows it. In a well calibrated monitor, both of these
squares should look approximately the same.

2. Examine the two color squares, and if the two squares look different,
adjust the Monitor gamma spin box until the bottom square looks similar
to the top square.

The monitor gamma value can be any number from 0.01 to 7.99. If none
of the squares exactly match, try and estimate the best match. In general,
your value should fall within 0.8 – 2.4; if not, try adjusting the brightness
and contrast controls on your monitor.

3. Click OK. The dialog box closes and your monitor is now optimized for
displaying images in the PhotoImpact programs.

Note: When using Capture to capture screen components to either the Capture
or PhotoImpact workspace, you may find some difference between display color
and captured color. If this occurs, uncheck the Monitor gamma option.

PREFERENCES DIALOG BOX: PHOTO CD TAB
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The Photo CD tab gives you the option of determining the resolution and data
type of any image file imported from a Kodak Photo CD. These options can also
be changed directly from the toolbar in the CD browser program.

Resolution allows you to specify the resolution for images opened from a
Photo CD. It is important to remember, the higher the resolution, the larger the
file size of the image.

Data type determines the respective data type for any images imported from
a Photo CD. True Color provides the most colors, but also results in larger file
sizes. Grayscale has the lowest file size, but the images contain no color. To
retain some color but keep the file size down, choose one of the Indexed-Color
options.

Working with image files
Before you get started with PhotoImpact, you need to bring an image into the
PhotoImpact workspace. This can be done in a number of ways, the easiest
being to click the Open button on the Standard toolbar.

Opening image files
After installation you will find a number of files in the SAMPLES\IMAGES
folder inside your installation folder. To open these files, or other image and
graphics files, click the Open button on the Standard toolbar or choose the
Open command [CTRL+O] in the File menu. The Open dialog box appears
displaying files in the current folder that correspond to the type shown in the
Files of type combo box.

To open a file, select its filename and click OK. (Double-clicking on the
filename also opens the file.) The dialog box closes and the file is opened in
the PhotoImpact workspace. To open multiple files, use the Shift key in
conjunction with your mouse to select a range of files or the Ctrl key to
select, or deselect, individual files. Once selected click OK. The images open
in individual windows in the program workspace.

Notes:
• When you open a graphics file which does not contain bitmap data, it is

converted into an image. (The data type of this image is the same as your
current display mode.) You can then edit it in the same way as other images.

• You can also open the files you have most recently worked on by choosing
their names from the list at the bottom of the File menu. (The number of files
that appear here is controlled by the Number of recently opened files option
in the Preferences dialog box, see p.72.)
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Creating new images
In many cases your images will have been obtained with an image input
device such as a scanner or frame grabber, or you will have opened them from
your hard disk or a CD-ROM. At other times you will want to start with a
new, or “clean” image window for compiling elements of other images
together or for using PhotoImpact’s painting tools.

To create a new image:

1. Click the New button on the Standard toolbar, or choose “New” [CTRL+N]
from the File menu. The New dialog box opens.

2. Click on one of the data type buttons to choose the data type of the new
image.

You can choose from Black & White, Grayscale, Indexed 16-Color,
256-Color, or True Color data types. (For more information on data types,
see "Imaging essentials" in the on-line Help.)

3. Set the image dimensions in the Image size group box.

Choose Standard if you want to use default image sizes or Active image to
set the size to be the same as the currently active image (this option is
disabled if there are no images open in the workspace). To define your
own, choose User defined and enter in the dimensions of the image in the
Width and Height entry boxes.

4. Enter a value for the image’s resolution in the Resolution entry box and
select either Pixels/Cm or Pixels/Inch in the combo box.

If the Measurement unit option in the Preferences dialog box (see p.72)
is in centimeters or inches, the resolution determines how many pixels are
used to create the image: the higher the resolution, the greater the number
of pixels and therefore the greater the amount of memory required to store
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the image. When the Measurement unit is pixels, the resolution
determines how large your image will be when printed. The higher the
resolution, the smaller your image will print (the memory required to store
the image, however, remains the same).

5. Click OK. The dialog box closes and the new image, filled with the
background color, appears in an image window.

Applying the same command to multiple files
Because PhotoImpact allows you to work with multiple files, it is very easy to
accumulate a large number of files in the workspace. Often you will want to
remove these, save them, or perform the same command to a selected few.
To help you do this, PhotoImpact provides a batch manager, accessed by
double-clicking in the workspace or by choosing the Batch Manager
command in the Window menu. Once invoked, the batch manager opens and
displays the filenames and thumbnails of all the files present in the workspace
as well as a combo box of commands that can be applied to them. To perform
a batch operation, select the command and the files you want the operation
to be performed on and click OK – the batch manager does the rest for you.

Duplicating images
As you work with an image you may find the need to make a copy of it.
This can be useful as it allows you to continue editing the copy without the
danger of losing work you have already done on the original. PhotoImpact
offers you three different kinds of duplication. You can duplicate the entire
image, including the base image and all objects, duplicate the base image
alone, or duplicate the image with all objects merged onto the base image.
(For a more thorough discussion of objects, see chapter 5, p.131.) Whenever
you create a duplicate image, it opens in a new image window.

To create a duplicate image you can:

• Choose the desired duplication command from the Edit: Duplicate
submenu.

• Choose the All command from the Edit: Select submenu to select the
entire image and then drag the selection onto the workspace. (This works
only if the image has no objects.)

• Drag an object from an image, or the Object Library, onto the workspace.
• Copy an image onto the clipboard and then use the As a New Image

command in the Edit: Paste submenu.

• Using a selection tool, select part of an image and drag it onto the
workspace.
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Saving images
Because PhotoImpact is an object-based editing program, any work you have
done that involves objects can be saved in a special Ulead File for Objects
format (UFO). A UFO file consists of the original base image and any objects
you may have created. (For more on objects, see chapter 5, p.131.) The
advantage of a UFO file is that it allows you to open the file at a later date
and still edit the objects and base image independently.

Note: To save images for use in other image editing programs, you need to
save the image in a file format other than UFO.

To save an image in a non-UFO format, you must use the Save As command
in the File menu. Any objects present are merged onto the base image. As
such, it is important to remember that you cannot edit or recover any objects
which have been saved in this way.

To save an image:

1. Click the Save button on the Standard toolbar, or choose the Save As
command in the File menu. The Save As dialog box opens.

2. In the Save in list box, select the folder you want to save the image to,
and then select a format from the Save as type combo box.

Choose “UFO” if you want to save any objects that are in the image.
Choosing any other format merges objects onto the base image.

3. In the File name entry box type the name of your file. You do not need to
enter the File extension.

Note: If you type in an extension, ensure that it is the same as the extension
shown in the Save as type combo box. This is because PhotoImpact saves
the file using the format specified here, regardless or what extension is
typed in.

4. Click Save. The image file is saved and the dialog box closes returning you
to the workspace.

Sending Images by electronic mail
With the Send command in the File menu, you can send an image to anyone
else connected to your PC through MS Exchange (Windows 95) or MS Mail
(Windows NT). When you choose the Send command, the Send Mail dialog
box opens allowing you to enter the subject and text of the message that you
wish to send. To attach an image file to the message, check the Image file
checkbox. To send the message, click OK; the Choose Profile dialog box
opens, allowing you to select an information service to be used as the sending
agent.
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Using the Quick Command panel
PhotoImpact provides you with a fast way to access commonly used commands
with the Quick Command panel. To display the Quick Command panel,
check the Quick Command Panel option in the Toolbars & Panels dialog box,
accessed by choosing the Toolbars & Panels command in the View menu.

The advantage of using the Quick Command panel over the menu bar is that
you can customize the commands that appear there, as well as resize and
position the panel so that it is always where you want it. By choosing the
Layout Options command in the Quick Command panel’s control menu,
you can set the size of the custom and cache areas. The custom area is the top
part of the panel and displays commands that you specify, whereas the cache
area occupies the bottom part of the panel and displays your most recently
used commands.

To specify which commands to display in the custom area, choose the Modify
command in the Quick Command panel’s control menu. This opens a dialog
box allowing you to add or remove any command from the custom area as well
as assign command names’ aliases. For example, T&P can be used as an alias
for the Toolbars & Panels command in the View menu. Used in this way,
aliases help keep the Quick Command panel relatively narrow, taking up less
space on the screen.

Recovering from mistakes
PhotoImpact remembers every action and command that you use when editing
an image. This is very useful as you may sometimes wander down the wrong
editing path and want to backtrack to the point where that path began.
PhotoImpact makes this easy by giving you multiple levels of undo and redo.
(To control the number of levels of undo or to disable the undo/redo feature,
see the Preferences dialog box, p.72.)

Using Undo
If you change your mind about an action or series of actions that you have
performed, click the Undo button on the Standard toolbar and the most
recent action is reversed. To reverse more than one action, choose the Undo
Before com m and [CTRL+Z] in the Edit menu. A submenu of the most recent
actions appears with the most recent action at the top. Choose the action you
wish to undo up to and the effect of the action, and all above it, are reversed.
The image is then restored to its state prior to the application of those actions.
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Using Redo
When you wish to reapply an action that has been undone, click the Redo
button on the Standard toolbar and the action is reapplied. If you want to
reapply a series of actions that have been undone, use the Redo To command
[CTRL+Y] in the Edit menu. When you choose Redo To, a submenu of undone
actions appears with the most recent one being on top. Select the undone
action that you wish reapplied and all undone actions above that will be
reapplied as well.

Clearing your undo/redo list

Repeated use of the Undo Before and Redo To commands can use up valuable
system resources, as well as leave you with a mixture of desired and undesired
actions applied to your image. For this reason PhotoImpact gives you the
option of clearing the Undo Before and Redo To submenus with the Clear
Undo/Redo History command in the Edit menu. When choosing this
command all actions from the Undo Before and Redo To submenus are
removed automatically. (Be careful when you use this command, as it cannot
be undone.)

Restoring an image
When a series of undesirable changes have been made to an image that
cannot be easily undone with the Undo Before command, you have the
option of using the Restore command in the File menu. Restore cancels all
changes made to the image since it was last saved. (This essentially closes the
file and reopens it.) Before using this command, consider carefully because it
cannot be undone. If in doubt, create a duplicate image before restoring so
that you can compare the current stage of your work with the original.

Printing images
PhotoImpact provides extensive print options to give you full control over
printing images. To print an image, click the Print button on the Standard
toolbar, or choose the Print command [CTRL+P] in the File menu. The Print
dialog box opens displaying various printing options. Basic printing options
allow you to select which printer to print from, the number of copies to print,
and where on the page to print the image.

Using Print Preview
PhotoImpact allows you to see what your printed image would look like
before actually with the Print Preview button on the Standard toolbar or the
Print Preview command in the File menu. When you activate Print Preview,
PhotoImpact switches from normal editing mode to print preview mode.



PHOTOIMPACT FUNDAMENTALS 83

In print preview mode you can use the buttons across the top of the
workspace to access basic printing and layout options. For example, click the
View button to zoom in and out on the preview or to return to the default
full page view. To position the image in the center of the page, choose the
Center Horizontally and Center Vertically commands in the Options menu
button or drag the image freely with your mouse. You can also resize the
image by clicking the Resize button and then dragging the control points that
appear on the image.

Calibrating your printer
All printers print images differently, for example, some consistently print
shadowed areas too dark, or highlighted areas too light. PhotoImpact can
easily compensate for this kind of printing problem through calibration.

To calibrate your printer:
1. Click the Print button on the Standard toolbar or choose “Print” [CTRL+P]

from the File menu. The Print dialog box opens.
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2. Click the Options button. The Options dialog box opens displaying a
calibration curve as well as an extensive range of preset calibrations.
(For more on modifying a calibration curve, see “Using the tone mapper”
p.104.)

3. Uncheck the Use printer’s default checkbox.

The other options in the dialog box are now enabled allowing you to
manually adjust the calibration curve.

4. Click the Enhancement button. A pop-up menu appears listing commands
of the various enhancements you can apply to the calibration curve.

Select an enhancement command that corrects one or more of your
printer’s problems. For example, if your printer makes midtones in an
image too light, select the Darken Midtone command. If no enhancement
command can effectively correct your printing problems, you can manually
adjust the calibration curve by dragging your mouse over the curve. After
adjusting the calibration curve, save it by clicking the Save button.
Whenever you print in the future, this calibration curve will be applied to
the printed image resulting in a more consistent printout.

Working with halftones
Whenever you are printing, you will probably encounter halftoning.
Halftoning is a process of creating a pattern of black and white dots to
simulate shades of gray (for a black and white printer) or using cyan, magenta,
yellow, and black dots to simulate shades of color (for a color printer). For
everyday printing, check the Use printer’s default checkbox in the Options
dialog box (accessed from the Print dialog box). This leaves the halftoning to
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the printer and should produce the quickest and most acceptable results.
However, for customized results, you will need to uncheck the Use printer’s
default checkbox and modify the halftoning options.

Note: The Halftone feature does not appear in the Options dialog box if your
printer does not support custom halftoning.

PRINT OPTIONS DIALOG BOX: HALFTONE TAB

Use Printer’s Default  allows the printer to perform halftoning. By
unchecking this option you can then modify the halftoning process yourself.

Shape determines the shape of the dots used to construct the halftone
pattern. The shape that you choose depends on the image that you are printing
and the type of effect that you wish to produce. Normally, you would choose a
shape that produces the least discernible dithering pattern, such as oval.
However, if you wish to give your image a more textured look then select
another shape, such as diamond.

Optimized screen  allows you to select from preset halftone screen settings
that your printer driver provides, or to select your own halftone frequency and
angle settings.

Frequency controls the distance between halftone dot centers, measured in
lines per inch, or lpi. A high frequency value results in smaller dots (because
the lines are closer together) and a low frequency value results in bigger dots
(because the lines are further apart). For printers with a 300 dpi resolution, a
frequency of 53 lpi is considered near optimum. For higher resolution printers,
use a frequency between 90 and 200 lpi.

Angle determines the angle of the halftone screen as it is applied to the
image. For grayscale images, 45° is considered to be the optimal angle,
however if your image has strong visual elements at or near 45° you may want
to try other angles.
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Working with PostScript printers
If your Printer supports PostScript, PhotoImpact allows you to specify various
PostScript settings to produce the best looking print output possible. Through
the PostScript feature in the Options dialog box, accessed from the Print
dialog box, you can take advantage of PostScript Level II features, such as
setting the image quality and compression level.

PRINT OPTIONS DIALOG BOX: POSTSCRIPT TAB

Use PostScript level 2 features  allows PhotoImpact to take advantage of
PostScript level 2 commands. Left unchecked, PhotoImpact uses standard level
1 commands. (Check with your printer to see what level it supports.)

Best quality sends more information to the printer for the best quality image
output. (Checking this option does result in slower printing times.)

Compress bitmap  sends any images to the printer in a compressed format.
This does speed up printing, but may degrade the quality of the image output.

Compress allows you to choose the type of compression scheme to use
when you have cheked the Compress bitmap option.

1

2

3

4

1

2

3

4



Chapter 2

Mastering the basics
The previous chapter introduced you to some of the fundamental concepts
and behavior of PhotoImpact. This chapter takes you to the next step,
explaining basic image editing operations such as copying and pasting image
data, using the Auto-Process feature, controlling the view of your images,
and using OLE 2 to perform drag and drop operations and “in-place”
editing.

Chapter contents at a glance

Using the clipboard........................................................................................................88

Automatically enhancing an image...............................................................................90

Controlling the view of an image ..................................................................................92

Performing OLE operations ..........................................................................................95
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Using the clipboard
Many commands in PhotoImpact make use of the clipboard. The clipboard is
a temporary storage area for any type of information. This may be an image,
text or even sound; but the clipboard can only hold one piece of information
at a time. When you place something onto the clipboard, existing clipboard
data is overwritten: irrespective of whether you placed new data onto the
clipboard from another program or from PhotoImpact.

Performing a cut and copy operation
The most common methods of placing data onto the clipboard are clicking
the Cut [CTRL+X] and Copy [CTRL+C] buttons on the Standard toolbar, or
choosing their respective commands from the Edit menu. Copy places a
duplicate of a selected area or object onto the clipboard whereas Cut deletes
the selected area or object and places it onto the clipboard. (If cutting a
selected area, the image is filled with the current background color.) When
there is no selection area, both Cut and Copy are applied to the entire image.

Performing a paste operation
After cutting or copying image data, you can then paste it from the clipboard
onto an image by clicking the Paste button on the Standard toolbar or
choosing one of the five paste commands from the Edit: Paste submenu.
(The Into Selection and Fit Into Selection commands are disabled when there
is no current selection. All paste commands are disabled if the clipboard is
empty or the content of the clipboard is from another, incompatible program.)
Whenever you paste data into an image, it becomes an object and floats
above the base image and any other objects.

Notes:
• PhotoImpact allows you to paste image data onto any image, regardless of

data type. If pasting onto an image of a different data type, the pasted data is
converted. At times this may cause an extreme change in color; for example,
pasting a True Color image into an Indexed 16-Color image.

• When pasting an image, it is placed pixel-on-pixel. If your source and target
images are at different zoom levels, the clipboard image may appear to be
enlarged or reduced after pasting.

Pasting images as objects

The standard paste command in PhotoImpact is the As an Object command
[CTRL+V], which can also be accessed from the Standard toolbar by clicking
the Paste button. When you paste an image as an object, the image is pasted
at the top left corner of the current view. (For a thorough discussion of
objects and working with them, see chapter 5, p.131.)
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Pasting images into a selection area

Use the Into Selection command when you want to paste a clipboard image
into a selection area. This command is useful when you want to fill a
selection area with image data.

To paste clipboard data into a selection:

1. Select an area on the image where you want to paste the clipboard image
into.

2. Choose “Into Selection” from the Edit: Paste submenu. The clipboard
image then appears inside the selection area.

Notice how the top left corner of the clipboard image remains connected
to your mouse. This allows you to move your mouse while at the same
time reposition the clipboard image anywhere within the selection area.

Note: Pressing the Esc key before you have finished the pasting operation
automatically removes the clipboard image.

3. Move your mouse around to position the clipboard image in the selection
area as desired.

4. Click your mouse. The clipboard image is then anchored in the selection
area as an object.

Note: If the pasted image is smaller than the selection area, it is placed at
the top left corner of the selection. The remaining areas of the image are left
unaffected.

Pasting images to fit into a selection area

Use the Fit Into Selection command when you want to paste the clipboard
image inside a selection area so that the entire image fills the selection.
Depending on the size of the clipboard image, this can degrade the image as it
may have to be expanded or compressed to fit the selection area.

    

Original selection Pasting into the selection Pasting to fit into the
selection



CHAPTER TWO90

Pasting images into a new image window

If you want to paste a selection into its own image window, use the As a New
Image command. This command is useful when you want to save an object,
or selection area, as its own image, or have copied an image from another
program and want to place it in its own window. (You can also accomplish
this by dragging an object from an existing image onto the workspace.)

Pasting images beneath the mouse pointer

The Under Pointer command allows you to place the clipboard image onto
the base image wherever you click your mouse. When you choose this
command, the top left corner of the clipboard image remains connected to
your mouse. This allows you to move your mouse while at the same time
reposition the clipboard image anywhere within the image. Clicking your
mouse anchors the image in place as an object.

The Clipboard submenu
To help you work with the clipboard, PhotoImpact provides the following
commands in the Edit: Clipboard submenu:

Load brings image files and previously saved clipboard images onto the
clipboard. This command is similar to the Open command, but rather than
opening a file and placing it into a new image window, Load places the file
onto the clipboard.

Save saves an image from the clipboard to a file. After saving, you can open
this image as you do any other images or bring it back onto the clipboard
with the Load command.

Display shows the current clipboard image in a Windows clipboard viewer.
To close the clipboard viewer, press any key or click your mouse.

Automatically enhancing an image
Whether you are learning image editing for the first time, or you just don’t
have time for more involved image enhancement, PhotoImpact provides the
Auto-Process commands for automatic and intelligent control over most areas
of your image’s appearance. When you use Auto-Process, PhotoImpact
examines an image or object and applies any necessary modifications to make
that image look better. For example, images that have been scanned can often
benefit from simple image processing techniques to correct bad cropping, poor
brightness and contrast, wrong color balance, and other easy-to-fix image
problems.
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To use Auto-Process:

1. Click the Auto-Process button on the Standard toolbar, or choose “Batch”
from the Format: Auto-Process submenu. The Auto-Process dialog box
opens containing seven auto-process options that you can apply to an
image or object.

2. Click on the auto-process options that you wish to perform. The options
appear on the process queue from left to right in the order selected, and
the preview image changes accordingly to give you an idea of the resulting
effect.

The auto-process options are applied successively in the order of their
selection. You can change their order by dragging them from one position
to another. To remove an option, click on its button or drag it off the
queue. To see more clearly how the options affect the image, click Preview.
The auto-process options are applied to the image and the Auto-Process
dialog box is replaced by a confirmation bar. The OK button accepts the
modifications while Cancel rejects the modifications, closing the confirma-
tion and returning you to the workspace. The Undo/Redo button allows
you to better compare the before and after views of the modifications and
Continue returns you to the Auto-Process dialog box, allowing you to
further edit the selected options.



CHAPTER TWO92

3. Click OK. The dialog box closes and the auto-process options are applied
to the image.

Note: Most of the options in the Auto-Process dialog box can be accessed
independently by choosing their respective command in the Format:
Auto-Process submenu.

Controlling the view of an image
When you open an image in PhotoImpact, the pixels of the image are
“mapped” onto your screen pixels. Controlling the mapping of these pixels
determines the way you see images. For example, the actual view (1x) of an
image is when one image pixel is mapped to one screen pixel.

Zooming on an image
When you edit an image, you may want to see part of it in greater detail or
more of the image at a smaller size. You can do this in several ways: with the
Zoom In and Zoom Out commands in the View menu, using the Zoom tool in
the Tool panel, or by selecting a zoom magnification in the Zoom combo box
on the Standard toolbar. In all, you can zoom in to an image by 16x or out to
1/16x.

The Zoom tool on the Tool panel provides an alternative to the Zoom In and
Zoom Out commands and allows you to accurately zoom in on particular areas
of an image. You can use the Zoom tool in a number of ways:

• Clicking your left mouse zooms in on the area under your mouse pointer.

• Holding down the Shift key and clicking the left mouse button zooms out
from the image.

• Clicking the right mouse button returns the image to actual view (1x).
• Dragging your mouse creates a rectangular viewing marquee. When you

release your mouse button, the image automatically zooms in on the area
defined by the marquee. (If the viewing area is too large or the image is
already at 16x magnification, the view will not be adjusted.)

Notes:
• You can also press the “+” and “-” keys to zoom in and out on images,

irrespective of the current tool selected.
• Pressing down the Z key while using another tool automatically switches that

tool to the Zoom tool. Releasing the Z key then switches the tool back.
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Adding a view
After having zoomed in on an image it is easy to get lost in a sea of pixels.
To help you keep the “big picture” in mind you can use the Add a View
[CTRL+I] command in the View menu. The Add a View command creates a new
window containing an additional view (at 1x) of the image you are working
on. This new window is not just a duplicate of the original: it is actually a
dynamic “mirror” of the original. That is to say, when you do any editing in
either of the windows the changes are reflected in the other. Thus, you can
edit fine detail at a higher magnification in one image window and at the same
time see the overall effect of that editing in the other image window.

  

Using the Global Viewer
When an entire image cannot be displayed within its image window, you would
normally have to use the scroll bars to locate hidden areas. The Global Viewer
in PhotoImpact provides a better way by displaying a thumbnail view of the
entire active image. This thumbnail image contains a floating frame that can
be moved independently around the viewer. Moving the frame automatically
repositions the current view of the active image. To access the Global Viewer,
click on the box that appears at the intersection of the scroll bars at the lower
right corner in an image window whenever the image is larger than its window.
This displays the Global Viewer at the corner of the image window allowing
you to change the view quickly and easily. When you release your mouse the
Global Viewer disappears.

Image at
actual view

(1x), enlarged
to 3x, and

reduced to ½x

Editing an
image (at 3x)

with a view
added
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Fitting an image in its window
When you use the zoom commands, the image window does not change to fit
the new image size. Therefore, after zooming in the entire image may not be
displayed in its window and scroll bars appear along the window border. If you
wish to display the complete image within its window choose an available
zoom command from the View: Fit in Window by submenu. (The maximum
zoom level available is determined by the size of the image and the resolution
of your current display mode.)

Viewing images at full screen
To maximize the amount of space to work in you can choose to display
PhotoImpact in full screen mode with the Full Screen command [CTRL+U]
in the View menu. When you choose this command, the active image is
displayed at the current zoom level occupying the entire screen; in its default
mode the program window and all docked toolbars and panels are hidden,
leaving only the image in view.

Full screen mode is very useful when you want to edit an image in as much
space as possible without the distractions of the program window. Any
floating toolbars or panels will remain visible in this mode allowing you to
continue working on your image. (To return to normal screen mode press the
Esc key.) If you prefer to have all the toolbars and panels present, choose the
Remove Menu Bar command in the View menu. This removes the title and
menu bars of the PhotoImpact screen only, leaving all other screen elements
present. (You can still access menu commands by using their keyboard short
cuts keys. To return to normal screen mode press the Esc key.)

Using the
Global Viewer

to reposition
the view of an

image
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Performing OLE operations
PhotoImpact supports linking and embedding features that allow you to easily
modify objects that have been embedded into other container programs.
The following section describes the different ways to link and embed objects
and how to edit them once they are in place.

To link an object from PhotoImpact:
1. Click the Copy button on the Standard toolbar, or choose “Copy” [CTRL+C]

from the Edit menu to place the currently active image onto the clipboard.

2. Open or switch to the container program containing the document into
which you want to place the object.

3. Choose the container program’s Paste Special command. The Paste Special
dialog box appears.

Note: Some container programs have a Paste Link command. You can use this
as an alternative to the Paste Special command.
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4. Select “Ulead PhotoImpact Image Object” from the As list box. (If the
Paste Link option is not enabled then select another object format that is
compatible with the container program.)

5. Click on the Paste Link radio button and then click OK. The dialog box
closes and a representation of the object appears in the container
program’s active document.

Note: Each container program may use a different Paste Special dialog box.
If any of the above procedures do not conform to the container’s dialog box,
see the program’s OLE documentation.

To embed an object from within a container program:

1. Open or switch to the container program containing the document into
which you want to place the object.

2. Choose “Object” from the Insert menu. The Object dialog box opens.

3. Click on the Create from File tab and enter the name and location of the
object’s source file.

4. Uncheck the Link to File option if it is checked and click OK. The object
appears in the container program’s active document.

Note: You can also paste objects from PhotoImpact by drag-and-drop. Pressing
the Ctrl key as you drop an object embeds it.

In-place editing of embedded objects

You can edit an image embedded in a container document in-place by double-
clicking on the embedded object. This displays PhotoImpact’s toolbars and
panels in the container’s program window allowing you to edit the image from
within the container program just as you would within PhotoImpact. Click
anywhere off the embedded object to display the container’s original toolbars.
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Enhancing images
PhotoImpact includes a powerful arsenal of image enhancement tools that
enable you to make images look their best. From fast on-screen dynamic
color correction to convenient drag-and-drop image styling, PhotoImpact
takes the guesswork out of image enhancement.

This chapter begins by examining when and why you might need to use
color correction and discusses how PhotoImpact adjusts an image’s color.
It then takes a look at the Style Gallery, a resource library of predefined
image styles that you can use to quickly change the “look” of an image and
continues with a detailed explanation of PhotoImpact’s other image
enhancements, special effects and filters.

Chapter contents at a glance

Understanding color correction.....................................................................................98
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Understanding mapping curves..................................................................................104

Applying special effects and filters.............................................................................107
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Understanding color correction
Color correction is a basic tool of image enhancement. By using the color
correction tools in PhotoImpact you can, for example, remove the yellowish
tint that makes a photograph look old, make dull colors stand out, or make a
blue sky look bluer. This ability to correct color is particularly important
when working with scanned images whose colors don’t match their original
source images.

What is color?
In image editing, it is easiest to refer to the colors in an image in terms of
their hue, saturation, and brightness (HSB). Hue refers to color, saturation
the intensity, or amount of color, and brightness to the amount of white or
black that appears in a color. By manipulating these color values PhotoImpact
is able, for example, to shift the hue of the image without affecting the
saturation and brightness. In this way specific colors can be corrected without
affecting other colors which need no correction.

Note: For more about color and how it relates to images, see “Imaging
concepts” in the on-line Help.

Using the color correction commands
PhotoImpact provides several commands in the Format menu that offer a
wide variety of control over color correction. In most instances these
commands can be applied to selected areas, objects, or to entire images.
However, some of the commands are not applicable to certain data types,
or they cannot be applied to selected areas in certain data types.

    

    

The Format
commands,

from left:
Brightness &

Contrast, Color
Balance, Hue
& Saturation,
Focus, Invert

and Level
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When you choose a color correction command, a dialog box opens displaying
sample thumbnails of the currently active image, object, or selection area.
Some commands display nine thumbnails and allow you to move through all
possible settings by clicking on each thumbnail accordingly. Other enhance-
ments display fewer thumbnails because there are fewer settings, or because
the number of controls do not allow for such a thumbnail navigation scheme.

Notes:
• When a color correction command is applied to a selection area, the

selection is converted into an object.
• Some color correction dialog boxes include refinement settings within their

main dialog box while others include an Options button for opening a
separate dialog box of refinement settings. To jump directly to the options
dialog box, check the Don’t show these quick samples next time check box at
the bottom of these dialog boxes. To get the quick samples back, check the
Display quick samples option in the PhotoImpact tab of the Preferences
dialog box, (see p.72).

To adjust the brightness and contrast values in an image:
1. Click the Brightness & Contrast button on the Standard toolbar, or choose

“Brightness & Contrast” [CTRL-B] from the Format menu. The Brightness &
Contrast dialog box opens displaying nine thumbnails of the currently
active image. The center thumbnail represents how the current settings
affect the image and the surrounding thumbnails indicate slight variations
of these settings.
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If you want to change which part of the image appears in the thumbnail,
click the Thumbnail button. This opens the Thumbnail dialog box with
three options that allow you to highlight a different portion of the thumb-
nail image. The first option uses the entire image as the thumbnail, the
second uses a predefined area at 1x view (change its position by dragging
on it in the sample thumbnail), and the third option allows you to define
your own area to view by dragging your mouse over the sample thumbnail.
When satisfied with the current view, click OK; the dialog box closes, you
return to the Brightness & Contrst dialog box and each thumbnail is
updated accordingly.

Note: Any changes you make are still applied to the entire image, selection
or object, irrespective of the area displayed on the thumbnail.

2. Click on what you consider to be the best looking thumbnail. The center
thumbnail is then replaced with this thumbnail, and all the others are
updated accordingly. (To change only the brightness or contrast value,
you can drag their respective sliders.)

If you check the Real-time preview checkbox, the changes are also
reflected on the image. (Leaving this unchecked improves the speed with
which the thumbnails are redrawn after each selection.)

Notes:
• The Thumbnail Variation slider controls the degree of variation between each

thumbnail. Moving this to the right increases the variation, left decreases it,
making the variations appear more subtle.

• To preview your changes, click Preview. The dialog box is replaced by a
confirmation bar, allowing you to better see the active image. Click Continue
to continue making adjustments, Undo/Redo to toggle between the original
image and the changes and OK to accept the changes and close the
confirmation bar.

3. When you are satisfied with the appearance of the center thumbnail, click
OK. The dialog box closes and the enhancement is applied to your image.

If you want to save your adjustments for later use, click Add to place the
adjustments in the My Gallery window of the EasyPalette. (You can give
an explanation as its name, such as “Add highlights to dull images”.)
The next time you want to use the same adjustment, simply drag-and-drop
its respective thumbnail from the My Gallery window to an image.
The adjustment is then automatically applied to the image.
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To adjust the color balance of an image the “smart” way:

1. Click the Color Balance button on the Standard toolbar, or choose “Color
Balance” [CTRL-L] from the Format menu. The Color Balance dialog box
opens with two tabs: Smart and Manual.

Manual has PhotoImpact balance the colors for you, while Smart allows
you to perform your own balancing. (The behavior of the Manual tab is
very similar to that discussed in the previous procedure about the
Brightness & Contrast dialog box.)

2. Click on the Smart tab. A thumbnail appears containing a sample of the
currently active image. (You can use the buttons at the bottom of the
image to control the view. For example, repeatedly clicking on the Zoom
in button, increases the magnification of the image.)

The Smart tab works by balancing an image’s color based on a neutral
gray. Having selected an area on the image that should be neutral gray, all
other colors are balanced in accordance with that color. (If your image has
no noticeable gray areas, then it is best to use the Manual tab.) A good
choice for a neutral gray color would be some feature in the image that
would normally appear gray in a properly balanced image, such as a
cement sidewalk, most rocks, tin cans, elephants and so on.

3. Click on an area of the image that should appear gray. If you have the
Real-time preview option checked, the active image will be changed
accordingly.

4. When you are satisfied with the changes, click OK. The dialog box closes
and the adjustments are made to the image.

Note: You can also use the Auto-Process: Batch command with the Balance
option to quickly balance an image’s color (see p.90).

Styling an image
The Style feature of PhotoImpact is a unique way of producing excellent
results with a minimum amount of effort. Styles work by providing predefined
characteristics that you drag-and-drop onto an image. Once dropped, the
image adopts that style’s characteristics, such as a sunset or a particular hue.
You can even create your own, so if you like a particular image’s look you can
automatically transfer that look to another image. It’s no harder than going to
a hair salon, choosing the hair style you want from a catalog and having your
stylist do the rest for you.



CHAPTER THREE102

Using the Style Gallery
PhotoImpact makes it easy to apply styles to an image with the Style Gallery
in the EasyPalette. To access the Style Gallery, click the EasyPalette button
on the Standard toolbar, the EasyPalette opens, and choose the Style Gallery
option from the Galleries combo box. The Style Gallery appears displaying
thumbnails of predefined styles that can be applied to any image.

When you view a style, it appears as a split thumbnail: the left half represents
an image with no style applied and the right half represents the same image
with the style applied. It is important to note here that the style does not
include the thumbnail image; the image is merely an example of the way that
the style affects an image.

The styles available in the Style Gallery modify an image’s attributes in
different ways. Some styles, such as Blue Sky, affect only a single color in an
image, leaving other colors unaffected. Other styles, such as Sunset and
Sunrise add a particular color to the whole image. Still others, like Cloudy,
affect the overall brightness or contrast in an image.

As you look through the different styles, note their names and thumbnails.
They have been carefully designed to make specific changes to different types
of images and named accordingly. Styles can be applied to any image, but
applying them to images that do not contain the features referred to in the
style name (or in the sample thumbnail) may produce unpredictable results.
Therefore, to make grass appear greener, choose Green Grass, not Blue Sky.

Applying a style
To apply a style, drag the thumbnail of the desired style and drop it onto the
image. The style is applied immediately and the image is redrawn showing
the enhancement. (If the style is applied to a selection area, that area is
converted into an object.) In general, you can increase the effect of the style
on the image by dragging the style thumbnail onto the image as many times
as necessary to produce the desired result.

Note: You can also apply a style by double-clicking on its thumbnail, or by
choosing the Apply command from the menu button on the EasyPalette.
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Cross-image styling
Once you begin to appreciate the power of styles, you will want to set up
some of your styles. This can be done easily through the Style command in
the Format menu. Choosing this command opens the Style dialog box which
allows you to not only apply styles but also to take an image and then use
that image as a reference from which to create a new style.

The Style dialog box has two tabs: Predefined and Custom. The Predefined
tab contains a combo box of all the existing styles. To apply a style, simply
select it from the combo box and click OK. To perform cross-image styling,
click on the Custom tab. This displays the currently active image, a Load
button from which to access the image file to be used as a reference, and a
Model group box that allows you to choose which aspects of the loaded image
you want to “cross-style”. Which model you choose depends entirely on the
image’s color problem and which attribute of the reference file would best
improve the image’s appearance. The three model options are:

Intensity applies the brightness and contrast attributes of the reference file to
the image. Choose Intensity when an image appears to be too bright or too
dim, or when the colors look washed out.

Saturation applies the degree of color in the reference file to the image.
Choose Saturation when an image appears to be pale or colorless.

Chrominance applies the hue, or color information, of the reference file to
the image. Choose Chrominance to change the overall tone of an image.
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Understanding mapping curves
When an image is created, each pixel in that image has a set of values which
make up its properties, such as color and brightness. The tone mapper feature
in PhotoImpact changes, or remaps, these pixel values to enhance an image.
Using a graph, the original pixel values are plotted along the x (horizontal)
axis and the remapped pixel values along the y (vertical) axis. Unmodified,
these input and output values are mapped one to one, or x=y. By changing
the mapping, for example, increasing the value of y, you remap the original
values of a pixel, and therefore introduce changes, such as increasing the
brightness or hue of a pixel. This type of color correction is much more
advanced and finer than those previously mentioned in this chapter.

Using the tone mapper
When you select the Tone Map command in the Format menu, a dialog box
opens with two tabs: Map and Highlight Midtone Shadow. In both tabs, a
graph appears representing the color values of the pixels in the active image.
The horizontal (x) axis represents the input value, or original value from
black at the left (0) to white at the right (255). The vertical (y) axis
represents the output, or remapped value. For general purposes, use the
Highlight Midtone Shadow tab. For much finer adjustments, use the Map tab.

TONE MAP DIALOG BOX – HIGHLIGHT MIDTONE SHADOW TAB
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Thumbnail opens a dialog box allowing you to choose which area of the
active image appears as the sample thumbnail.

Graph displays the number of pixels in an image with different values.
Darker pixels appear on the left, while brighter pixels appear on the right.

Auto analyzes the image and redraws the mapping curve to spread the pixel
values across the full range from black (x=0,) to white (x=255). This improves
the contrast in an image and is recommended (for most images) before you
start adjusting any color values.

Real-time preview  updates the image as changes are made to the tone
map. (Uncheck this option for faster response.)

Add opens a dialog box allowing you to save the current mapping curve to
the My Gallery window in the EasyPalette.

Highlight allows you to control the brightness of pixels in an image.
Moving the slider to the right increases the brightness, to the left decreases it.

Midtone allows you to adjust the midtone pixels without affecting the
highlights and shadows too much. Moving the slider to the right increases these
midtones, to the left decreases them.

Shadow allows you to control the amount of shading in an image.
Moving the slider to the right increases the shadow, to the left decreases it.

Histogram scale facto r allows you to expand the vertical scale of the
histogram to show more detail, much like a zoom control.

Channel allows you to specify which color channel to adjust, such as red,
green or blue. To adjust all channels together, select the Master option.

TONE MAP DIALOG BOX – MAP TAB
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Thumbnail opens a dialog box allowing you to choose which area of the
active image appears as the sample thumbnail.

Graph displays the number of pixels in an image with different values.
Darker pixels appear on the left, while brighter pixels appear on the right.
Dragging your mouse over the graph changes the mapping curve accordingly.

Smooth spreads changes to the mapping curve across more pixels,
resulting in a less intense enhancement.

Real-time preview  updates the image as changes are made to the tone
map. (Uncheck this option for faster response.)

Add opens a dialog box allowing you to save the current mapping curve to
the My Gallery window of the Easypalette.

Channel allows you to specify which color channel to adjust, such as red,
green or blue. To adjust all channels together, select the Master option.

Show control points displays control points allowing you to make changes
to the mapping curve more quickly and keeps these changes restricted to a
particular area.

Accumulatively allows more than one enhancement function to be applied
to the mapping curve in succession.

Enhancement opens a menu of enhancement commands that you can apply
to the mapping curve. Use these commands if you are not sure which areas of
the mapping curve you need to change.

Load allows you to apply a previously defined mapping curve to the graph.
Save allows you to save the current mapping curve to disk for later use.

Note: This command is primarily aimed at calibrating your input and output
devices. As such you will find that it is provided as an extension to both the
input/scanning process as a post processing option (see p.163) and the printing
process.

Quick color correction
PhotoImpact provides a quick way for you to fix an image that has the wrong
tint or looks too dark with the quick color controls which appear on the color
panel. These on-screen adjustments work much like the controls on a
television and allow you to adjust the brightness and contrast values of an
image, as well as each individual color channel, for example, red, green or
blue.

Notes:
• The quick color controls do not work with Black & White images and provide

only brightness and contrast control for Grayscale images.
• For Indexed-Color images the dynamic color controls work only over the base

image, not objects or selections.
• When an adjustment is made to a selection area, the selection is converted

into an object.
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Applying special effects and filters
PhotoImpact provides a full range of effects and filters that can be used to
enhance images and create special effects. You can apply effects and filters in
one of two ways, directly through drag-and-drop operations from the
EasyPalette and indirectly by first configuring specific effect and filter options
and then applying them to an image.

Notes:
• Effects and filters can only be applied to True Color and Grayscale images.
• To improve the quality of effects and filters, set the Generation quality option

in the Preferences dialog box (see p.72) to Best. If speed is more important
than quality, then set the quality to Fair.

Applying effects and filters to an image
The easiest and most convenient method for applying an effect or filter is to
drag it from the EasyPalette and drop it directly onto an image, selection area,
or object. To open the EasyPalette, click the EasyPalette button on the
Standard toolbar and choose “Effect Gallery” from the Galleries combo box.
The Effect Gallery displays all the effects and filters as thumbnails organized
by category. The thumbnails represent how each effect or filter affects a
sample image. You can browse through the different kinds of effect filters by
clicking the tabs that appear across the top of the gallery. (To see how the
effect or filter affects the currently active image, click on the Try! button.)

Notes:
• When you drop an effect onto a selection area, that area is converted into an

object.
• Each of the effects and filters can also be accessed by their corresponding

commands in the Effect menu.

    

Add Noise Average Blast
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Blur Charcoal Colored Pen

    

Cool Custom Filter Custom Effect

    

Despeckle Emboss Emphasize Edges

    

Facet Fat Find Edges
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Gaussian Blur Kaleidoscope Light

    

Magic Gradient Mosaic Motion Blur

    

Oil Paint Pinch Punch

    

Puzzle Remove Moire Ripple
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Sharpen Sphere Stagger

    

Thin Tile Turnpage

    

Unsharp Mask Warm Warping

    

Watercolor Whirlpool Wind
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Modifying an effect or filter
When you want to apply an effect or filter to an image but do not wish to use
the default settings, you can modify it by either clicking the right mouse
button over its thumbnail and choosing the Modify Properties and Apply
command or by choosing its respective command directly from the Effect
menu. Either action opens a dialog box displaying that effect’s or filter’s
settings as well as a preview thumbnail of how the effect or filter modifies the
image and a reference thumbnail of the image for comparison. (For more
information on how to adjust these settings, click the dialog box’s Help
button.)

Warping an image
Warping is a method of distorting an image using a grid (or mesh) based
pattern. This grid is visible on a sample thumbnail that appears in the
Warping dialog box, accessed by choosing the Warping command in the
Effect menu. In this dialog box you can define the size of the grid squares and
whether or not to show control points at grid intersections. To warp an image,
simply drag on a grid intersection point. To see how the changes affect the
image, press the Test button. This adjusts the preview thumbnail at the
bottom of the dialog box.

Note: You can only warp True Color and Grayscale images.
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Creating your own effects
The Custom Effect command in the Effect menu works in much the same way
as the Warping command, in that it distorts the pixel positions in an image.
The difference however, is that the Warping feature allows you to manually
distort a specific area of an image, whereas the Custom Effect distorts the
pixels over an entire image, changing their x and y coordinates respectively.

To create your own custom effects:

1. Choose “Custom Effect” from the Effect menu. The Custom Effect dialog
box opens.

The graph displayed in this dialog box represents the physical placement
of pixels in an image. In general, a steeper curve moves pixels in (pinch-
ing), while a shallow curve moves pixels out (punching).

2. Click the Samples button and choose one of the predefined mapping
curves.

3. Drag your mouse over the mapping curve to change its shape. The change
is immediately applied to the preview thumbnail.

For better control, check the Show control points check box. This
displays control points on the curve that you can adjust without affecting
the neighboring ones. You can determine the number of control points
that appear by entering a value in the points spin box.
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4. To save the effect for future use, click the Add or Save button. Add saves
the effect to the My Gallery window of the EasyPalette, whereas Save
saves the effect to a file which you can then distribute to others.

5. Click OK to apply the mapping curve to the image.

Creating your own filter
Many of the filters provided by PhotoImpact work by regenerating a pixel
value based on its original value and the value of its surrounding pixels.
The Custom Filter feature allows you to create your own filters in a similar
way using a 5 by 5 pixel matrix. After specifying values for the different cells
of this matrix, that matrix can then be applied, pixel by pixel, to an image to
produce a variety of special effects.

Note: You can only create custom filters for use with True Color and Grayscale
images.

To create your own filter:

1. Choose “Custom Filter” from the Effect menu. The Custom Filter dialog
box opens.

2. Click the Methods button and choose one of the predefined
enhancements.
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3. Enter values in the matrix cells.

The cell in the middle of the matrix represents the pixel whose value is
going to be regenerated. The surrounding cells represent the surrounding
pixels and the values determine the relative weighting assigned to them
when the matrix calculates a new value.

Changing the Divided by value allows you to control the contrast of the
custom filter and the Offset value controls the brightness of the custom
filter by adding to or subtracting from the matrix the value entered.
To convert the colors in the custom filter to their complimentary colors,
check the Invert check box.

Note: To change values of the matrix back to their original state (a one in
the center surrounded by zeros), click Reset.

4. To save the effect for future use, click the Add or Save buttons. Add saves
the effect to the My Gallery window of the EasyPalette, whereas Save
saves the effect to a file which you can then distribute to others.

5. Click OK to apply the custom filter to the image.

Changing your wallpaper
Although not strictly an effect, the Windows Wallpaper command in the
Format menu is a useful feature that allows you to make any image file the
current Windows wallpaper. When you choose this command, a submenu
appears allowing you to either tile the image or center it. Once chosen, the
wallpaper is changed immediately. If you feel the image appears too big or too
sm all, use the D im ensions com m and [CTRL+G] in the Format menu (see p.150)
to resize the image accordingly.

Adjusting an image for video
The Adjust for NTSC and Adjust for PAL commands from the Video
submenu in the Effect menu allow you to see an image as it would appear
when viewed on an NTSC or PAL device. These commands adjust the colors
in your image so that they can be displayed on a television. This is important
because some colors, such as pure cyan, cannot be displayed on television.

Note: Depending on the image and your current display mode, using this
command may not produce any visible effect.
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Painting
PhotoImpact’s painting tools enable you to easily “touch-up” and enhance
any kind of image. The painting tools themselves present a variety of
functions from the advanced retouch and clone tools to more common tools
like the paintbrush, eraser and text tools. This chapter introduces these
painting tools and begins by describing how to select and work with colors in
PhotoImpact.
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Working with colors
One of the most important aspects of painting is choosing the right color.
PhotoImpact provides a number of ways to help you do this and gives you
maximum freedom in your choice of how to display and select colors.
The most obvious means of doing this is with the color panel.

Using the color panel
The color panel contains colors that you can apply to any given image. The
way colors are displayed varies according to the type of image you are working
on. For Grayscale images, the color panel displays shades of gray. Changing to
an Indexed-Color image switches the color panel to display the 16 or 256
colors from the image’s color table. For True Color images, a complete range
of colors is displayed in individual cells or as a continuous spectrum.

Of the available colors in an image, two are active at any given time.
These two colors, referred to as the foreground and background colors, are
displayed in the color squares just below the color area on the color panel.
The foreground color is in the front, slightly lower and to the right of the
background color. Clicking the left mouse button on any of the colors
displayed in the color panel selects the color as foreground, while clicking the
right mouse button selects the color as background.

Using the color cache
The color cache displays eight color squares that you can easily select for use
as the foreground color. The advantage of the color cache is that you can
keep the eight most often used colors readily available for painting, much as
an artist’s color palette holds only those colors needed for his/her work.
Clicking on a color square selects that color as the foreground color.
To change a color in the color cache, click your right mouse button over a
color square and choose a color from the Color Picker pop-up menu.

Selecting colors from the Color Picker pop-up menu
The Color Picker pop-up menu, displayed whenever you click your right
mouse button over a color square, allows you to select a new color to replace
the selected color square, or to choose from a range of Color Pickers.
Each Color Picker provides a different method for selecting colors, each
suitable for particular situations.
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Using the Ulead Color Picker

Choosing the Ulead Color Picker command opens a dialog box showing a
continuous color spectrum. The color spectrum displays hue, or color, from
top to bottom and luminance, or the amount of brightness, from left to right.
When you move your mouse over any colors, their respective RGB color
values are displayed below the color spectrum and the color itself appears in
the left color square. If you click and hold your mouse button down over a
color, a saturation drawer appears allowing you to select a specific color.
Releasing your mouse selects the color, displaying it in the right color square.

For a more precise color selection, you can choose your color by clicking one
of the colored tabs above the color spectrum. This displays a whole range of
colors similar to the color on the selected tab. From here you can select the
exact color by clicking the mouse on the desired color cell and then clicking
OK.

Note: To select a particular color, use the RGB spin boxes to the right of the
Color Picker window.

Using the Windows Color Picker

When you select the Windows Color Picker, the standard Windows Color
dialog box appears in which you can select a basic or custom color.

Using the Eyedropper as a Color Picker

Use the Eyedropper Color Picker when you want to select a color from an
image itself. This works the same way as the Eyedropper tool (described on
the following page), except that it allows you to use zoom tools to enlarge the
currently active image, therefore increasing the precision of the Eyedropper’s
position. Also, if no color in the image is quite what you want, you can enter
your own RGB values and see the result in the color square in the lower right
corner.
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Selecting colors with the Eyedropper tool
The Eyedropper tool is used to select a foreground or background color from
colors in an image, the color panel, or the Attribute toolbar. (Whenever you
move your mouse pointer over the color panel, it changes to the eyedropper
tool, irrespective of your current tool selection.) The Attribute toolbar also
displays the RGB and HSB values of the image beneath the Eyedropper tool.
As you move the Eyedropper over the image, the values change reflecting the
color changes of the pixel beneath the Eyedropper. Clicking the left mouse
button selects the color under the pointer as foreground, while clicking the
right mouse button selects the color as background. (To place the color in the
color cache, select the color cache square to change before using the
Eyedropper tool.)

Editing an indexed-color image’s color table
Indexed-Color images are unique in that they are small in file size (compared
to True Color images), yet offer a wide range of colors which can be arranged
to make it appear as if they contain much more. This is done through the use
of a color table which allocates a single color in either 16 or 256 discrete
cells. You can view this color table by choosing the Color Table command in
the Format menu. (This command is disabled when the active image is not
Indexed-Color.)
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As each color is in its own cell, you can change it so as to affect the color
composition of an image. For example, you can change all occurrences of
white by simply changing the white color cell. To change a color, double-click
on the cell, the Color dialog box opens, and choose a new color. Clicking OK
replaces the old color with the new one and returns you to the Color table
dialog box.

Loading and saving color tables
In PhotoImpact, you can save color tables and then load them into another
compatible Indexed-Color image. This allows you to ensure that two or more
images share the same color composition, which is particularly important if
you are preparing images to be displayed in a 256-Color display mode, such as
with CD titles. You can also load in color tables that allow you to colorize an
image. For example, you can convert a grayscale image to Indexed 256-Color
and then load a color table to give it a particular hue. (During the installation
of PhotoImpact, you had the opportunity to install some predefined color
tables for such purposes. Color tables appear with a PAL extension.)

Note: You can only load color tables containing 16 colors into Indexed 16-Color
images. Likewise, color tables containing 256 colors can only be loaded into
Indexed 256-Color images.

    

Original image Applying a gold palette Applying a fire palette

Color table of
an Indexed

256-Color
image (on the

left) and an
Indexed

16-Color image
(on the right)
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Using the painting tools
PhotoImpact comes equipped with an extensive assortment of painting tools
that allow you to apply paint to an image by brush, airbrush, crayon, charcoal,
chalk, and marker. To select a tool, click on the lower right corner of the
Paint button on the tool panel, a drawer of painting tools opens, and select
the painting tool you wish to use. The drawer closes and the attributes
available for that tool appear in the Attribute toolbar.

To apply a painting tool, move your mouse to the point on the image where
you want to start and click. The color displayed in the Attribute toolbar is
then applied to the image. The effect of the tool continues for as long as you
hold your mouse button down.

Note: If you have created a selection area, the tools are only applied to the
area within the selection. Using selection areas in this way allows you to restrict
the parts of the image to which paint is applied, protecting the rest of the image
from inadvertent changes.

    

Paintbrush Airbrush Crayon

    

Charcoal Chalk Marker Pen

Working with paint tool attributes
When you select a painting tool, its various attributes appear along the
Attribute toolbar. Many of these attributes are shared and work for all of the
available paint tools. For example, the first options on the Attribute toolbar
allow you to control the size, shape and color of a painting tool’s brush.
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In the Spacing spin box you can determine how close each drop of color is
applied as a percentage to the current brush size. The higher the value, the
farther away drops are applied. Likewise, a lower value applies color closer
together. For example, a value of 100 places each drop of color next to each
other, creating a dotted line effect, whereas a value of 300 places each drop of
color at a distance 3 times the size of the brush.

Controlling the Merge factor

The Brush and Airbrush painting tools provide a merge attribute with options
for controlling the way color is applied to an image when painting.
The following describes each of these options in greater detail:

Note: The Merge option is available only if the active image is Grayscale or
True Color.

• Always replaces all parts of an image with the applied color.
• Hue & Saturation replaces the hue and saturation of pixels with those of

the applied color, retaining their original brightness. If you convert a
Grayscale image to True Color, you can use this option to colorize areas of
the image.

• Hue Only changes the hue of pixels to the hue of the applied color.
Use this to change the color of areas in images, for example, changing
green eyes to blue.

• If Lighter repaints only the pixels in an image that are darker than the
applied color. This is useful for when you are working in a light area of the
image that has dark pixels that you wish to replace without affecting
lighter ones.

• If Darker repaints only the pixels in an image that are lighter than the
applied color. This is useful for when you are working in a dark area of the
image that has light pixels that you wish to replace without affecting the
darker ones.

• Pigment mixes the original color of the pixels with that of the applied
color. Use this option when you want colors to mix as you paint.

    

Always Hue & Saturation Hue Only
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If Lighter If Darker Pigment

Specifying the painting mode

As you paint you can switch between three different painting modes,
Freehand, Straight Lines and Connected Lines, accessed through the Options
button on the Attribute toolbar. Freehand allows you to paint in an
irregularly shaped stroke while Straight Lines is for painting in straight lines.
To paint a straight line, first click on the point at which you want the line to
start and drag to the point where you want it to end and release the button.
(Pressing the Shift key constrains the line to an angle of 0º, 45º, or 90º.)
If you want to paint a series of connected straight lines, then use the
Connected Lines mode. This mode functions much like the Straight Line
mode except that after a line is painted you can select a new line segment
and continue painting. Double-clicking then paints a straight line connecting
the end point to the starting point.

Saving a painting tool’s attributes to the custom gallery
PhotoImpact provides a way for you to set up your own gallery of specially
configured painting tools. When you have modified the attributes of a paint
tool which you want to save for future use, click the Add button on the
Attribute toolbar. This opens the Add to Custom Gallery dialog box prompt-
ing you for a name for the tool. You should give the tool a name that reminds
you what the tool is and what it can be used for, for example, “eye pencil”.
The tool attributes are then saved in the Tools tab of the My Gallery window
in the EasyPalette. To retrieve the tool, simply drag the thumbnail of the tool
from the EasyPalette onto the image. The Attribute toolbar changes
accordingly to reflect the new tool and its attributes.

Applying color to the edges of an object or selection
PhotoImpact makes it easy for you to outline objects or selections with the
Paint on Edges command in the Effect menu. (To enable this command you
must first have an active object or selection area and the current tool must be
a paint tool.) When you choose this command, the current foreground color
is applied to the border of the selected object or selection area according to
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the current attributes of that tool. Half a stroke width of the paint, as
determined by the brush size attribute, is applied inside the border area and
half outside the border. This feature is particularly useful when you want to
outline part of an image, such as highlighting the edges of a car with spray
paint or creating a neon-like effect with text.

  

Retouching images
The retouching tools are not strictly painting tools in the sense that they do
not “paint” over an image with a selected color. Instead they are used to
enhance areas of an image by adjusting existing pixel colors. In all there are
five retouching tools: Dodge, Burn, Blur, Sharpen, and Smudge. To select a
tool, click on the lower right corner of the Retouch button on the Tool panel,
a drawer of retouching tools opens and select the retouch tool you wish to
use. The drawer closes and the attributes available for that tool appear in the
Attribute toolbar.

When you apply a retouching tool to an area, the tool uses the shape and size
of the current brush each time you click your mouse. To perform the effect
over a larger area, drag your mouse. To reapply and increase the effect on a
specific area, click repeatedly. (Smudging requires you to drag the tool, as it
smudges color from one area into another.)

Note: The retouching tools can only be applied to Grayscale and True Color
images.

    

Original image Dodge Burn

An example of
painting on

the edges
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Blur Sharpen Smudge

The Level attribute

The retouching tools share many of the same attributes as the painting tools,
as described earlier in this chapter. However, one attribute that all the
retouching tools share in common, which is not shared with the painting
tools, is the Level attribute. This sets the level of effect for each of the
retouching tools. A higher level creates a more pronounced effect, while a
lower level creates a less pronounced effect.

Erasing colors from an image
Often in your work you will want to replace certain colors in an image with
another. For example, you may want to replace paint that has been applied in
the wrong place or to change all the white pixels in an image to black. To do
this, PhotoImpact provides the erasing tools. Clicking on the lower right
corner of the Eraser button on the Tool panel opens a drawer of two erasing
tools: Standard Eraser and Color Eraser. The Standard Eraser tool works by
replacing the color of all the pixels that it passes over with the background
color while the Color Eraser tool replaces a selected color with another, such
as all white to black. If using the Color Eraser, you can select these colors
with the From and To color squares on the Attribute toolbar. (Increasing the
value in the Color similarity spin box allows you to erase colors similar to the
color specified in the From color square.)

Note: The erasing tools share the same brush size and shape attributes in
common with the painting tools. For more information on these tool attributes
see the section on the painting tools earlier in this chapter.
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Cloning parts of an image
The cloning tools enable you to paint parts of an image or object with
another part of the same image, or part of another image. The cloning tools
consists of two tools: the Image Clone tool and the Object Clone tool. The
Image Clone tool copies part of an image to another area in the same image
or to another image of the same data type, such as painting one person’s head
onto another person’s body. The Object Clone tool is used to paint objects
from an image file onto an image as single stamped objects, or as a continuous
stream of painted objects, such as trees in a forest.

Note: You can only clone on Grayscale and True Color images.

To use the Image Clone tool:

1. Click on the lower right corner of the Clone button on the Tool panel,
a drawer of cloning tools opens, and select the Image Clone tool.
The drawer closes and the attributes available for that tool appear in the
Attribute toolbar.

2. Move to the image you want to clone and holding down the Shift key,
click your mouse over the area you wish to clone. (This area is then
marked with a cross-hair and your mouse pointer changes to the clone
pointer.)

3. Move to the area on the image where you want the clone to appear and
start dragging your mouse. The cross-hair changes to indicate the area you
are cloning, and as you paint, you replace the area with whatever the
cross-hair passes over. (The size and shape of the area painted are
determined by the current tool size and shape settings in the Attribute
toolbar.)

After painting, the cross-hair’s position is determined by the Clone
Continuously command in the Options menu on the Attribute toolbar.
With this command unchecked, the cross-hair returns to its original point,
allowing you to clone the same area again. Checked, and the cross-hair
remains where you left it, allowing you to take a rest while cloning a large
area.

To use the Object Clone tool:

1. Click on the lower right corner of the Clone button on the Tool panel, a
drawer of clone tools opens, and select the Object Clone tool. The drawer
closes and the attributes available for that tool appear in the Attribute
toolbar.

2. In the Attribute toolbar, click on the Open button. The Open dialog box
appears.
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3. Select the file you want to clone. (If the image file has no objects,
the base image is chosen as the cloned object.)

Note: For an idea of what you can clone, try loading in one of the UFO files
provided in the SAMPLES folder under your PhotoImpact program folder.

4. Choose either the Stamp or Trail command in the Options menu on the
Attribute toolbar.

Stamp allows you to clone the loaded objects one at a time, while Trail
allows you to “spray” the active image with the loaded objects.

5. Choose either the Randomly or Sequentially commands in the Options
menu on the Attribute toolbar.

Randomly applies cloned objects in a random order while Sequentially
applies them in the order that they appear in their image file.

6. Click your mouse over the area that you want to apply the cloned object
to. Continue clicking over the image to apply additional cloned objects.

If you are in Trail mode, drag your mouse over the image to “spray” the
objects. The cloned objects appear at a specific distance from each other,
determined by the Spacing entry box on the Attribute toolbar.

  

Original image Performing a standard Performing an object
clone clone

Filling an area with color, textures and gradients
With PhotoImpact’s fill options you can quickly fill any image, object, or
selection area with a color, gradient, pattern, or texture of your choice. This is
particularly useful when you want to create a background behind a person or
image, or introduce special effects into an image. PhotoImpact provides three
different methods for performing a fill operation: the Fill tool, the Texture
and Gradient galleries in the EasyPalette, and the Fill command.
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Using the filling tools
The fill tools in the Tool panel provides access to the Bucket, Linear,
Rectangular, and Elliptical Gradient Fill tools. The Bucket Fill tool works by
replacing any color you click on with the color shown in the Fill Color
square on the Attribute toolbar. To increase the range of the fill, adjust the
values in the Similarity spin box. The higher the value, the more colors filled.
Use this tool to quickly replace a solid color, such as white to black (you do
not need to create a selection area). The gradient fill tools fill an area with a
smooth transition from one color to another, such as creating a sunset or
framing a photograph.

Notes:
• The Bucket Fill tool works with all data types, while the gradient fill tools only

work with Grayscale or True Color images.
• If you don’t select an object or make a selection area, the fill tool acts on the

base image.

To make a gradient fill:

1. Click on the lower right corner of the Fill button on the Tool panel, a
drawer of fill tools opens, and select a gradient fill tool. The drawer closes
and the attributes available for that tool appear in the Attribute toolbar.

2. Using the Fill Color color squares on the Attribute toolbar, select the
starting and ending fill colors.

3. Move to the image where you want to apply the fill and click on the point
at which you want the fill to start. Drag your mouse to the point where
you want it to reach the end color and release. The fill is then applied
between these two points. (Any area before the start point and after the
end point is filled with the Start and End colors respectively.)

Note: If you are using the rectangular and elliptical gradient tools, holding down
the Shift key as you draw produces a square or circular fill respectively..

    

Linear fill Rectangular fill Elliptical fill
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Performing drag-and-drop texture fills
PhotoImpact makes it easy to apply a full range of predefined and custom
textures and color gradients to any image, object, or selection area through
the Texture and Gradient galleries in the EasyPalette. When you access the
Texture Gallery, you can view thumbnails of Magic, Natural, and User
Defined Magic textures, accessed by clicking on their appropriate tabs.
Magic textures are generated artificially, while the Natural textures represent
real-world textures such as wood grain, stone, and fabric. The User Defined
Magic textures are Magic textures that have had their settings modified and
then saved through the Add button in the Magic Texture dialog box. To
apply a texture or gradient fill, drag its thumbnail onto an image, object or
selection area.

Notes:
• You can modify a texture by clicking the right mouse button on a thumbnail

and choosing the Modify Properties and Apply command in the Thumbnail
pop-up menu that appears. This opens the Magic Texture dialog box which
allows the texture setting to be modified to create new textures that can be
added to the Magic Texture tab of the Texture window.

• When a texture fill is applied to a selection area, the base image within the
selection area is filled with the texture.

    

An example of some of the magic and natural textures available in PhotoImpact

Using the Fill command
The Fill command in the Edit menu provides greater control over the fill
process and allows you to fill an image, object, or selection area with either a
color, an image from the clipboard, or a texture. Through the Fill dialog box,
which appears when the Fill command is chosen, you can control exactly how
the fill takes place and what is used to fill the area.

Filling an area with a texture

The Magic texture and Natural texture options in the Fill dialog box allow
you to fill an area with either an artificially generated or natural texture.
You can choose either one by clicking the radio button next to either of the
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displayed textures. To change the magic texture click on its Library button
and choose from Standard, Custom, or Options. Standard opens a predefined
library of magic textures to choose from. Custom opens a library of textures
that have been modified, and Options opens the Magic Textures dialog box
allowing you to modify a magic texture’s attributes.

When modifying a magic texture you are presented with an array of thumb-
nails. The center thumbnail represents the current texture. To change this
texture, click on any neighboring thumbnails. The thumbnail you select then
replaces the center one and the others are redrawn accordingly. When you are
satisfied with the modified texture, click OK; the dialog box closes and you
return to the Fill dialog box.

To change the natural texture, click on its Library button to open a library
displaying all the different natural textures available. You can choose from
different wood grain, stone, metal, cloth, cloud, tree and other textures by
clicking on the desired texture’s thumbnail.

Using Clear and drag-and-drop to fill
One of the quickest ways to fill an image is to choose your fill color as the
background color and then press the Delete key. This fills the image or
selected area without the need to access the Fill dialog box.

If you wish to quickly use an existing image as the fill, you can drag it from
one image (with the T key held down) and drop it onto another. This fills the
image, object, or selection area with as many tiled copies as possible of the
original image.
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Adding text to an image
With the Text tool, PhotoImpact provides a powerful feature that allows you
to add dynamic text to an image. Dynamic text is text that is created on a
path which can be modified to distort the text to any shape and size desired.
In addition to providing you full control over text shape, you also have full
control over the font type and other text attributes.

Placing text
PhotoImpact makes it easy for you to place text on an image and manipulate
that text to give it any shape, size, color, and appearance you want. To place
text, select the Text tool on the Tool panel and then click on an image
wherever you want the text to appear. The Text Entry Box opens allowing
you to type in the text of your choice. (Press CTRL+M or CTRL+ENTER to
advance to a new line.) Click Update to place the text onto the image.
Because the text is dynamic, any changes you make to the text from the
options on the Attribute toolbar will be automatically applied. Once you have
the text the way you want it, click OK. The Text Entry Box closes and you
are returned to the workspace.

Distorting text
To distort text, first select it with the Text (or Path) tool and then choose the
Path option in the Mode combo box on the Attribute toolbar. When this
mode is activated, a path is displayed around the text featuring control points
and the text is outlined. By dragging on a control point, you can freely distort
the shape of the text. When you drag a control point, handles extend from
either side of it. Dragging on one of the handles allows you to apply a curve
to the distortion, thereby creating a smoother edge. To see how the changes
affect the actual text, choose the Object option from the Mode combo box.
Choose the Selection option if you want to fill the text with a texture, or
another image.

Note: You can edit any path or text later by simply selecting it with the Text
tool. (As long as it remains as an object and has not been moved from the
active image.) However, after editing, any textures, gradients, or other fills will
be lost.

   

Using the
path tool to
distort text
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Working with objects
So far this guide has introduced you to some of PhotoImpact’s more basic
image editing functions and enhancements as they apply to an entire image.
This chapter shows you how to work with smaller portions of an image
using selection areas and objects – the building blocks of image editing.
Two powerful tools are also examined in detail: the Object Library and the
Layer Manager, both of which work to help make your image editing easier
and more productive than ever before.

Chapter contents at a glance
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Understanding objects & selections
PhotoImpact makes extensive use of objects and selections to give you the
ability to modify all or portions of an image with ease. This section introduces
these and then goes on to discuss each in greater detail.
• Selections are selected regions of an image containing image data.

Selection areas are bordered by a black and blue dashed line (the selection
marquee) and can be expanded to include multiple areas of an image.
In general, actions performed on a selection area convert it into an object.
(It is not possible, however, to create a selection area on an object.)

• Objects are selection areas that have been transformed in some way and
“float” above the original (base) image. They are independent of the base
image and are distinguished by an animated black and white dashed line
when they are selected and by a dark border when not selected. (This
border can be hidden by unchecking the Highlight inactive selections and
objects option in the Preferences dialog box, see p.72) Each image can
contain any number of objects, with each object occupying its own layer
in an image. By managing these layers, you can move objects above or
below one another.

  

An example of a selection (on the left) and objects (on the right)

Working with selection areas
In general, whenever you apply a command in PhotoImpact it is applied over
an entire image. To restrict the command to a certain area of an image,
you first need to create a selection area. PhotoImpact provides four selection
tools that allow you to do just that, offering a wide range of options for
creating both simple and more complex selection areas.

Note: The selection tools only work on base images: you cannot create
selection areas on objects.
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Selecting regularly shaped areas
The Shape tool allows you to select areas of an image based on a preset size
and/or shape, such as a square, rectangle, circle, or an ellipse. To determine
which shape, select one of the various shape tool options in the Shape combo
box on the Attribute toolbar. To create a selection, drag your mouse over an
image. If you want the selection to always appear at the same size, check the
Fixed Size option and enter the appropriate values in the neighboring spin
boxes. Now when you click on an image, a selection is made based on that
size. Selecting a fixed size is useful when you are selecting identically sized
image portions, such as personnel photos to be added to an employee
database.

When you create a selection, it starts from where you first click your mouse.
This is fine for most cases, but sometimes you may want it to start from the
center, particularly if you are creating circular or square shapes. To do this,
check the Draw From Center command in the Options menu on the
Attribute toolbar. The next time you create a selection, it will start from the
center and move out from each side as your drag your mouse.

Selecting irregularly shaped areas
The Lasso tool allows you to select an area of any shape you desire. This is
especially useful for selecting difficult areas such as a person’s head or objects
with a number of different angles.

The Lasso tool operates in two ways as you create a selection area. Dragging
your mouse allows you to draw precise curved segments, while clicking your
mouse allows you to define straight line segments. By combining both drawing
techniques you can quickly outline selection areas that contain both irregular
and straight segments. When you have finished outlining the selection area,
double-click and PhotoImpact automatically selects all image data within the
bounds of the drawn selection area.

By checking the Snap to Edges option on the Attribute toolbar and then
entering a value into the Sensitivity entry box (up to 10), PhotoImpact can
help you quickly trace around irregularly shaped objects. The Sensitivity
attribute works by specifying the range of contrast values that are used to
define an object’s edge, and Snap to Edges pulls the selection area to that
edge as you draw. This works best when you are tracing a bright foreground
object against a dull background. (If you find the selection “pulls” to include
unwanted areas, then uncheck the Snap to Edges option or decrease the
sensitivity.)

Note: If you make a mistake while drawing a selection area or wish to start
again, press the Esc key. Pressing the Backspace key takes you back one step.
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Selecting an area containing similar colors
The Magic Wand tool is used when you want to select specific colors in an
image. When you click on an image, any colors that fall within the values
specified in the Similarity entry box are included in the selection area. This is
especially useful when the colors occupy a predominant part of the image,
such as a solid color background.

When you use the Magic Wand tool, it operates in one of two modes, Line or
Area. (You determine which with the Select by: option on the Attribute
toolbar.) In Line mode, dragging your mouse over an image creates a line that
calculates the largest and smallest color values of the pixels under the line
(any values entered in the Similarity spin box are also included). Releasing
your mouse then creates the selection based on that range. Line mode is
useful when creating selection areas around straight edges such as borders or
frames.

Area mode works in much the same way, except that instead of taking the
values of pixels under a line, it includes all pixels within a selected area.
This mode works best for irregular areas containing similar colors such as
backgrounds and gradients.

    

Standard selection Freehand selection Magic Wand selection

Determining color similarity

When using the Similarity entry box you type in a value that you feel closest
reflects the range of colors you wish to select. To help determine the color
similarity range, move the Magic Wand over target pixels in the image and
notice the RGB and HSB color values displayed on the status bar. Below is a
guideline on what to expect when choosing particular color ranges. (You can
only select a color range between 0 and 255):
• A value of 0 selects neighboring pixels with exactly the same color value,

such as all white.
• A value of 255 selects pixels of all colors – thereby selecting the entire

image.
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• A value of 50 selects neighboring pixels that have values which differ from
the pixel you click on by 50. For example, if you click on a pixel with
values R25, G60, B190, neighboring pixels with values between R0, G10,
B140, and R75, G110, B240 will be selected.

Using the Mask Brush
The Mask Brush tool allows you to create selection areas by painting on a
color mask that appears on an image whenever you choose the Mask Brush
tool on the Tool panel. (This color is defined by the Mask color square on
the Attribute toolbar.) Using the mask makes identifying areas easier as it
creates a better contrast between the image and the selection area.

To use the Mask Brush tool, click or drag your mouse over the area of an
image that you want to include in a selection area. The affected area of the
mask is then removed, revealing the underlying image. If you reveal too much
of the underlying image, select the Subtract option in the Mode combo box
on the Attribute toolbar. The next time you use the Mask Brush, the mask is
applied, rather than removed from the image. Once finished, changing to
another tool removes the mask and converts any revealed areas into selections
areas.

Notes:
• To quickly switch modes, press the “A” key to remove portions of the overlay,

“S” key to reapply them. Likewise, clicking your left mouse button removes
an overlay, right mouse button reapplies it.

• If you use the Mask Brush on an image with an existing selection area, the
selection appears as removed areas of the overlay.

Understanding the Mask Brush attributes

As the Mask Brush tool is similar in function to a painting tool, it shares
many of the painting tools attributes, such as brush shape and size. This can
help you better define the areas to include in a selection area. For example,
a square brush shape is ideal for tracing straight lines, and a circle brush for
circular objects. You can also choose to paint in a straight line, freely or in
straight line segments using the appropriate command in the Options menu
on the Attribute toolbar. To smooth the edges of the Mask Brush, you can
also specify a value in the Soft Edge spin box on the Attribute toolbar.
After creating the selection area, any enhancement or paint you apply to the
selection will blend along the edges with the underlying image.
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As the Mask Brush adopts many of the attributes of a paint tool, you can use
it in conjuction with a paint tool to perform certain special effects. For
example, normally when you apply color to an image with a paint tool, it is
automatically merged onto the image. Sometimes this may not be what you
want, particularily if you want to move it at a later date. Using the Mask
Brush you can first paint a selection, then convert the selection into an
object, and then fill that selection with a color. This method works especially
well if you want to apply a color to several objects, as a paint tool can only
apply a color to a single object at a time.

  

Using a mask to “paint” a selection area

Moving a selection area marquee
Sometimes you will want to use a selection area itself without the image data
it contains. For example, you may want to move a selection area to expose
certain portions of an imag, or to protect other portions from any effects or
changes you may make to the image. To do this, choose the Move Selection
Marquee command in the Options menu on the Attribute toolbar. Now when
you move a selection, only the marquee of the selection area moves, without
any image data.

Preserving the base image
By default, whenever a selection area becomes an object the image beneath
the object is preserved. This is helpful when you want to duplicate parts of an
image or leave them unaffected by any actions you may perform. However,
when you are working with objects against a solid background color you may
find it more useful to have that option turned off. This is done by unchecking
the Preserve Base Image command in the Options menu on the Attribute
toolbar. After this, whenever a selection is moved, the area beneath the
selection is filled with the current background color.

Note: Pressing the Ctrl key as you move an object preserves the base image,
irrespective of its current status.
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Original image Preserve base image off Preserve base image on

Creating smooth-edged selection areas
Sometimes a particular selection area you are working on may have too rough
or too abrupt an edge and may not blend well with the surrounding image.
To help such selection areas blend in better with the base image, choose the
Anti-aliasing command in the Options menu on the Attribute toolbar.
Anti-aliasing works by smoothing out selection area edges and is especially
helpful inkeeping curved selections smooth. However, since Anti-aliasing
modifies the edges of selection areas, the extent of the selection area may
seem to have changed.

Softening a selection edge
To make the edge of a selection area appear diffused, creating a “halo” like
effect, use the Soften command in the Edit: Select submenu. (This submenu
can also be accessed by clicking your right mouse button over a selection
area.) Soften is especially useful when you want to make an object appear to
float above the base image. You can specify the edge width to soften (from
1 to 150 pixels) in the Soften dialog box that appears when you choose this
command. After applying this command the selection area takes on a diffuse
edge corresponding to the amount of softening.

Note: If you do not have the Preserve Base Image command checked and you
move the selection, you will notice the base image shows a corresponding
diffuse-edged hole filled in with the background color where the selection area
was created.

  

Softening a
selection

area
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Selecting a border area
When you want to add a frame or border to part of an image, or draw a box
or circle, choose the Border command in the Edit: Select submenu.
(This submenu can also be accessed by clicking your right mouse button over
a selection area.) The Border command allows you to include a border of
pixels around the edge of the current selection area. You can specify the
width of the border (from 1 to 64 pixels) in the Border dialog box that
appears when you choose this command. (Half the specified width appears on
the inside of the selection and half on the outside.) You can also set the
border to have a soft edge causing the border edges to blend in with the
surrounding image. After defining a border you can then “fill” it with a color
or texture to create a frame, box or circle.

    

Original selection Applying a border Filling the border

Adding to or subtracting from a selection
PhotoImpact enables you to select multiple parts of an image at one time.
You can, for example, use the Lasso tool to select a tree in an image and then
go on to select other trees as well. In the same way, you can also exclude
portions of existing selection areas. To select additional areas of an image or
to extend an existing selection area, make your initial selection and then
click the Mode combo box on the Attribute toolbar and choose Add
(the pointer changes to display an addition sign) and select more of the
image. If you wish to exclude an area from an already selected area, choose
Subtract (the pointer changes to display a subtraction sign) and select the
unwanted area – the selection is redrawn so that it no longer contains that
area.

Notes:
• You can also press the “A” key when using a selection tool to add to a

selection area and press the “S” key to subtract from an area.
• If you do not already have a selection area, using Add or Subtract has no

effect.
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Original selection Adding to the selection Subtracting from the
selection

Expanding a selection area

In addition to changing the mode to select more of an image, you can also
expand selection areas by using the Similar command in the Edit: Select
submenu. (This submenu can also be accessed by clicking your right mouse
button over a selection area.) Using this command you can select similar
colors in an image, such as the blue sky in a city skyline, all occurrences of
white in an image, or all the letters in a word. The Similar command is much
like the Magic Wand tool (see p.134) except that it acts on already existing
selection areas, either expanding the selection to include neighboring areas of
similar pixels or similar pixels from the entire image.

Using Grayscale masks
PhotoImpact gives you the option of creating and editing grayscale masks that
control not only the areas of an image that are selected, but also by how
much. This means that when you use a paint tool or apply an effect to the
masked area, they have only a partial effect on that area. A grayscale mask is
especially useful when you want to create a fade between two images, where
one gradually fades into or out of the other.

Creating a grayscale mask
Any Grayscale image can be used as a Grayscale mask. To convert a selection
area into a Grayscale mask, drag the selection (with the M key held down)
onto the workspace. The selection automatically opens as a grayscale image in
its own image window. (If the selection is regular in shape it appears white. If
it is irregular in shape, the area not selected is filled with black.)

Note: You can also use the Load and Save Selection commands in the Edit:
Select submenu to save and open Grayscale mask files. (This submenu can
also be accessed by clicking your right mouse button over a selection area.)
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Editing a Grayscale mask
Because a grayscale mask is actually a Grayscale image, you can edit the mask
with standard paint tools and enhancement commands. This enables you to
alter areas of the mask to make them more or less transparent. As you edit
remember:
• Black areas will not be selected.
• White areas will be selected.
• Gray areas will be partially selected: the closer to white the greater the

effect; the closer to black the less the effect.

    

Original selection Grayscale mask Edited Grayscale mask

Using a Grayscale mask
Once you have created or edited a Grayscale mask, you can now use it in any
other image. The easiest way to do this is to first save the mask in the Object
Library as a selection (see p.146) and then drag it back onto the image you
want to edit. Now whenever an effect, paint tool, or object is applied over
the mask, its effect is directly related to the shade, or transparency, of the
mask at that point.

Note: When a mask containing gray shades is dragged onto an image, the
selection border may not appear to accurately represent the mask. This is
because the selection border only shows the edges of areas in the mask that go
from a value less than 128 to a value greater than 128. If your mask is very
dark, containing only gray values below 128, no selection border will be shown:
if it is very light, containing only gray values greater than 128, the entire image
will appear to be selected.

    

Mask applied to original Changing the hue Copying the image to
image as a selection another
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Working with objects
Much of the power of PhotoImpact lies in its ability to create, manipulate,
and transform objects. Objects are created whenever you move a selection,
paste an image, or perform a transformation. Once created, objects float above
the base image in independent layers, allowing you to freely move and
manipulate them without fear of affecting other objects or the base image.
When finished working with objects, you can then merge them back onto the
base image.

Managing object layers
As easy as it is to create objects, the more objects you create in an image, the
more important it is to keep track of those objects. To help you with object
control, PhotoImpact provides the Layer Manager in the EasyPalette,
accessed by clicking the EasyPalette button on the Standard toolbar and
choosing Layer Manager from the Galleries combo box.

Whenever you view the Layer Manager, all objects present in the currently
active image appear as thumbnails, each with a sequential creation number.
An open eye icon on the thumbnail indicates that the object can be viewed.
(To show or hide an object, open the Object Properties dialog box and check
or uncheck the Show option.) By clicking on a thumbnail you select that
object in the image. Once selected, the object appears with an animated
marquee. (If the object is hidden behind other objects, only the animated
marquee is displayed.)

Note: You can make inactive objects (and selection areas) more noticeable by
displaying them with darkened borders by checking the Highlight inactive
selections and objects option in the Preferences dialog box (see p.72).

  

An image with its objects displayed in the Layer Manager
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Grouping and ungrouping objects
In the course of editing, you may find it convenient to group objects together
so that you can move them as a unit or act on them collectively with a
specific tool or effect. To do this, hold down the Ctrl key and click on the
thumbnails of the objects you want to group in the Layer Manager. (Each
selected thumbnail appears with a blue border and the corresponding objects
in the image are selected.) Choosing “Group” from the Layer Manager button
menu groups the selected objects together and the thumbnails on these
objects are marked as G1, indicating that the thumbnails belongs to the first
group (G2 appears for the second group, and so on).

Note: You can also select objects to group directly from the image.

After grouping objects together you may need to ungroup them to act on a
specific object within that group. To do this, choose “Ungroup” from the
Layer Manager button menu. All objects in that group are now ungrouped
and can be acted upon separately.

Changing an object’s layer in an image
When an object is created, by pasting or from drag-and-drop between images,
it is automatically placed on the top layer of an image, covering the base
image and any objects that may be present. (Converting a selection to an
object places it on the lowest layer.) Once you have several objects, you will
find the need to position them above or below the others. To do this, use the
four arrow buttons that appear on the Attribute toolbar whenever an object is
selected. From left to right, the four arrow buttons move an object up one
level, down one level, to the top level, and to the bottom level.

Note: You can also change an object’s level by dragging its thumbnail in the
Layer Manager to a different position relative to the other thumbnails. (The first
thumbnail is on the top layer, while the last thumbnail is on the bottom layer.)

    

An example of changing the layer of objects in an image
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Setting an object’s properties
PhotoImpact gives you control over all the objects in your image and how they
appear. By specifying object properties you can make objects appear to blend
in with other objects and the base image. To set an object’s properties, double-
click on the object or choose the Properties command in the Edit: Object
submenu, (this submenu can also be accessed by clicking your right mouse
button over an object).

OBJECT PROPERTIES DIALOG BOX

Name specifies the name of an object (up to 16 characters).
Merge sets the color factor for the object. You can choose from:
• Always displays the object as is.
• Hue & Saturation displays only the object's color and intensity values.
• Hue Only displays only the object's color information.
• If Lighter displays only the pixels in the object which are lighter than the
underlying image or object.
• If Darker displays only the pixels in the object which are darker than the
underlying image or object.
Transparency controls the object's degree of transparency. A value of 0

means the object is opaque whereas a value of 99 means the object is totally
clear or transparent.

Edge blending determines how the object’s edges blend with the base image
or any underlying objects.

Transparent color  sets which color in the object will be made transparent.
For example, you can specify that the red color in an object be transparent,
therefore allowing the base image or any underlying objects to show through.

Similarity allows you to determine a range of colors to be made transparent,
based on the Transparent color. Use this if the color you want to make
transparent does not appear as a soild color throughout the object. For example,
it may consist of a range of reds rather than a single red.

Show controls whether or not the object appears in the image window.
Objects that are not shown still appear as thumbnails in the Layer Manager
window, and their properties can still be changed.
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Adding shadows to an object
PhotoImpact provides a useful way to introduce depth to an image by applying
a shadow to an object or group of objects. To add a shadow, choose the Add
Shadow command in the Edit: Object submenu. (This submenu can also be
accessed by clicking your right mouse button over an object in an image.)
This opens the Add Shadow dialog box that allows you to control the
direction, length, transparency, edge blending, and color of the shadow.

Whenever you create a shadow, it is an independent object that is grouped
together with the object it was created from. In this way, whenever you move
a shadowed object both the object and its shadow move together. (You can,
if necessary, choose to ungroup shadowed objects with the Ungroup command
in the Edit: Object submenu.)

  

Appyling a shadow to an object

Sorting objects
When working with large numbers of objects in an image, you may find it
helpful to use the sort commands to arrange the objects’ thumbnails in the
Layer Manager. This helps you to keep track of your objects, especially when
there are many in an image. You can sort object thumbnails with the Sort by
Depth, Sort by Name, and Sort by Group commands in the Layer Manager
menu.

Sort by Depth arranges the thumbnails according to their level above the
base image, with the highest level object displayed first. Since each object
floats at a different level, this sorting option is useful for showing how objects
are stacked.

Sort by Name arranges the thumbnails alphabetically by their name. This
sorting option is useful when you want to find an object by its name. You can
modify an object’s name through the Properties dialog box accessed by double-
clicking over an object.



WORKING WITH OBJECTS 145

Sort by Group arranges the thumbnails by the groups defined using the
Group command. The thumbnails of the first defined group are displayed
before the thumbnails of the second group, and the third, and so on.
This sorting option is useful when you have several groups and want to select
a specific group of objects to act on.

Copying and moving an object between images
PhotoImpact allows you to move objects between images and is quite useful
when you have created an object in one image and want to use it in another
image. To move objects between images, drag the object from the source
image and drop it onto the destination image. The object is removed from the
source image, and placed into the destination image. (If you want to copy an
object, hold down the Ctrl key as you drop.)

Duplicating an object
To help speed up and simplify your work, PhotoImpact allows you to duplicate
any object or group of objects that you have created. This is especially helpful
when you have put the finishing touches on a specific object, or group, and
you wish to use several copies of that object, or group, in your image.

To duplicate an object or group, first select it and then choose the Duplicate
command in the Edit: Object submenu, (this submenu can also be accessed by
clicking your right mouse button over an object). A copy of the object, or
group, appears next to the original. You can then position and act on the
duplicate as you wish.

Deleting an object
As you work with objects you may, for various reasons, end up creating more
objects than you wish to have in your image. To delete an object, or group of
objects choose the Delete command in the Edit: Object submenu. (This
submenu can also be accessed by clicking your right mouse button on an
object.) The object or group is deleted from the image window and their
corresponding thumbnails disappear from the Layer Manager.

Retrieving an object’s original appearance
When working with objects, you may find it desirable to revert back to the
original form of an object. The object may have lost the “look” that you
wanted, or you just wish to start over. In any case, PhotoImpact makes it easy
for you to revert to an objects original appearance by choosing the Revert
command in the Edit: Object submenu. (This submenu can also be accessed
by clicking your right mouse button over an object.) When you choose the
Revert command the object immediately reverts to the form it had when
created.
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Notes:
• The Revert command should not be confused with the Restore command in

the File menu which closes and then reopens the image file.
• The Revert command is disabled whenever the Preserve Base Image

command is unchecked.

Using the Object Library
As you create and edit images with PhotoImpact you will come across
portions of an image or selection areas that you want to save for later use
with other images. Normally, this means saving that portion of an image as a
separate file and then opening it later. PhotoImpact provides a more
convenient way to store images and selections with a unique and easy-to-use
feature – the Object Library.

You can access the Object Library by clicking the EasyPalette button on the
Standard toolbar. This opens the EasyPalette displaying the last opened
gallery. Click on the Galleries combo box and choose Object Library to
display the Object Library window, complete with thumbnails of any images
and selections that have been stored there.

The object Library

Saving selections to the Object Library
You save a selection to the Object Library by dragging it from an image to a
group tab in the Object Library window of the EasyPalette. (You can also
choose the Copy Selection to Object Library command from the Edit: Select
submenu.) The selection is then automatically saved as a file (in the folder
specified at the time the group was created), and a thumbnail of the selection
appears in the Object Library window.

Note: If you have not yet created a group, PhotoImpact automatically opens the
New Group dialog box allowing you to create a group to place the object.
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When you save an object, you have the option of saving it as a selection or
an image. You choose which in the Object Library menu, accessed by clicking
the menu button in the EasyPalette. (This menu can also be accessed by
clicking your right mouse button over an object in the Object Library
window.) For Grayscale images there is an additional option to save a
selection area as an “image as selection”. This converts a Grayscale image into
a selection area and stores it (such as for use with gradient masks, see p.139.)

Note: Holding down the M key as you drag an object into the Object Library
automatically saves it as a selection.

Saving selections to a file
Although the Object Library allows you to easily save selections, there may be
times when you want to use a selection on another machine or save it to a
secondary storage device. PhotoImpact provides a direct method of doing this
with the Save Selection command in the Edit: Select submenu. (This
submenu can also be accessed by clicking your right mouse button on a
selection in an image.) This opens the Save Selection dialog box and allows
you to save the current selection area as a Grayscale image in a file format of
your choice.

Note: In general, do not save masks in a format that involves “lossy” compres-
sion (like JPEG): these formats will change the mask.

Creating Object Library groups
The Object Library is a very handy and useful place to store your images and
selections. It can, however, quickly become cluttered with large numbers of
selections and images. To better organize these selections and images you can
place them into user-defined groups.

To create an Object Library group:
1. From inside the EasyPalette choose “Create Group” from the menu button.

The Create Group dialog box opens displaying a text entry box for
specifying a group name.

2. Type in a name for your group in the Name entry box. The name can be
up to 16 characters long (do not type in an extension). If you want to
change the path and folder where the group is saved, type in a new
destination in the Folder entry box. (Group files are saved with the OPG
file extension.)

3. Click OK. The dialog box closes and the newly created group appears in
the Object Library window.
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Importing Object Library groups

You can import Object Library groups from a network, shared hard drive,
diskette, or other external source by choosing the Import Group command
from the Object Library menu. (When you import a group, the group file and
their contents remain in their original folders.) If you wish to share your own
Object Library groups but want to make them read only, choose the command
in the Object Library menu. Other users can still access your Object Library
groups but cannot make any changes to your groups.

Deleting groups and objects

Having created a group, you can easily delete it and its associated files from
disk by choosing the Delete Group command in the Object Library menu.
To delete an object from a group, click on the object to select it and choose
the Delete Object comand from the same menu.

Retrieving an image or selection
Just as you save images and selections by dragging them into the Object
Library, you can retrieve them by dragging them from the Object Library into
an image window or the workspace. Dragging an object to the workspace
creates a new image window containing the image or selection as an object.
(If you cannot drop an object onto an image, for example, it may be hidden,
choose the Copy Object to Image command in the Object Library menu.)

If you drag an object back to the image that it originally came from, or
another of equal size, the object is placed on the image in its original posi-
tion. (If the destination image is a different size, the selection is placed at the
position of your mouse.) This feature is especially helpful when you want to
preserve the position of image elements in an image whose background needs
changing. In this case you would select and drag each element into the
Object Library, modify the background, and then drag each image element
back onto the image. Each image element is repositioned automatically. This
feature is also helpful when working with image and animation sequences for
preserving the position of stationary objects across all the images in the
sequence.

Notes:
• When placing a selection that has been created from a Grayscale image into

an Indexed-Color or Black & White image, the gray areas of the selection are
converted to pure black or white.

• To load a previously saved selection (or any grayscale image) into the active
image as a selection area, use the Load Selection command in the Edit:
Select submenu. (This submenu can also be accessed by clicking your right
mouse button over an object in an image.)
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Transforming images
This chapter deals with manipulating and transforming images. It begins by
explaining how you can adjust an image’s size by cropping, resampling,
and modifying resolution, as well how to change the number of colors in an
image. It also discusses the Transform tool which allows you to resize, flip,
rotate, distort, and add perspective to portions of an image, and the Trace
and Path tools that allow you to quickly outline and precisely modify the
shape of a selected area.
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Transforming images
Whatever your reasons for editing images, PhotoImpact provides you with the
tools to manipulate an image to produce the “look” that you want. Whether
you are preparing images for a publication and need to resize and crop them,
preparing images for display and need to convert them, or just eager to use
your creative talent to add some perspective to an image – PhotoImpact’s
transformation tools will more than satisfy your needs.

Cropping an image
Cropping is a way to trim the edges of an image and control the position and
size of the subject in an image. This is particularly useful when you have
images that are too large to be displayed and contain information around the
edges that you wish to discard. To crop an image, select the area of the image
you wish to retain and choose the Crop command [CTRL-R] in the Edit menu.
The areas outside the selection area are discarded and only the area you
selected is retained. (If you select an object and then choose the Crop
command, the base image and all other objects are cropped leaving only the
selected object.)

Notes:
• If you select a non-rectangular area, the image is cropped to the smallest

rectangle that can contain the selected area. Areas outside the selected
area, but within the image frame, are filled with the current background color.

• When cropping the base image, any objects are discarded without merging.
• Use the Auto-Process Crop option to quickly crop an image bordered with

surplus empty space, see “Automatically enhancing an image” p.90.)

  

An example of cropping

Resizing images
You can resize an entire image in two ways: by changing its resolution and by
resampling. Changing the resolution of an image adjusts its physical size
without changing the actual image data and thereby retains original quality.
Resampling an image adjusts the size by discarding data when you reduce an
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image and adding new data when you enlarge one. Which method you choose
depends on the quality you want and the target destination for the image.

Note: For more on resolution and imaging basics , see “Imaging essentials” in
the on-line Help.

Changing an image’s resolution

Resolution determines the physical size of an image by defining the size of its
constituent pixels. As you change the resolution, you change the number of
pixels that appear per unit area. For example, increasing the resolution places
more pixels closer together, and thereby reduces the size of the image, while
decreasing the resolution places pixels farther apart, thus making the image
larger. In this way you can resize an image without actually changing the
number of pixels the image contains, as such you are able to retain the
original quality of the image. Additionally, because no pixels are added or
lost, the size of the image file remains unchanged.

To change the resolution of an image:

1. Choose “Resolution” from the Format menu. The Resolution dialog box
opens.

2. Decide on the resolution to use: Display, Printer, or User defined.

Choose Display if you plan to show the image in a slide show or other
on-screen presentation and Printer if you wish to print the image out on a
black & white printer. When an image appears too large or too small in
another program, such as Microsoft Word or PowerPoint, choose User
defined and enter an appropriate resolution in the entry box.

3. Click OK. The dialog box closes and the resolution of the active image is
changed.

There is no change to the appearance of the image. Changes are only
apparent when you print the image or place it into another program that
reads the resolution.

Resampling an image

When you open images, their size on screen is determined by your screen
resolution and the number of pixels they contain. The Dimensions command
allows you to adjust the number of these pixels in an image. It is important to
note however, that because resampling changes the number of pixels in an
image, its file size is modified accordingly.
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You will want to resample an image when:
• You are preparing images for display on your computer and wish to make

them all display at the same size, for example, in a slide show.
• You are preparing images for a publication and you wish to make their file

size smaller so that they take less time to import into, and print from, your
DTP or word processing program.

• You wish to stretch or squash an image.

Converting images
When working with images, it is often necessary or useful to change the data
type of an image, for example, from Grayscale to True Color. Your choice of
data type directly relates to an image’s file size and quality. For example, by
converting to a data type that supports more colors, you can take advantage
of the extra colors, but the image’s file size will increase. To convert an
image’s data type, choose an appropriate command from the Format: Data
Type submenu. (You can also access this menu by clicking on the Data Type
button on the Status bar.) Some data types may not be available: these
require an intermediate conversion to True Color. After choosing a data type,
the conversion is immediate or an options dialog box appears.

Notes:
• Conversions change the original image, unless you have the Create a New

Image command checked in the Format: Data Type submenu.
• For more on color and imaging basics , see “Imaging essentials” in the

on-line Help.

GRAYSCALE TO BLACK AND WHITE DIALOG BOX

Resolution allows you to choose the resolution of the new image. You can
choose the resolution to match that of the active image, printer, display or you
can define your own. (If you select a high resolution, a very large file will be
produced and the conversion may take a long time.)

1 2

1
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2 Halftone screen  allows you to specify your dithering method. Shape selects a
pixel pattern to use for the dithering. (The Diffusion option generally results in
the best conversion.) Frequency controls how many lines per inch appear for a
particular shape that you are using to dither and Angle controls the angle that the
shapes are placed at when dithering.

TRUE COLOR TO 16-COLOR DIALOG BOX

Palette allows you to select the colors to be included in the new image’s color
table. Standard uses the system’s default 16-Color table, containing the 16
colors available on a standard VGA display. This option is most useful when you
transfer images to other Windows programs or prepare them for use in a help file
or a CD title.
The Optimized option creates a color table that is the closest representation of
the colors used in the image. In most cases this option gives the best conversion.
Reserve Entries allows you to reserve some entries in an optimized palette. For
example, you may need black to add text later, but your image is largely green
and blue. Selecting the Reserve entries Black & White option then creates a
color table containing greens, blues, black and white. Checking the 8 primary
colors option retains red, green, blue, cyan, magenta, yellow, black and white in
the color table.
From File allows you to load an indexed 16-Color palette file, that was previously
saved from another indexed 16-Color image file, and use that palette to map the
colors of current image.

Dither allows you to choose a dither method. None maps each pixel in an
image to the closest color in the palette. Pattern arranges pixels in square
patterns to simulate more colors than are present in the palette and Diffusion
uses a more random method to dither colors. (The Diffusion option generally
results in the best conversion.)

1 2

1

2
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TRUE COLOR TO 256-COLOR DIALOG BOX

Palette allows you to select the colors to be included in the new image’s
color table. Standard uses the system’s default 256-Color table and gives the
most balanced use of palette color. Use this option if you are preparing images
which need to be displayed consistently on 256-Color display modes. The 3-3-2
(bits) option uses the system’s color table based on a combination of eight
(3-bits) reds, eight (3-bits) greens, and four (2-bits) blues, while 6-7-6 (levels)
uses a color table that offers six levels (shades) of red, seven levels of green,
and six levels of blue.
Choosing Optimized creates a color table that matches the range of colors used
in the image as closely as possible and as such normally produces the best
results. You specify the color index value of the first color in the palette by
entering a number in the Start index. (This is best determined by noting the
color value of the most white color in an image and choosing that color index to
be the first color in the palette.) You can also specify the range of color by
entering a value in the Maximum number of colors entry box corresponding to
the spread of color in your original image. The higher the value, the more colors
created.
Choosing From file allows you to load an indexed 256-Color palette file that was
previously saved from another Indexed 256-Color image, and uses that palette
to map the colors of the current image.

Dither allows you to choose a dithering method. None maps each pixel in an
image to the closest color in the palette. Pattern arranges pixels in square
patterns to simulate more colors than are present in the palette and Diffusion
uses a more random method to dither colors. (The Diffusion option generally
results in the best conversion.)

Converting True Color images to CMYK
PhotoImpact gives you the ability to prepare color separations of your color
images for full color commercial printing. PhotoImpact separates images into
four Grayscale images, one for each color channel: cyan, magenta, yellow, and
black (CMYK). If you output these images to film on a high resolution image
setter, a commercial printer can then use the film to print a full color image.

1 2
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When you convert a True Color image to CMYK, it is a good idea to save
each image under a common name appended with the name of its CMYK
color, for example, “sports car – cyan”, “sports car – yellow”, and so on.
This ensures that each CMYK image can be correctly identified later on
when the images are recombined together to form a True Color image.

Converting CMYK images to True Color
Not only does PhotoImpact enable you to convert a True Color image to
CMYK, you can also recombine an image that has been separated into its
CMYK colors. This is useful when the original True Color image is
unavailable and you need to edit the image. However, this should be done
only as a last resort, as the recombined image will not have the color range
of the original.

Using the Transform tool
The Transform tool allows you to take an image, or part of it, and then
manipulate it so that it changes shape. To perform a transformation, select an
object, or the area on the image you want to transform and then click the
Transform tool button on the Tool panel. Each of the possible transformation
options appears as a button on the Attribute toolbar. (You can also access
some of these transformations from the Edit: Rotate & Flip submenu.) On the
following page are examples of what each of these options are and how to use
them:

Notes:
• Applying a transformation creates objects out of any selected areas.
• If you rotate or distort an image by anything other than 90º, 180º or 270º,

extra space is introduced around the image. This space is filled with the
background color if you do not have Preserve Base Image selected in the
Options menu on the Attribute toolbar. (Objects are not affected in this way.)

    

Original image Free resizing Slanting
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Distorting Perspective Rotating

    

Flipping left Flipping horizontal Flipping vertical

Straightening images

The Rotate by Horizontal and Vertical Line options are useful when you have
an image which is not quite straight. This is often the case when you input an
image with a hand-held scanner. To horizontally straighten an image, click on
the Rotate by Horizontal Line button and then drag a control point to one
end of a stong horizontal feature, such as the edge of the image. Now drag the
second control point to the other end of the feature, carefully aligning the
control line along the feature. Double-clicking on any of the control points
now rotates the image horizontally.

Note: You can also use the AutoProcess Straighten command to quickly
straighten an image. For more information, see “Automatically enhancing an
image” p.90.

  

An example of
straightening

an image
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Working with paths
PhotoImpact makes it possible for you to convert objects and selection area
marquees into paths. Paths are vector-based images, as opposed to bitmapped
images, comprised of a collection of control points, bezier curves, and lines.
Paths do not contain any image data, but they can be shaped with great
precision to produce shapes with little or no discernible jaggedness. It is this
smoothness that makes using paths a valuable tool when working with text
and other shapes, such as corporate logos.

The Trace commands
The Edit: Trace submenu contains commands that can convert any base
image, selection area or object into a path-based object. The Selection
Marquee command converts a selection area into a path controlled by a
number of control points and handles. The Image command works in much
the same way as the Selection Marquee command except that the control
points and handles are located on the edges of the selected image giving you
greater control over the shape of the vector path.

Deciding which Trace command to use is entirely dependent on the image
that you want to convert to a path. If the image is of similar brightness and
contrast with the background, such as a person’s face against a bright sky, it is
better to first use a selection tool to carefully outline the person’s face, and
then choose the Selection Marquee command. In cases where the image data
is easily distinguished from background pixels, such as with text on an image,
you should use the Image command.

Note: To improve the quality of paths, set the Generation quality option in the
Preferences dialog box (see p.72) to Best. If speed is more important than
quality, then set the quality to Fair.

TRACE DIALOG BOX
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Show path only  displays only the vector path in the preview thumbnail.
The advantage of the Show path only view is that it displays the thumbnail more
quickly and gives you a better idea of how the path is taking shape.

Tolerance sets the accuracy of the control points on the vector path.
Move the slider to the right to set a high tolerance which results in fewer control
points, and as such does not follow the boundaries of the selection area or
image as accurately. For simple paths, such as a building or doorway, a high
tolerance is no problem. However, for irregular shapes, such as a person or a
car, specify a low tolerance.

Jump point determines the accuracy of the curves between the control
points. Move the slider to the left to create a path that fits more closely with the
selection area or image (the better the fit, the slower the conversion). Again, for
simple paths, fewer jump points is no problem, but for irregular shapes,
specify more jump points.

Threshold determines which pixels are included in the vector path.
Move the slider to the left to decrease the number of pixels and to the right to
increase the number of pixels. This option is similar to color similarity, allowing
pixels of a specified color range to be included in the vector path. The higher
the threshold, the larger, and possibly less accurate, the path will be.

The Path tool
Once you have created a path, you need to use the Path tool to modify it.
(For modifying paths created with the Text tool, see “Placing text” p.130.)
The Path tool operates in one of three modes: Object, Path and Selection.
You determine which one by selecting it from the Mode combo box on the
Attribute toolbar. In Path mode you can freely edit the path, distorting its
shape and position. Object mode converts the path back to a raster-based
object, filling it with the selected color on the Attribute toolbar; while
Selection mode converts the path into a selection area, which you can then
fill with a color, texture or even another image.

Changing the path shape

If you have created a path using one of the Trace commands, you cannot edit
it immediately as it has yet to be mapped with control points. To do this,
choose the Edit Existing Path command in the Edit menu on the Attribute
toolbar. Now when you click on the path, control points appear at each
corner. To modify the shape of the path, you need to change the position of
these control points.

To move a control point, first click on it to make it active (the pointer
changes to a crosshair pointer) and then drag it to a new position. When you
select a control point, a handle appears connecting the control point to an
additional two control points. These control points allow you to modify a
path’s curvature and can be easily adjusted by dragging them anywhere within
the workspace. (If you click off the control point, the path is no longer
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active. To change its curvature, you will then need to make the original
control active again and then drag on a handle.)

Note: You can make a control point by dragging your mouse over it.

    

An example of distoring text using the path tool

When you change a handle, its behavior is determined by the Free edit
option on the Attribute toolbar. Left unchecked, and the handles rotate
together around the control point. Checked, you can move each handle’s
control point independently, allowing to apply more acute angles and
curvatures.

Creating a new path

PhotoImpact also allows you to create new paths by choosing the New Path
command in the Edit menu on the Attribute toolbar. Now, wherever you
click your mouse on an image, control points appear, connected together by
straight lines. Dragging your mouse curves the line around these points.
To finish, or close a path, simply click on the first control point or double-
click. A line is then drawn from the last control point to the first.

After creating a new path, you need to either convert it to an object or
selection, or choose the Edit Existing Path command in the Edit menu on the
Attribute toolbar. If you don’t, each time you click your mouse, another
control point will be placed on the image. To change the shape of the path,
choose the Edit Existing Path command and then follow the procedures
explained above.

Grouping and ungrouping paths

When you edit an existing path, such as text, the path is likely to be in a
complex form containing many separately closed paths. You can edit these
individually or as a group. To edit them as a group first select them,
by dragging your mouse over them or using the Shift key in conjunction with
your mouse, and choose the Group command in the Path menu. (Accessed by
clicking your right mouse button over a path.) To ungroup a path, select it
and then choose the Ungroup command from the same menu.
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An example of selecting or grouping seperated paths

Filling a path

Whenever you convert a path into an object, the path is filled with the color
specified in the color square on the Attribute toolbar. Using the Even-Odd
fill option on the Attribute toolbar, you can determine how this fill takes
place. For example, left unchecked, the fill occupies the entire interior of the
path. This option is particularly useful when you wish to maintain a solid fill
whenever paths overlap. Checked, and the fill occupies different regions of
the path, in particular, regions where a path is folded over onto itself or
contains multiple paths inside. This option is best for when you have a
complex or irregular path whose overlapping portions you wish to keep free
of paint.

    

Original path Path with an Even-Odd fill Path without an Even-Odd
fill
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Acquiring images
PhotoImpact works with your camera, scanner, camcorder and VCR
allowing you to acquire and edit all manner of electronic, photographic,
and printed images. This chapter explains how to access and calibrate
your acquiring device, obtain good input results, perform automatic
post-processing and stitch together image strips to form a new image.
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Before you begin
PhotoImpact allows you to access images from a scanner or other input
devices through a variety of software drivers. However, since each software
driver works differently, many of the actual image acquisition options will
differ with different input devices. For this reason, the full range of possible
acquisition options are not discussed in this chapter. For information about
such options and how they are implemented by an installed software driver,
please refer to your image input device’s software driver documentation and
on-line help.

Acquiring images
PhotoImpact makes it possible for you to import images from any image input
device that is TWAIN compliant. This capability allows you to acquire
photographs, slides, and printed material, or capture frames from a camcorder,
VCR, digital camera, or even your television, and then convert them into
images that you can modify with PhotoImpact’s powerful editing and
enhancement tools. Later in this chapter you will find some tips on how best
to get images into PhotoImpact, but first a discussion of TWAIN.

TWAIN
TWAIN is an industry standard for image input devices, drivers, and software
applications that allows any TWAIN-compatible software application to
acquire image data from any TWAIN-compatible device. By being TWAIN-
compatible PhotoImpact can work with all TWAIN-compatible devices to
give you access to all kinds of images.

If you have a TWAIN-compatible device you should follow its installation
procedure. Once correctly installed, you will be able to use the device from
PhotoImpact or any other application that supports TWAIN without worrying
about compatibility problems.

Selecting an image source
Before acquiring an image you first need to select which device you want to
acquire an image from. You might, for example, have a flatbed scanner, a
digital camera, and a video capture device connected to your PC, and since
each device may have its own TWAIN driver, you need to select between
them. To do this, choose the Select Source command from the File: Acquire
submenu. This opens the Select Source dialog box which displays a list of
TWAIN devices on your system that you can choose from. Once selected,
a TWAIN device becomes the source for image data whenever you select the
Image command from the File: Acquire submenu and remains the source until
another device is selected.
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Note: If you only have one TWAIN device connected to your PC, that device is
automatically selected as the TWAIN source.

Acquiring an image
After selecting your TWAIN source you can acquire an image by clicking the
Acquire Image button on the Standard toolbar or by choosing the Image
command in the File: Acquire submenu. This opens the Acquire Image dialog
box which allows you to specify the destination, calibration, and post
processing options for the acquired image. You can choose to set these options
before acquiring an image or you can acquire an image directly by pressing the
Acquire button in the Acquire Image dialog box. Doing so opens the TWAIN
driver and displays a dialog box containing your device’s imaging options.
For more information on specific imaging options, see your image device’s
documentation or on-line help.

Note: If you click the Acquire button and you do not have a TWAIN device
installed, you will see an error message. If you do have a TWAIN device, but it
is incorrectly installed, a dialog box appears containing configuration options.

Setting the destination

The destination options in the Acquire Image dialog box allow you to send
your imported images directly to any, or all, of the following destinations:
• New image opens an acquired image in its own image window in the

PhotoImpact workspace.
• File stores an acquired image in the PhotoImpact workspace. Click the

Filename button to specify the filename and location. Filenames must end
with a number, allowing PhotoImpact to save multiple images by
auto-numbering the files. This is especially useful when you want to store
multiple pages of a document for optical character recognition (OCR) at a
later time.
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Note: After entering a filename, it is displayed in the Acquire Image dialog
box underneath the File destination option.

• Printer sends an acquired image to be printed on your PC’s default printer.
This destination option makes it easy for you to turn your PC system into a
high quality copy machine. Click the Setup button to specify the printer
options.

• Fax/Mail sends an acquired image to either your PC’s fax device or to your
mail software. This option operates in the same manner as the Send
command in the File menu and makes it easy to scan in handwritten text
and images and send them off as a fax or as an e-mail attachment. Click on
the Setup button to access the Send dialog box.

Note: For more information on the Send Mail dialog box, see “Sending
images by electronic mail” p.80.

Calibrating your input device

The Calibration tab in the Acquire Image dialog box allows PhotoImpact to
automatically adjust an image’s tone as it is acquired. An extensive range of
calibration schemes allow you to correct color problems that arise because of
the different ways that your monitor, video display card, and input device
handle colors. The calibration schemes include corrections for many common
color problems as well as calibration schemes for many of the most popular
scanner models.

To apply a calibration scheme to an acquired image, check the Apply
calibration scheme checkbox and select a scheme from the Scheme list box.
These schemes are actually tone maps created through the Tone Map dialog
box (see p.104) and adjust different pixels of an image in different ways. If, for
example, your scanner tends to wash out detail in highlighted areas and make
shadowed areas appear too dark, you can create a tone map that darkens
highlighted areas and lightens shadowed areas, and apply that tone map
automatically every time you scan an image.

To add a calibration scheme:

1. Create a new tone map by using the Tone Map dialog box, accessed
through the Tone Map command in the Format menu. (For more on
creating tone maps, see “Using the tone mapper” p.104).

2. Save the tone map as a file with the MAP extension and close the Tone
Map dialog box.

3. Open the Acquire Image dialog box and click the Add button in the
Calibration tab.
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4. Select the new tone MAP file and click OK. The new tone map is added
as a calibration scheme which you can select from the Scheme list box.

Post-processing options

The post-processing options in the Acquire Image dialog box allow you to
automatically apply several basic but powerful enhancements to an acquired
image automatically. These post-processing enhancements analyze and modify
an acquired image to correct basic image problems, improving the image’s
appearance. The following post-processing options can be applied by selecting
the appropriate checkbox.
• Auto-straighten straightens out an image that is acquired in a crooked, or

skewed, manner.
• Auto-crop removes excess blank space in an image, cropping an image

down to the smallest rectangle containing relevant image data.
• Auto-remove moire eliminates interference patterns and other scan

artifacts from an image that has been half-toned, such as photographs in a
magazine or book.

• Adjust brightness & contrast optimizes the brightness and contrast levels
in an image by stretching pixel values across a full range of 256 levels.

• Add frame & shadow adds a frame, shadow, and canvas border to an
image. Click the Settings button to specify the various framing options.

When the Image is acquired each of the selected post-process options are
applied automatically before the image is displayed in the workspace.

Note: For more information on the first four post-processing options, see
“Automatically enhancing an image” p.90.
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Acquiring a good image
The best way to ensure that a finished image looks its best is to start with a
good acquired image. The following tips are provided to help you get the best
results quickly when acquiring an image.
• Limit your image size whenever possible.

A small image requires much less hard disk space and processing time than
a large image. Always note the scanned image size in KB. If the scanned
image size approaches or is larger than your available disk space, adjust the
scan size downward before scanning.

• Scan to the same color mode as your output device.
OCR text: Black and white.
Line art: Black and white
Laser printer: Grayscale mode
Monitor: 256/True Color (depending on your video driver)
Post production: True Color

• Scan good quality images and text.
When scanning images some information is invariably lost. If the output
device does not match the resolution of the scanned image or if the output
device cannot reproduce the color shading equivalent to that displayed by
your monitor, further information will be lost. Scan quality can only be as
good as the original image. Minimize these problems by avoiding scanning
materials that are either extremely light or dark, damaged or unclear.

• Scan photographs instead of printed pictures.
To help preserve accurate toning details, scan photographs instead of
images that have been printed in magazines or books. Printed pictures
have already been half-toned or dithered and are composed of tiny dots.
Typical resolution for color typesetting is 180-400 dpi with a halftone
frequency of 90 to 200 lpi, so when printed images are scanned in at a
higher resolution no better quality is obtained. In fact, at too high of a
resolution the scanner can see the individual color dots and may produce a
moire pattern.

• Do not always select the highest resolution.
High resolution images, especially 24-bit color images take enormous
amounts of disk space. There is no benefit gained if your image is scanned
at a resolution far higher than your intended output device is capable of
producing. If you plan to display the image on a monitor you should select
a 72 or 96 dpi resolution. However, if you wish to output to a color
printer, you will want to scan the image in at between 150 and 300 dpi.
(However, if you want to enlarge a small photo, try a higher resolution.)
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• Experiment with different settings.
Acquire images using different settings and then compare them on your
screen to verify which one suits your particular printing or imaging
requirements. You will find that PhotoImpact has many functions that
allow you to manipulate the acquired image to get the best results.

Stitching images together
If your image input device cannot handle larger images in one pass, such as
may happen when you are using a handheld scanner, PhotoImpact enables
you to input an entire image by scanning in strips and then joining the
resulting image pieces. In this situation, the ability to join images accurately
and efficiently is essential. PhotoImpact provides both automatic and manual
image stitching to aid you in reconstructing an image from multiple pieces
with the Stitch command.

Choosing the Stitch command in the Edit menu allows you to stitch any
image open in the workspace with the currently active image. This process
involves choosing an image to join with the active image, floating that image
into the proper position over the active image through an automatic or
manual process, and then stitching together the images by combining the
overlapping regions.

The way in which you use the Stitch tool to join image strips depends
entirely on the condition of the images you have. Some images are well suited
for automatic stitching and others may require manual adjustment. For this
reason, Stitch provides multiple options and controls for both manual and
automatic stitching, giving you pixel-level control for seamless joining of
images. With the Stitch tool you can:
• Set auto-stitching parameters and make PhotoImpact automatically match

and align the floating image over the active image.
• Drag the floating image until it matches up with the active image.
• Define a reference point in each image which PhotoImpact then uses to

align the two images.
• Select “Auto fine tune” to help the images snap into the correct relative

position and aid in manual stitching.
• Set the transparency of the floating image to aid manual stitching and to

define how images are combined in the overlap area.
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Notes:
• You can only join images that share the same data type and are either

Grayscale or True Color.
• The Stitch tool only works with base images, objects cannot be stitched. If

you wish to stitch an object, it must first be merged onto the base image.

THE STITCH DIALOG BOX

Stitch with enables you to select an image from any that are open in the
PhotoImpact workspace. Click on the combo box to choose an image.

Overlap area transparency  allows you to specify the transparency of the
floating image. While you are placing the floating image, use a transparency of
50 to enable you to see both images equally. Before stitching, choose another
transparency to define how the area of overlap appears after stitching.
Selecting 0 causes the floating image to obscure the active image in the area of
overlap, while a value of 99 causes the active image to obscure the floating
image.

Manually allows you to position the floating image over the active image by
dragging it with the mouse.

Auto fine-tune automatically fine-tunes the position of the floating image
immediately after you have moved it by dragging or by defining matching points.
To be successful the floating image must be placed fairly close to its final
destination (within thirty pixels either way). This option usually achieves the
best result with the least amount of effort.

Auto stitch sets the Stitch tool to automatically align the floating image over
the active image based on the specified overlap and tolerance parameters.
When this option is selected a horizontal or vertical line appears on the active
image. This line represents the approximate position to which the floating image
should overlap. This line is moved by adjusting the Overlap range spin box.
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Overlap range specifies the amount of overlap in the images to be stitched.
If the overlap is too small (less than thirty pixels), the chance of a successful
match is greatly reduced.

Horizontal/Vertical tolerance  allows you to provide for misalignment in the
direction perpendicular to the stitching direction. The tolerance should be
slightly greater than the distance the floating image needs to move (horizontally
or vertically) to align with the active image.

Test automatically repositions the floating image to match the active image
according to the overlap and tolerance parameters you have defined.

Switch directions  allows you to specify which side of the floating and active
images to stitch together. Clicking the left button swaps the images left and
right. Clicking the right button swaps the images above and below.

Deskew allows you to rotate the floating image with respect to the active
image. Click the left button to define a line to align the image horizontally,
and click the right button to define a line to align the image vertically. This is
useful when the image strips are not quite parallel to each other. (For more
information on deskewing an image, see “Automatically enhancing an image”
p.90.)

Zoom In and Zoom Out change the view of the images one step at a time.
Use these commands if you want to view a magnified or reduced portion of the
images to enable you to stitch more accurately.

Actual view returns the view of the images to the normal (1x) view where
each image pixel is shown by one screen pixel. (If you are already at actual
view, this command has no effect.)

Fit in Window displays the images at the maximum magnification that still
allows the active image to fit within the display window.

Automatic image stitching
The fastest and easiest way to stitch two image strips together is by using the
Auto stitch option. This option works for a wide range of images and is
especially useful for images that show a lot of detail and are fairly clear.

To stitch two images automatically:

1. Make one of the images you wish to join the active image.
2. Choose the Stitch command in the Edit menu. The Stitch dialog box

appears.

3. In the Stitch with combo box, select the image you want to join to the
active image. The image selected here appears as the floating image in the
stitch window.

4. Use the Direction buttons to place the floating image in the correct
position relative to the active image.
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5. Check the Auto stitch option, and then enter values in the Overlap
range and Vertical/Horizontal tolerance entry boxes according to the
approximate percentage of overlap and vertical/horizontal misalignment
that you feel is evident between the two images.

Note: Overlap range or Vertical/Horizontal tolerance values that are off by
more than 50% of the image size prevent the Auto stitch option from
properly joining image strips.

6. Click the Test button to preview the auto stitched image.

7. Click OK. The Stitch dialog box closes and a window appears containing
the newly stitched image.

Manual image stitching
You can use the manual stitching option to join images in unusual ways
creating special effects. Such effects might include placing the same image
against itself or joining a flipped version of an image to the original to create
a mirrored effect. You might also use the manual stitching mode when your
image details are unclear or somewhat blurred, or when you are joining images
with small scale repeating patterns.
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To stitch two images manually:

1. Follow steps 1 through 4 for automatic image stitching (see previous
procedure).

2. Drag the floating image until you are satisfied with its position.

3. Click OK. The Stitch dialog box closes and a window appears containing
the newly stitched image.

Note: To improve the stitching accuracy, check Auto fine tune to allow
PhotoImpact to automatically fine tune image alignment after you have placed
the images in an approximately correct position.

Stitching images by defining reference points
When you are stitching together images that have fine details in common,
it is quite easy to join them by using a reference point. A reference point can
be any small feature, or detail, that appears in the overlapping regions of both
images. Once specified, PhotoImpact uses that reference point to stitch the
images together.
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To stitch two images by using a reference point:

1. Follow steps 1 through 4 for automatic image stitching (see previous
procedure).

2. Define a reference point by holding down the Shift key and clicking on a
small detail common to both images in the floating image.

3. Define a matching reference point by holding the down the Shift key and
clicking on the corresponding detail in the active image. The Stitch dialog
box closes and a window appears containing the newly stitched image.



Chapter 8

Album: getting started
Album is the program to use when it comes to viewing and managing the
files on your system. When you place files into Album, they are represented
as graphical thumbnails which allow you to see what a file is, therefore
making it easier to locate files as well as better organize your work.

This chapter introduces the basics of Album, explaining how to create
and maintain album files, access programs from the Tool panel, perform
drag-and-drop operations, and use the Preferences commands to customize
the way Album works with you and your Windows environment.
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1

Customizing the way you work
An essential part of Album’s management is that it allows you to control both
the program and how it interacts with Windows. This is done with the two
Preferences commands, PhotoImpact Album and General, found in the File
menu. The PhotoImpact Album command allows you to define preferences for
Album only, while the General command is for all PhotoImpact programs.
(General preferences are discussed in “Common preferences options”, p.74.)
When you choose the Album command, the Album Preferences dialog box
opens with three tabs: General, Font, and OLE Representation. These allow
you to specify a variety of options such as checking links to source files,
defining the way files behave as OLE objects and controlling the size and type
of the fonts used in Album.

Note: You can quickly access the Album Preferences dialog box by double-
clicking on the status bar or pressing the F6 shortcut key.

ALBUM PREFERENCES DIALOG BOX: GENERAL TAB

Check links to source files  makes Album perform an automatic check
between each thumbnail in an album and its source file. The check is done
whenever a thumbnail is selected or the view in the album changes, such as
from scrolling or performing a sort operation. Although this option does not
require any extra memory, it may slow down processing time as you wait for
Album to finish checking. Leave this option unchecked if you are certain files
have not been modified, if it is not necessary to update existing thumbnails,
or if you wish to scroll quickly through an album.
Note: If, during a check, Album comes across any missing files, the index
number of the appropriate thumbnail is grayed-out.
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Minimize on use  minimizes Album as soon as you invoke another program
from the Tool panel or Switch menu. This can help save on system resources as
Album is no longer occupying the desktop.

Free up memory when minimized  releases any system memory used by an
album by swapping it out to disk whenever it is minimized. When you swap out
to disk, the memory contents of the album are saved to a file in your TEMP
folder (*.$$$). Restoring the album reads that file back into memory. This may
slow processing time depending on the size of this file and the current state of
your system’s resources.

Confirm on thumbnail deletion  prompts you with a confirmation message
whenever you try to delete thumbnails.

Create best quality thumbnail images tells Album to generate the best
quality images for use as thumbnails. Check this option if you want your
thumbnails to be as clear as possible. (This does, however, require a longer
thumbnail insertion time.) Leave this option unchecked if you are satisfied with
the existing thumbnail image quality.

Display fixed-length tabs  makes all the tabs in an album appear at a fixed
size. If this option is left unchecked, each tab appears as large as the number
of characters it contains. (You control the number of characters with the
Maximum tab width option below.)

Print field data with source files attaches field data to source files when
printed.

Play annotation file after viewing thumbnails  plays the annotation file
associated with a thumbnail after you open the thumbnail’s source file, (using
the View command in the Source menu).

Maximum tab width: (in characters)  allows you to specify the length of the
names that appear in tabs (from 3 to 30). Keep this number low when you need
more space to show tabs. To see tab names in full, increase this number.

Number of recently removed files  specifies the number of files to list at
the bottom of the File menu, (up to 9). Clicking on a name from the list reopens
the album.

Delimiter used in search toolbar  allows you to choose which delimiter to
use in the Search toolbar.

ALBUM PREFERENCES DIALOG BOX: FONT TAB

The Font tab allows you to control the type and size of the font used to display
the text in an album. (The options and dialog box layout displayed here are
standard to all Windows compatible programs.) If you are in high resolution
display mode, such as 1024x768, you may want to increase your font size so
you can better see the names of your thumbnails. Likewise, if you are in a lower
resolution display mode, such as 640x480, you may want to decrease the font
size.
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ALBUM PREFERENCES DIALOG BOX: OLE REPRESENTATION TAB

The OLE Representation tab allows you to define how an object looks when
placed into another program (the container program).

Source object displays the entire file in the container document. This allows
you to clearly see the contents and dimensions of the object file but does
increase the container’s file size and slow down its operation.

Thumbnail only replaces the source file with its thumbnail in the container’s
document. This provides a visual clue as to the contents of the file without
affecting the container’s file size or speed of operation too much.

Low resolution place holder  places a low resolution version of the object
file into the container document. This is particularly helpful in preparing images
for publication when it is not necessary to have a good quality image displayed
on screen at all times. When you print the document, however, the low resolu-
tion image is printed. To print the original file, you must first update the thumb-
nail from the container program.

Album’s program icon  allows you to use Album’s program icon to represent
the object file. This adds the least to the container’s file size, but you do not
have a visual clue as to the contents of the file.

Convert images as display mode  converts the data type of an image
(when placed onto the clipboard) to that of your current display mode. This is
particularly useful if you are using a low resolution display and wish to save on
system resources. (This option is only enabled if you are running in 256-Color
display mode.)
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Creating an album
Your first step on the way to managing files in your system is to arrange them
into albums. A key feature of albums is their support for UDFs or user
definable fields. Fields allow you to append all sorts of information about a
file, in any category that you determine.

When you run Album for the first time, it opens with existing albums in the
workspace containing thumbnails of the PhotoImpact sample files. You can
immediately begin to place your own thumbnails into these albums, or create
a new album. You can create a new album by:
• Clicking the New button on the Standard toolbar.
• Choosing the New command [CTRL+N] in the File menu.
• Clicking the Album button in any of the other PhotoImpact programs’

Save As dialog boxes and choosing “New”.
• Selecting thumbnails in an existing album and then choosing the Make

Album command in the Edit menu.

Note: You can have any number of albums open in the workspace, and each
album supports over 64,000 files.

To create a new album:

1. Click the New Album button on the Standard toolbar or choose “New”
[CTRL+N] from the File menu. The New dialog box opens displaying a
number of template options.

Templates are provided to help get you started with your album. For
example, the Personnel Database template contains fields such as Name,
Address, Gender, Salary and Job Title. Album templates are also fully
customizable, so you can add, remove or rename fields whenever necessary.

2. In the Album template list box, select a template that you want to base
your album on. The Total fields list box changes to show the fields
included in that template.

If you want to create a multipurpose album for simple file cataloging,
choose the default General Purpose template.

Note: You can edit the fields of an album by clicking on the Customize
button. For more information, see “Editing an album’s properties”, p.196.
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3. Decide on a name for your album and enter it in the Title entry box.

The title you enter appears in the album’s title bar and also becomes the
filename for the album itself. (Album files are indicated with an AB3 file
extension and are stored in the folder specified in the General tab of the
New dialog box, see p.177.)

4. Click OK. The new album appears in the Album workspace and the Insert
dialog box opens. You can close this dialog box and leave the album
empty, or continue to insert files. (For more on inserting files, see p.198.)

Using the album shelf
Whenever you create an album, it appears in the Album workspace. You can
have any number of albums open in the workspace at one time. Of course, a
large number of albums would not only clutter your workspace but make it
hard to find those albums you want to work with. To help manage albums in
the workspace, Album provides the Shelf command in the File menu.

The shelf is a storage area in which you can place the albums you are not
currently working on or wish to remove from the workspace. It is a good idea
to place excess albums onto the shelf, as this not only makes it easier to work
with those albums you often use, but also frees up system resources.

Note: To access files referenced in an album on the shelf, you must bring the
album back to the workspace.

You can place albums onto the shelf in the following ways:
• Choose the Shelf command in the File menu (the Shelf dialog box opens)

and select the album you want to place onto the shelf from the Albums in
workspace list box. Clicking “=>” automatically removes the selected
album from the workspace, and it then appears in the Albums on shelf list
box.

• Right mouse click on an empty part of an album’s workspace or its title
bar, and choose the Put on Shelf command from the pop-up menu.

To retrieve albums from the shelf:
• Choose the Shelf command in the File menu (the Shelf dialog box opens)

and select the album you want to retrieve from the Albums on shelf list
box. Clicking “<=” automatically moves the selected album into the
workspace, and it then appears in the Albums in workspace list box.

• Open the file using the Open command in the File menu.
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Lower pane

Viewing
Thumbnails are one way (or mode) of viewing files in an album. You can
also view files in attribute, filename or data entry mode. Choose which one
by selecting the appropriate mode from the Standard toolbar or by choosing
its corresponding command from the View: Mode submenu or from the
Viewing Mode button on the status bar. (An additional Layout command
allows you to configure each of these modes except data entry.) You can also
view an album in two different modes simultaneously by splitting the
window document into an upper and lower pane. To split an album window,
simply drag the splitter at the bottom of the scroll bar up.

If you split an album into panes, changing the viewing mode via the
Standard toolbar or with a mode command from the View: Mode submenu
only changes the thumbnails in the default upper pane. To change the
viewing mode of the lower pane, use the Viewing Mode button on the status
bar. This has a menu with two sets of Mode commands. The top set is for
the upper pane and the lower set for the lower pane. The following provides
a brief explanation of what information is displayed when you choose any of
the four viewing modes:
• Thumbnail displays the thumbnails of files from left to right and top to

bottom. You can choose whether or not to display certain album file
attributes or data field entries using the Layout dialog box, accessed by
choosing the Layout command from the View: Mode submenu.

Upper pane

Pane splitter
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• Attribute displays both the thumbnails and information about each file.
As with the Thumbnail mode, you can specify what information to display
from the Layout dialog box.

• Filename displays filenames from top to bottom in the album. Depending
on selections made in the Layout dialog box, various information is
displayed about each file, such as file attributes, subject, description and
pathname. (Viewing in filename mode is quicker than thumbnail mode
and requires less memory.)

• Data Entry displays the field names and data of each thumbnail with the
image shown to the left of the fields. Choose this mode if you want to add
or edit information in the fields of an album.
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Viewing by tabs

Another way to view thumbnails is by tabs, displayed by choosing the Show
Tabs command in the View menu or by dragging down the splitter at the top
of each album window’s vertical scroll bar. Each tab contains a collection of
thumbnails with a common theme. The default classification is by media type.
To change this, you can select another type from the View: Tab by submenu.
This is also a quick way to find information within an album, particularly
when the album has a defined value list. For example, you can view your
album based on marital status, age, gender or income. (To create a value list,
see p.204.)

Scrolling an album
Album provides several methods for locating thumbnails in an album. The
most obvious is the scroll bar which appears on the right side of the album.
Clicking the scroll bar direction buttons moves the view by a single line.
Clicking in the scroll bar moves the view by a page, and dragging the slider
allows you to move quickly to a new location. The number that appears next
to the slider is the index number of the first thumbnail in the row that you
are scrolling to. To scroll quickly through an album, click and turn the red
dot on the scroll dial at the top of the Tool panel. Turning it clockwise scrolls
down, while turning it counterclockwise scrolls up.

If you have a large number of thumbnails in an album you can automatically
scroll through them by using the Auto Scroll dialog box, accessed by choosing
the Auto Scroll command in the View menu. In the Delay time entry box,
type the time (in seconds) that you want Album to wait before each scroll.
When ready, click on the OK button. The dialog box closes and automatic
scrolling begins. (To pause/continue scrolling, press the Space bar; to stop
scrolling press the Esc key.)

If you want to go to a specific thumbnail, choose the Scroll to command in
the View menu. This opens the Scroll to dialog box which lists the filenames
and index numbers of all the thumbnails in the album. Selecting a filename
and clicking OK automatically scrolls to the location of that thumbnail.
(Double-clicking on a filename performs the same effect.)

Using scan play

To quickly browse through a large number of wave, MIDI, video, or animation
files, choose the Scan Play command in the View menu. The multimedia files
of the selected thumbnails are played sequentially in a media window. The
Play/Pause button in this window allows you to pause and continue the
playing of files. The Skip button allows you to skip the current thumbnail and
start playing the next one. You can mark thumbnails as you scan play by
choosing a mark from the combo box and then clicking the Marks button.
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Using Explorer to view files
If you have yet to place thumbnails of your files in an album, PhotoImpact
provides Explorer, a handy utility that allows you to quickly view the contents
of any image or graphics file. When you run Explorer, it opens like Windows
Explorer, displaying the contents of each drive and folder. The only difference
is that any image or graphics file that Explorer comes across is displayed as a
small thumbnail. Used in this way, you can quickly browse through the
contents of your system before committing to inserting thumbnails or to get
an idea of what a file contains. Explorer also allows you to perform basic file
maintenance such as copying and moving files, viewing file properties and
sorting.

Note: For more information on how to use Explorer, refer to the program’s
on-line Help.

List the last
visited folders

Change the display mode

Sort
thumbnails

Access Viewer

Place Explorer
on top of other
programs

Access PhotoImpact

Display file
properties
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Using CD Browser to view Photo CDs
If you have a Photo CD and wish to view and organize the photos contained
on it, use the PhotoImpact CD Browser utility. (You cannot use PhotoImpact
CD Browser if you do not have a CD drive installed on your system.) When
you open PhotoImpact CD Browser, photos on the Photo CD are displayed as
thumbnails in the workspace. Once displayed, you can choose to save them to
your hard disk, catalog them in Album, or open them in either PhotoImpact
or another editor of your choice.

Although CDs have great storage capacity, they are relatively slow when
compared to hard disks. Therefore, whenever you view or scroll through
photos on a CD, it may take a little longer for the photos to refresh.
To overcome such delays, you can insert thumbnails of the photos into
Album. This allows you to view the contents of your CD quickly and
easily – without even having to have your CD present in the CD drive.
(To access the actual photos themselves, however, you will need to reinsert
the Photo CD into your CD drive.)

Note: For more information on how to use CD Browser, refer to the program’s
on-line Help.

Display file
properties

Display
information
about the
current
Photo CD

Select a
CD-ROM
drive

Select an
image size
for viewing

Select a
data type
for
viewing

Access PhotoImpact Access Viewer

Insert photos into an album
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Using the clipboard
One of the easiest ways to move thumbnails is by dragging and dropping them
into other albums. Other means involve using the clipboard and the Cut
[CTRL+X], Copy [CTRL+C], and Paste [CTRL+V] commands in the Edit menu.

Cutting a thumbnail removes it from the album and places it onto the
clipboard (only the thumbnail is cut: the thumbnail’s source file is not
affected and remains where it is). If you choose to use the Copy command,
you have the option of copying the thumbnail, its field data, or the filename.
If you choose “Field Data”, all field data is copied. To only copy certain field
data, first highlight the data you want to copy and right mouse click in the
data entry pane to show the pop-up menu. Choosing the Copy command from
this menu only copies the selected data to the clipboard.

Pasting field data into an album
The Paste command is available only when the clipboard contains a thumb-
nail or field data that has been cut or copied from an album. This command
is useful when you have thumbnails that share the same or similar field data.
By copying the field data for one thumbnail, you can then paste it into others,
saving the time needed for retyping the same information several times.
(If pasting single field data, use the Paste command in the pop-up menu that
appears when you right mouse click on a field in data entry mode.)

Printing thumbnails
Album allows you to print the thumbnails of an album (in either of the four
different display modes) to any Windows compatible output device. Before
you print make sure that your output device is turned on, connected, and
selected in the Print dialog box. You can access this dialog box through the
Print command [CTRL+P] in the File menu.

To print all thum bnails, check the All option in the Thumbnail range group
box. To print only the currently selected thumbnails, check the Selection
option (this is disabled if no thumbnails are selected). To print a range of
thumbnails, check the Range from option and enter the first and last thumb-
nail index numbers of the range into the entry boxes provided. For the best
possible representation of thumbnails, check the Create thumbnails from
source files option. This produces a clearer thumbnail but does slow down
processing time.
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Other options are also included in the Page Setup dialog box, accessed by
clicking on the Page Setup button. Here you can change the page layout,
create a header and/or footer as well as choose to append any relevant file
information, such as the album’s title, filename and current date. (This dialog
box can also be accessed directly by choosing the Page Setup command in the
File menu.)

Note: To preview how your thumbnails will look when printed, choose the Print
Preview command in the File menu or click on the Print Preview button in the
Standard toolbar.

Using the Tool panel
Central to Album’s ability to manage files is its ability to act as a program
manager through the Tool panel. By adding frequently used programs to the
Tool panel you can transfer control and, in many cases, files between Album
and those programs. You can also place similar programs into program groups,
allowing you to instantly change the Tool panel configuration depending on
the task at hand. For example, one group can consist of your multimedia
programs; another, your word processing programs and so on. Once an icon is
added to the Tool panel, simply click on it to open the corresponding
program.

Note: You can also open programs from the Run dialog box, accessed by
choosing the Run [CTRL+R] command in the Tool panel menu.
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Adding programs to the Tool panel
When you invoke Album for the first time, the Tool panel appears with a
group of icons featuring the PhotoImpact programs. You can choose to add
more icons to this group, or create a group specific to the programs on your
system.

To add a program icon:

1. Click the menu button in the Tool panel and choose “New” from the
menu. The New Group dialog box opens.

2. Click on the Program group option and in the Group name entry box
enter the name of the group you want the program to be associated with,
for example, Word Processing, and click the New button.

3. Click on the Program icon option and enter the Description (optional),
Command line and Working folder (optional) of the program concerned.

To load the Windows WordPad program, type in WordPad for the
Description, the full pathname where the WordPad file is located for the
Command Line and the full pathname of your temp folder for the Working
Folder.

4. Click the New button. The program icon appears in the Tool panel.
(If you want to add more programs to the Tool panel, repeat steps 3 and
4.)

5. Click the Close button to close the dialog box and return to the Album
workspace.

Notes:
• You can also add programs to the Tool panel by dragging execution files

(EXE) from Windows Explorer and dropping them onto an empty icon in the
Tool panel.

• To change program groups, choose the appropriate group name from the list
of group commands, available when you click on the Menu button.

• If you wish to change any of the options specified in the New Group dialog
box, choose the Properties command in the Menu button.

Removing a program from the Tool panel
At times you may want to remove a program icon: this can be because you no
longer need it, have deleted the program from your hard disk, or feel that
there are too many icons in the program group. When you remove icons, you
can choose to remove individual ones or all those associated with a program
group.
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To remove a program icon or a program group:
1. Click the Configure button on the Tool panel and choose “Delete”.

The Delete dialog box opens.

2. To delete the current program group, select the Delete current program
group option. (This deletes the group and all program icons associated
with that group.) To delete an individual program icon, select the Delete
program icon from current group option and click on the icon to be
deleted from the Icon combo box.

3. Click OK. The selected program icon or group disappears from the Tool
panel, and the dialog box closes.

Repositioning the Tool panel
When you work in Album, you may prefer to have the Tool panel in another
position. In other PhotoImpact programs, you would normally drag on the
Tool panel to remove it from its docked position. In Album, however, this is
not possible. Instead, Album allows you to configure the position of the Tool
panel via the Configure command (accessed by clicking the menu button on
the Tool panel) or by one of the positioning commands in the Configure
pop-up menu, accessed by right mouse clicking on the Tool panel. These
allow you to dock the Tool panel to the left or the right of the Album
window or to make it floating. (Once floating, the Tool panel can be dragged
anywhere on the desktop.)

Performing drag-and-drop operations
Drag-and-drop is a simple, yet powerful technique for transferring information
within and between programs. Album provides extensive support for drag-and-
drop that enhances its ability to provide complete file and program
management.

Drag-and-drop to the Tool panel
One of the more common drag-and-drop operations you will perform is to
drag a thumbnail from an album and drop it onto a program icon on the Tool
panel. Given that the file is compatible and the program accepts command
line opening of files, the file associated with the thumbnail is opened in the
destination program. Dragging and dropping to one of the PhotoImpact
program icons (except for CD Browser and Explorer) is even more powerful,
as you can drag-and-drop multiple thumbnails in one go.

Note: Pressing the Enter key with a thumbnail selected also opens the file of a
thumbnail as long as it has the correct program association.
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Drag-and-drop to another program’s workspace
If you have other programs running at the same time, you can drag-and-drop
thumbnails directly into the program’s workspace rather than to its program
icon on the Tool panel. (Depending on the settings in the OLE Representa-
tion tab of the Album Preferences dialog box, see p.176, this either embeds,
links or opens the file, where compatible.)

If you are working from Windows Explorer, you can:
• drag-and-drop program files (EXE) to an empty icon on the Tool panel of

Album to create program icons.
• drag-and-drop album files (AB3) into the Album workspace to open them.
• drag-and-drop files into albums to create thumbnails of the files.

Drag-and-drop thumbnails to albums
Using drag-and-drop, you can easily move thumbnails within or between
albums by simply selecting the thumbnails and dragging them to their new
destination. (This can be to an open album or to its minimized icon.)
Thumbnails moved from one album to another are removed from the first and
introduced at the end of the second (or in the position determined by the
album’s current sort mode). If you hold the Ctrl key down while dragging,
the thumbnails are copied. (The original files associated with the thumbnails
are not duplicated.)

Note: Thumbnails dropped into an album change to suit the properties of the
thumbnails in that album.

Drag-and-drop thumbnails between tabs
To move thumbnails from one tab to another, simply select them and drag
them to the other tab. Doing this not only moves the thumbnails but also
changes the thumbnails’ list value. For example, if you have thumbnails in a
tab for the Sales department and drag them to the tab for the Marketing
department, the value for the Department field changes accordingly, from
Sales to Marketing.

Notes:
• You cannot drag thumbnails from a specific tab to the All tab.
• You can also move thumbnails from one tab to another by first selecting the

thumbnails you want to move and then choosing the Switch To command
from the tab menu button.
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Drag-and-drop thumbnails to other programs
When dragging thumbnails to other programs, the result is determined by the
particular program. In general, if you drop a thumbnail onto a minimized
program icon, or onto the program window’s title bar, the program will
attempt to open it. If you drop the thumbnail into the program’s workspace,
it may be placed into the active document as an object, or it may be opened:
exactly which depends on the program and the settings in the OLE
Representation tab in the Album Preferences dialog box (see p.176).

Note: Holding down the Ctrl key as you drop an object into the destination
program embeds it, irrespective of the selection made in the OLE Representa-
tion tab of the Album Preferences dialog box, (see p.176). Holding down the Ctrl
+Shift keys links it. (If you do not hold down any keys, the embedded object is
linked to it associated program.)

Working in compact mode
When dropping thumbnails into another program, it is often easier to have
Album in compact mode and have the destination program running at the
same time. You can switch to compact mode by choosing the Compact Mode
command from the View menu or by clicking the Compact Mode button
located on the status bar. In compact mode, the Album program window
occupies minimum screen space with no menu bar, allowing you to see both
the active album and the destination program window. To switch back to
normal mode, select the Switch to Normal Mode command in the same
menu. (See the “Using Album with other programs” tutorial, p.69)

Note: In compact mode you can still access Album’s commands by clicking on
the Display menu button located on the status bar.

Performing OLE operations
Album supports linking and embedding features that allow you to easily
modify objects which have been incorporated into other program documents.
When an object is linked, information gets updated each time the source file
is modified. The container file, the file into which you insert the object into,
only stores a connection to the source file and a representation of the linked
object. When an object is embedded, it becomes part of the container file
itself and the information does not change if the source file is modified.
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Linking and embedding objects
You can link objects by:
• Holding down the Ctrl and Shift keys while you drag-and-drop a thumb-

nail to a container program.
• Using the Copy: Thumbnail command in Album and the Paste Special

command (with the Paste Link option selected) in the container program’s
Edit menu.

• Using the Insert/Object command in the container program.

You can embed objects by:
• Holding down the Ctrl Key while you drag-and-drop a thumbnail to the

container program.
• Using the Copy: Thumbnail command in Album and the Paste Special

command (with the Paste option selected) in the container program.
• Using the Copy: Thumbnail command in Album and the Paste command

in the container program.
• Using the Insert/Object command in the container program.

Editing linked or embedded objects

Right mouse clicking on an object in a container program’s document brings
up the following commands:

• View/Play Ulead Album Thumbnail Link: Opens the object in
PhotoImpact Viewer for image and graphics files and in Windows Media
Player for sound, animation, and video files for a quick and more detailed
look at an object.

• Reselect Ulead Album Thumbnail: For embedded objects, allows you to
select another thumbnail to replace the current thumbnail.

To reselect a thumbnail:

1. Right mouse click on the thumbnail in the container program document
that you want to replace with another thumbnail, and choose “Reselect
Ulead Album Thumbnail”. PhotoImpact Album opens.

2. Select another thumbnail to replace the current thumbnail.

3. In the File: Update submenu, find the container document with the
thumbnail you want to replace and select it.

4. Return to the container program document. The thumbnail is now
replaced with the newly selected one.



Chapter 9

Working with albums
In the previous chapter you learned about albums and how they can help to
organize the files on your system. This chapter takes you one step further,
explaining how to insert thumbnails of your files into albums as well as
how to enter information. Once the thumbnails are inserted, you can
manipulate them and perform various file management tasks such as
copying, moving, renaming and converting.
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Maintaining albums
When working with albums, it is easy to forget that they are in fact files, and
as such, can be managed and maintained. (The album file is identified with
an AB3 extension.) All the commands to maintain album files can be found
in the Album menu and include common commands such as Move, Copy,
Delete, and Rename. (Other more specific commands are discussed later in
this chapter). It is important to remember that when performing operations
on album files, you are not affecting the actual source files of the thumbnails.
For example, if you choose the Delete command, the album file is removed
from disk, but all the source files associated with it remain.

Note: If you want to remove an album from the workspace without deleting it,
either place it onto the shelf (see p.178) or choose the Close command in the
File menu.

Refreshing an album
If you are sharing albums over a network, changes made to the  source files
may not be reflected in the current thumbnails. To update the album, choose
the Refresh command in the Album menu. (This command is disabled if you
are not currently sharing an album over a network.) This checks each thumb-
nail in an album against its source file. If the file has changed, the thumbnail
is updated accordingly.

Checking the thumbnails in an album
If you have been using the Windows Explorer or a DOS session to manage
your files, you may inadvertently “break” the link between some files and
their thumbnails. This can be because the original files have been moved,
renamed, or perhaps deleted.

To determine if this link has been broken, choose the Check command in the
Album menu. After checking for any missing or modified files, the Check
dialog box opens with two tabs: Missing files and Modified files. The Missing
files tab indicates those thumbnails whose original source files are now
missing. You can then choose to relink or delete the thumbnails of these files.
(Delete removes the thumbnail from the album, not the source file.) The
Modified files tab indicates those files which have been changed since they
were originally inserted into an album. Here you can choose to relink, update
or delete the thumbnails.
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Notes:
• Check cannot be performed on read-only albums. To take the read-only

attribute off an album, choose the Sharing command in the Album menu and
deselect the Read-only mode option in the Sharing dialog box, (see p.195).

• Checking the Check links to source files option in the Album Preferences
dialog box (see p.174) automatically checks thumbnails whenever you select
them, perform a sorting operation, or scroll.

Backing up an album file
When you backup an album, you not only backup the album file but all those
files associated with the thumbnails. This serves two purposes: one, it creates
a copy of the important files you want to keep a record of, and two, it allows
you to delete the backed up files to create more storage space.

If you choose to delete the original files after a backup, you can still keep a
record of them by not deleting the album file. This allows you to view the
thumbnails of the files in the album. (To access the files you need to restore
the original album.)

To backup an album:

1. Select the album you want to backup.
2. Choose “Backup” from the Album menu. The Backup dialog box opens.

3. Use the Backup album to folder list box and the Drives combo box to
specify the folder and drive to save the album.

Important: Any files in the target folder are deleted before backing up
begins.

4. If you have selected specific thumbnails to backup, check the Backup
selected files only option. Unchecked, and all files are backed up.
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5. Check the Compress files option to compress the files as they are backed
up.

Note: If it is important to achieve maximum compression, try converting all
image files in the album to the JPEG format before backing up. JPEG,
however, is a lossey compression scheme, and as such the quality of the
compressed files may not be as good as the original.

6. Click OK. The dialog box closes and the backup process begins.
(The progress of the backup is displayed in the album’s status bar.)

Backing up to floppy disks

If you are backing up to floppy disks, you will be asked to insert additional
disks as they are filled up. During the backup operation, Album splits files so
that the disks are filled as efficiently as possible. For an indication of the total
number of disks required to backup an album, refer to the Total size to
backup indicator in the Backup dialog box and divide this by the capacity of
your disks.

Note: It is important that you sequentially number and label each disk used
during the backup. This way when you come to restore the album, you will know
which disks to insert and in which order.

Restoring an album file
After backing up an album, you must restore the album to be able to use any
of the files contained in it.

To restore an album:
1. Choose “Restore” from the Album menu. The Restore dialog box opens.

2. Using the Restore album from folder list box and the Drives combo box,
locate the folder and drive containing the album you wish to restore.

3. In the Restore to group box, select the subfolder to restore the backed up
files to.

4. Click OK. The dialog box closes, your album and associated files are
restored to their specified subfolders, and the album appears in the Album
workspace.

When you restore an album, any existing files with the same filename as the
files to be restored are replaced. These files may be the files you originally
backed up and did not delete or files you have since created with the same
filenames.
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Note: You can restore an album file that has the same title as an existing one,
as long as the filename is different or you restore it to a different folder.
However, once restored, you cannot open it in Album until you have renamed,
removed, or deleted the other.

Sharing albums over a network
Album allows more than one user to use the same album file at the same
time. To control sharing, choose the Sharing command in the Album menu,
this opens the Sharing dialog box. Here you can set the rights associated to
the currently active album as well as how that album can be used by others.
For example, in the Active album group box, an album can be set as either
read/write or read-only, while in the Sharing mode group box, an album can
be set as exclusive, read-only, or read/write. Setting the sharing mode to
exclusive gives you exclusive use of the album and other users on the network
have no access to it at all. If the sharing mode is read-only, then the album
can only be viewed. Read/write mode allows albums to be both viewed and
worked on simultaneously by multiple users. However, this mode does slow
down performance dramatically, as Album has to read data from disk when-
ever possible to ensure that the data shown on the screen is consistent to
those on file.

Note: If there are others already using the album, you will not be able to set the
options for it.

Sending an album
The Send command in the File menu is available only if MS Exchange
(Windows 95) or MS Mail (Windows NT) has been properly set up. With this
command, you can send an album to anyone else connected to your PC
through MS Exchange or MS Mail.

When you choose this command, the Send Mail dialog box opens with two
tabs, Send files and Message text. In the Send files tab you can choose to
send the album file and/or the source files for all or some of the thumbnails in
an album. (When you send an album, Album sends only a duplicate of your
original album file and/or the source files of the thumbnails.) If you cannot
send large file sizes over the network, check the Send files as separate mails
option. This sends each file as a separate mail rather than attaching all files to
one mail. You can also choose to append the album’s field data by checking
the Include field data in message text option.

The Message text tab allows you to enter a subject and message for the mail.
If you checked the Send files as separate mails option under the Send Files
tab, the subject and message will appear in all mails.
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Editing an album’s properties
When you create an album, you have the opportunity to define certain
properties of the album such as its title, description, and fields. To modify
these properties, choose the Properties command in the Album menu or click
the Customize button in the New dialog box. This opens the Album Proper-
ties dialog box with four tabs: General, Field, Advanced and More. (For more
about changing the properties of an album, see the “To add and remove
fields” tutorial, p.62.)

Note: If the album is password protected, the Password Protected dialog box
opens asking you to enter the password.

ALBUM PROPERTIES DIALOG BOX: GENERAL TAB

Album title allows you to enter or edit the name of the album. The name
you type here appears in the album’s title bar but does not change the filename
of the album.

Thumbnails allows you to specify the size of the thumbnails, the
compression scheme to use, as well as the thumbnails‘ number of colors.
(It is important to remember that your choices here only affect the thumbnails,
not the actual source files themselves.) To save on disk space, choose a small
thumbnail size and JPEG compression. JPEG compression is lossey, so you
may notice some degradation in quality. To improve on this, choose lossless.
This compression scheme retains all data but does not achieve as high a
compression rate as JPEG.

Description list box provides a brief summary of an album's template and
its intended purpose.
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1

2

ALBUM PROPERTIES DIALOG BOX: FIELDS TAB

Field name indicates the name of the currently selected field displayed in
the Total Fields list box. You can change this to more accurately represent your
album database, for example, Work, Transport or Holiday.

Field type specifies the type associated with the currently selected field.
The type of a field is important as it indicates the kind of information you can
place in the field. For example, text fields allow you to use text; filename fields
are for entering filenames and so on.

Total fields list box displays all the fields in the current album or template.
You can select a particular field by clicking on it with your mouse and then use
the Add, Change and Remove buttons to edit the contents of this list box.

Note: For more information on fields, see the “To add and remove fields”
tutorial, p.62.

ALBUM PROPERTIES DIALOG BOX: ADVANCED TAB

21
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Folder monitoring  allows you to specify which folder you want Album to
monitor. To monitor a folder, you must check the Enable folder monitoring
option. Any changes to the specified folder, such as file deletions or additions,
are immediately updated in the album. In this way you do not have to insert
thumbnails to an album or remember to insert a thumbnail whenever you create
a file in another program such as PhotoImpact. You can select multiple types of
files to monitor by clicking on them in the File types combo box, (up to 26).

Password allows you to specify a password of up to 22 characters to
prevent your album from being modified by unauthorized users. If users do
not have the correct password for a password protected album, they are
automatically put in read-only mode.

ALBUM PROPERTIES DIALOG BOX: MORE TAB

The More tab displays information about the album file including name, size and
date last modified. (This tab does not appear if you access the Properties dialog
box from the Customize button in the New dialog box.)

Inserting thumbnails
Once you have created an album, you can proceed to insert thumbnails of
your files. It is important to remember that the original, or source, file never
moves: it remains where it is on your disk. How the thumbnail is represented
depends on the type of file it is linked or associated to. If its associated file is
an image or graphics file, the thumbnail displays the contents of that file. For
video and animation files, the first frame of the sequence is displayed. If the
file’s contents cannot be shown, as for text or sound files, the thumbnail
displays the source file’s program icon or a default icon.

Whether you want to insert thumbnails into an empty album or one that
already contains existing thumbnails, you can:
• Use the Insert command [INS] in the Thumbnail menu, (see over).
• Use the CD Browser utility to insert photos from a Photo CD.
• Drag-and-drop existing thumbnails from one album to another.
• Use the Acquire command in the File menu (only available if you have an

installed TWAIN device).
• Click the Album button in any of the PhotoImpact programs Save As

dialog boxes.
• Drag-and-drop files directly from Windows Explorer or Photo Explorer into

an album.

1

2
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Note: The thumbnail of a given file can only be inserted into the same album
once. If you insert a thumbnail from the same file more than once, the
original thumbnail and information are updated each time.

To insert thumbnails of files:

1. Choose “Insert” [INS] from the Thumbnail menu. The Insert dialog box
opens with two tabs: Files and Folder.

To insert specific files, choose the Files tab. To insert all the files of a
folder, choose the Folder tab. (This inserts thumbnails for all files found
within the specified folder and/or subfolders.)

2. Using the Drives combo box and the Folder list box, locate the folder
containing the files you want to insert.

3. Select the media type you want from the List files of media combo box.

Choosing a type here determines which file extensions are available in the
List files of type combo box below.

4. Select the file extensions of the files you wish to insert from the List files
of type combo box.

To insert all types of files, choose the All Formats option.

5. Select the files you want to insert from the File name list box . (Not
necessary if you are inserting a folder.) You can perform a quick insert of
single files by double-clicking on their filenames.

6. Check the Write errors and journals to file option if you wish to see a
report about the problems that occurred while inserting the selected files.

Use this option when inserting a large number of thumbnails and you
don’t want the insertion process to be halted if any errors occur. (This is
particularly useful if inserting files overnight.) If this is left unchecked, any
problem that occurs prompts a message box and halts the insertion process.

7. Click Insert. The selected files are inserted into the currently active
album. The dialog box remains open to allow you to insert more files into
the same or different albums. To close the dialog box click on the Close
button.
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Inserting files from a TWAIN device
If you have an installed TWAIN device, such as a frame grabber or scanner,
you can input images directly to albums, fax machines, printers, or electronic
mails using the Acquire button on the Standard toolbar or the Acquire
command in the File menu. Clicking the Acquire button or choosing the
Acquire command brings up a submenu with the following buttons or com-
mands.
• File & Album acquires an image and inserts the file into the active album.

When you select this button or command, the Acquire dialog box opens.
In this dialog box, you can specify the filename and folder of the file to be
created. Once created, a thumbnail of the file is automatically placed in
the currently active album. (If acquiring multiple images, ensure that the
last character in the filename is a number. Album will automatically add
one to this with each successive input.)

If using an auto feed scanner and scanning large numbers of pages with
information on both sides, check the Increase file number by two option.
For the first scan, all files are saved in consecutive odd numbers, for
example, IMG0001.BMP, IMG0003.BMP... When you scan in the reverse
sides of the pages, the files are saved as even numbers, for example,
IMG0002.BMP, IMG0004.BMP... This way you can be sure that the file
order is identical to your page order.

• Fax in B&W acquires an image and sends it as a black and white fax.
• Fax in Color acquires an image and sends it as a colored fax.
• Printer sends an acquired image to your PC’s default printer.

Selecting the Printer button or command opens the Print dialog box from
which you can specify the number of copies to send to the printer. To scale
the file to be as large as possible on the page while maintaining its aspect
ratio, check the Scale to fit the page option. With this option unselected,
the file prints at the size determined by its resolution. To print the
acquired image centered on the page, check both the Center image
horizontally and Center image vertically options.

• e-Mail acquires an image and sends it as e-mail.

Note: Before you use the Acquire command, you may need to select a
TWAIN device from in the Select Source dialog box, opened by choosing the
Select Source command in the File menu.
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Entering field data
After you have finished inserting thumbnails into a new album or have
opened an existing album, you are ready to start entering information about
each thumbnail. The information that you enter can then be used to help
locate and sort thumbnails later on. The following section explains what kind
of information can be accepted by each of the field types.

Note: Fields are defined at the time an album was created. To edit these fields,
see “Editing an album‘s properties”, p.196.

To enter data, you must be in data entry mode, accessed by clicking the Data
Entry Mode button on the Standard toolbar. When you do so, the first
thumbnail in the album, (or the selected thumbnail), appears with all of the
fields associated with that album to the right of it. Place your pointer in one
of the field entry boxes to begin entering data. The scroll buttons along the
top allow you to step forward or backwards through the thumbnails in the
album or jump to the start or end.

Number

Number fields accept any numeric data from 0 to 4,294,967,294. Negative
numbers are not accepted in this field, and if decimals are used, the numbers
after the decimals are truncated. For example, 16.75 becomes 16.

Date

When entering data into date fields, you must use the same short date format
as defined in the Date tab of the Regional Settings dialog box accessed from
the Windows Control Panel. For example, if your date format is YY/MM/DD,
then your date should be 65/10/20. (If the date you enter does not conform to
that format, a message appears requesting you to enter the date again using
the correct format or change your Regional Settings.)

Text

Text fields can hold up to 255 characters and are very flexible as they allow
you to enter a variety of information, all of which you can later search and
sort on.
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Filename

Filename fields can accept a filename of up to 259 characters. When you type
in a filename, you need not include a file extension.

Keyword

Keyword fields allow you to assign keywords or phrases to thumbnails, making
it easy to find files that share common themes. For example, the keyword
“Sports” can be assigned to all those files in an album that are related to
sports. A keyword can consist of one word, such as “sun” or multiple words
such as “sun in Hawaii”.

To edit a keyword list:
1. Click on a Keyword field from the Total fields list in the Field tab of the

New (or Album Properties) dialog box, (see p.177). The Edit Keyword
button appears.

2. Click the Edit Keyword button (the Edit Keyword dialog box opens), and
in the New keyword entry box, type in a keyword.

If there are existing keywords, the Change button is enabled. Clicking
this button changes the highlighted keyword in the list to the keyword
appearing in the New keyword entry box.

3. Click the Add button or press the Enter key. This adds the keyword to the
keywords list box.

To add more keywords repeat this procedure. If you have mistakenly added
the wrong keyword to the list, select that keyword and click the Remove
button. To remove all keywords in the list, click the Remove All button.

4. Click OK. The dialog box closes and the keywords are now included in
the album. (They are not yet, however, assigned to any thumbnails.)

Note: The total number of keywords you can have in an album is 8,000. You
can assign up to 32 keywords to each keyword field, but each keyword
cannot exceed 255 characters.
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Assigning keywords

To assign keywords to a thumbnail, double-click on the appropriate Keyword
field in data entry mode (the Keyword dialog box opens) and select one of
the keywords to assign to the thumbnail from the Current keywords available
list box. Clicking Add places that keyword into the Current
keywords in field list box. Repeat until all keywords for this field are added
and then click OK. (For more information, see the “Creating a database”
tutorial p.61)

Saving and loading keywords

When you create a keyword list, you can save it for use in another album.
To do this, click the Save button in the Edit Keyword dialog box. This opens
the Save Keywords dialog box. Select the path you want to save the keyword
file to and type in a filename, choosing either a DOS or Windows TXT file
format. Use Windows if you are working with Windows, DOS if you want to
transport your file to a DOS application program for editing.

To add keywords from an existing keyword file, click on the Load button in
the Edit Keyword dialog box. The Load Keywords dialog box opens. Choose
the appropriate keyword file and click Open. You will be asked if you want to
retain the current keywords. Selecting YES adds the new keywords to those
currently in the keyword list box; NO replaces the current keywords with
those from the file.

If you are preparing a large number of keywords, you may find it easier to first
compile the keywords in a word processing program and then load them into
an album. Doing so, you can easily edit and, where possible, spell check your
work before assigning keywords to thumbnails. (If using a word processing
program, each keyword must appear on its own line, that is, separated by a
paragraph break.)

List

The data in list fields is taken from a predefined list of values, called a value
list. For example, if you are setting up an employee database, you may have a
list field for marital status. Your value list would provide the values: Single
and Married.
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To create a value list:

1. Click on a list field from the Total fields list in the Field tab of the New
(or Album Properties) dialog box (see p.177). The Edit List button
appears.

2. Click the Edit List button (the Edit List dialog box opens) and in the New
value entry box, type in a word you want the list to contain – for example,
Single.

If there are existing values, the Change button is enabled. Clicking this
button changes the highlighted value in the list to the word appearing in
the New value entry box.

3. Click the Add button or press the Enter key. This adds the word to the
values list box.

To add more values, repeat this procedure. If you have mistakenly added a
wrong value to the list, select that value and click the Remove button.
To remove all values in the list, click the Remove All button.

4. Click OK. The dialog box closes and the values are now available to the
album. (They are not yet, however, assigned to any thumbnails.)

Note: You can have as many as 8,000 values in a single value list.

Assigning value lists

To assign values from a value list, double-click on the appropriate list field in
data entry mode (the List dialog box opens) and select one of the values to
assign to the thumbnail from the Current values available list box. (You can
only assign one value at any time.) The value appears in the New value entry
box. (You can also type in a new value here directly if one does not exist in
the Current values available list box.) Click OK. The value is now added to
the field.

Memo

This a special type of text data. It can contain up to 65,635 characters in a
field and is useful for appending miscellaneous information to a thumbnail.
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Importing field data
If you have database file information from another album or another database
program, such as dBASE IV, you can include it in your current album with
the From File command in the Thumbnail: Import submenu. This opens the
Import dialog box with two tabs: File and Fields. Use the File tab to locate
the database file you want to import and then click on the Fields tab. This
contains two list boxes: Fields in input file and Fields in album. The Fields
in input file list box displays the fields found in the input file and the Fields
in album list box displays the fields in the currently active album.

To import a file, simply drag-and-drop the appropriate fields in the Fields in
album list box. This replaces the field data in the album with that of the
input file.

Note: If there are more records in the input file than thumbnails in the album,
the extra records are discarded. If there are fewer records, the fields are left
empty in the remaining thumbnails.

To compare the values of the input list fields to that of the album, check the
Match field values with album’s fields option. The Treat first record in file
as field names option lets Album know that the first row of information to be
imported contains field names, not field data. When this option is selected,
the field names appear in the Fields in input file list box, allowing you to
quickly match the two lists of fields without making any mistakes.
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Exporting field data to an external file
To save selected field data to an external file, choose the Export command in
the Thumbnail menu. The Export dialog box opens. In the File tab, you can
specify the file name and format of the exported file. You can choose to
export a file as either Formatted Text Files, Tab Delimited Text Files (field
data separated by tabs), Comma Delimited Text Files (field data separated by
commas), and dBase IV Files.

Listed in the Export fields list box in the Fields tab are the fields in the
present album along with the width (the number of characters) reserved for
each field. From here, you can specify which ones to export to an external file
by checking/unchecking them appropriately. You can also drag-and-drop these
selections to change the order that they appear in the file.

From the Character set combo box, you can choose to export the file as
Windows or DOS text. Export the data as DOS text if you plan to import the
data to a DOS program later on. The Store field names as first record in file
option saves the field names of the exported fields in the first row of the file
to facilitate in the importing process.

Notes:
• If there are thumbnails selected in the current album, only the field data from

those selected is exported. To export data of all thumbnails, make sure that
all or none are selected.

• You can have anywhere from 1 to 999 characters reserved for each field.
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Managing thumbnails
Albums are essentially databases that provide an easy-to-use and efficient
way of cataloging and managing files. As with any database, its real worth
is how it allows you to organize, label and search for information related to
these files. This chapter explains how you can do just that, by using visual
marks and a variety of advanced search and sort techniques.
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Maintaining thumbnails
Album allows you to maintain thumbnails so that they always accurately
represent the files that they are associated to. One of the most obvious
methods is to set an album to monitor a particular folder (see p.198).
Any changes made to either a file or the contents of that folder are then
immediately reflected in the album and its thumbnails. If you do not
monitor a folder, you can still maintain thumbnails by either reinserting their
associated files or by choosing one of the update commands from the Thumb-
nail menu.

Updating a thumbnail
There may be times when you need to check a thumbnail to its source file,
for example, the source file may have been removed or its contents changed.
To do this, choose the From Source File command in the Thumbnail: Update
submenu. This performs a check between each selected thumbnail and its
associated file. (Holding the Ctrl+Shift keys down as you choose this
command creates a thumbnail at best quality: holding Ctrl only produces a
good quality thumbnail.)

Note: If you have the Check links to source files option checked in the Album
Preferences dialog box (see p.174), thumbnails are updated whenever the view
in the album changes. To update a large number of thumbnails, it is quicker to
first check this option and then scroll through the album.

Changing a thumbnail’s image
When you first insert the thumbnail of a file, it displays the contents of that
file, when possible. At times you may want to change the thumbnail,
especially for those thumbnails whose contents cannot be displayed,
for example, sound and text files.

When you change a thumbnail, you replace it with image or graphics data
from the clipboard using the From Clipboard command in the Thumbnail:
Update submenu. By doing this, you can use your favorite images to represent
thumbnails or customize thumbnails to represent particular files.
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Relinking thumbnails to their associated files
When the thumbnail of a file is inserted into an album, it maintains a link to
the location of this file. This is why you can manage files by manipulating
their thumbnails. If files have been moved using DOS or Windows Explorer
or if you have remapped your disk drives, Album may lose this link. Thumb-
nails that have lost their link appear with their index numbers grayed-out if
the Check links to source files option is checked in the Album Preferences
dialog box. (The file commands in the Source menu are also disabled for such
thumbnails.) If you want to reestablish the link, you can reinsert the file for
the thumbnail or use the Relink command.

To relink thumbnails:

1. Select the thumbnails that need relinking.

2. Choose “Relink” from the Thumbnail menu. The Relink dialog box opens.
3. Select the drive and folder that contains the files you want to relink the

thumbnails to.

4. Click OK. The dialog box closes and the relinking process begins. The
thumbnails are compared against the files present at the new location;
their paths are updated, and if necessary, so are their thumbnails and
related information.

Preparing CD-ROMs for distribution

The Relink dialog box also includes the option Album drive, which allows
you to link source files to the drive where the album file resides. For example,
if your source file is located in C:\PHOTOS, and the album file is on your
D: drive, then the source location will be changed to D:\PHOTOS. The
advantage of this is that you can move all your files, both album and
associated source files, to another drive or medium, such as CD-ROM, and
still have album accurately locate them. If you do not do this, album will
assume that the files are still at their original location, and thus be unable to
find them.

To distribute albums on a CD-ROM

1. Make sure all the files you want to distribute are in their appropriate
folders, and then choose “Relink” from the Thumbnail menu. The Relink
dialog box opens.

2. Select the Album drive option and click OK. If you have any files not
currently on the same drive as the album file, an error message appears
asking if you still want to link this file. Click YES if you are going to
distribute the file, NO if you are not.

3. Copy all your files to distribute, both source and album, to the CD-ROM.
Be sure to keep the same folder structure as you copy the files. If you use a
different structure, album will be unable to find the source files.
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Annotating a thumbnail
In Album, you can annotate sound, MIDI, video, or animation files to any
thumbnail. This gives you an added dimension to identifying thumbnails, and
is particularly useful if you have audio editing software that allows you to
record audio files (WAV). To annotate a thumbnail, first select the thumbnail
and then choose the Add command in the Thumbnail: Annotation submenu.
The Add Annotation dialog box opens. Locate the multimedia file you want
to annotate and click OK. The dialog box closes and a red music note appears
on the thumbnail slide indicating that it has an annotation. To play the
annotation, double click on the music note.

Note: Checking the Play annotation after viewing thumbnail option in the Album
Preferences dialog box (see p.174), automatically plays the annotation file
whenever you view a thumbnail by double-clicking on it or by choosing the View
command in the Thumbnail menu.

Reordering thumbnail index numbers
Album allows you to freely change the position of thumbnails by either
dragging-and-dropping them to new positions or to sort them in a particular
order through the Sort dialog box, accessed by choosing the Sort command in
the Thumbnail menu. Whenever you rearrange the order of thumbnails,
you may find that their index numbers no longer accurately represent their
position in the album. To reorder these numbers, click the Save button on
the Standard toolbar or choose the Save Sequence command in the Thumb-
nail menu. This automatically changes all index numbers so that they run
consecutively from the first to the last thumbnail in an album.

Note: Save Sequence also compacts albums and should be used before
distributing albums to other users.

Maintaining source files
Once files are represented in an album, you can manage them just as you
would with Windows Explorer. This includes such commands as Open, Move,
Copy, Delete, Create and Remove Folder. All the commands to manage files
are contained in the Source menu. When using these commands, you must
remember that any action performed is done to the actual file. For example,
if you choose the Delete command, the file is removed from disk and cannot
be retrieved unless you have a utility with an undelete function. (To delete
only the thumbnail and not its source file, select it and choose the Clear
command in the Edit menu, or press the Delete key.)
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Note: You can use wildcards when renaming multiple files. For example, the
string “NEW*” will replace the first three characters of all selected files with
NEW.

Opening and viewing files
Album allows you to directly open a file in its associated program by choosing
the O pen com m and [ENTER] in the Source menu. If you only want to see the
file in greater detail and not do any extensive editing, a quicker method is to
choose the View command in the Source menu or double-click on the
thumbnail itself. This opens any image or graphics file in the PhotoImpact
Viewer utility, and any multimedia files in Windows Media Player. Once an
image or graphic is open in a Viewer window, you can copy any area of it or
send the file to another program for further editing.

Note: For more information on how to use the PhotoImpact Viewer, refer to the
program’s on-line Help.

Drag-and-drop the image into
another program

Select files to open

Zoom in or out
on the image

Access
PhotoImpact

Display Global
Viewer

Access another editing
program of your choice

Display file properties
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Converting a file’s format and/or data type
Choosing the Convert command in the Source menu allows you to convert
image and graphics files to other file formats and data types. This command
can be applied to individual or multiple files, sharing the same or different file
formats and data types.

Being able to change the file format is particularly useful when you want to
open a file in a program that doesn’t support that file’s current format,
for example, changing TIF files to a BMP format so they can be opened in
Windows Paintbrush. Changing the data type is also useful when you are
preparing a large number of images for publication and wish to, for example,
convert your images from True Color to Grayscale.

Printing a file
If you want to print the file of a thumbnail, choose the Print command in the
Source menu. The Print dialog box opens. In the Copies entry box, enter the
number of copies to be printed. Checking the Scale to fit the page option
scales the file to be as large as possible on the page while maintaining its
aspect ratio. With this option unselected, the file prints at the size determined
by its resolution. The Center image horizontally and Center image vertically
options allow you to choose where images print on the page. If both options
are selected, images print centered on the page.

Note: For some application-linked files, their associated program will be called
up to print the file. Once printed, the program will close. For example, to print a
Write document, Write is opened with the selected document in the workspace
and its Print dialog box also appears.

Changing the program association of a file
The Associate command in the Source menu allows you to change the
association of a file with a particular program. You will want to change the
association of a file when, for example, you double-click on a filename in
Windows Explorer and the file opens in a different program than expected.
(Such situations often happen when you use different programs to work on
the same file.)

Choosing the Associate command opens the Associate dialog box. In this
dialog box, you can specify the file extension whose program association you
want to change. If you do not select any thumbnails, this command affects all
thumbnail files sharing the same extension.
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Displaying a file’s properties
Clicking the Properties button on the Standard toolbar or choosing the
Properties com m and [ALT+ENTER] in the Source menu allows you to change the
attributes of the file whose thumbnail is selected. These attributes can be:
Read-only, Archived, Hidden, or System. A read-only file allows you to open
the file but prevents any changes from being saved to it. This is useful when
sharing files over a network and you do not want anyone changing the
content of your files. The Archived attribute identifies those files which have
been updated since their last save. Selecting the Hidden attribute hides files
from view, and System marks files as MS-DOS system files, also hiding them
from view.

Performing a slide show presentation
Album provides a slide show feature which allows you to showcase your
image, graphics and sound files. This includes using impressive transition
effects and providing manual or automatic playing. To run the slide show,
click the Slide Show button on the Standard toolbar or choose the Slide
Show command in the View menu.

Note: Once you have played a slide show, you may want to retain the same
slide show settings for future use. To do this, click the Save button to save your
settings to file. Click the Load button to bring your settings back for another
slide show .

SLIDE SHOW DIALOG BOX: GENERAL TAB

1
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7
8

11
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10
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1

2

3

4

5

6

7

8

9

10

11

Effect contains a number of transitions that control the way one slide is
replaced by the next.

Speed controls the speed of the transition effect between slides.
Delay specifies how much time elaspes before the next slide starts to display.
Synchronize with audio files  displays a new slide once an audio file has

finished playing.
Control manually with keyboard or mouse  allows you to manually change

slides by clicking your mouse or pressing a key. Check the Control panel option
to display a navigation panel at the bottom of the presentation screen.

Repeat continuously  runs the slide show nonstop. Check this if you wish
to use your slide show as a screen saver or to have it run continuously in the
background.

Resize large images to fit screen  ensures that images too large for your
current display are resized accordingly so that they can be seen in their entirety.

Use a common palette to show images  is only enabled in 256-Color display
mode and uses the system palette to show images.

Display true color images at best quality  is only enabled in 256-Color
display mode and ensures the best possible display of True Color images.

Hide pointer hides the pointer during a slide show. To stop the slide show,
press the Esc key.

Play audio annotation  plays any audio files annotated to files appearing in
the slide show. This is a good way to present a file and then have a narration
following to explain what the file is or represents.

SLIDE SHOW DIALOG BOX: TEXT & COLOR TAB

The Text & Color tab allows you to append information to the files in a slide show
as well as control the background color of the presentation. You can also specify
where on the screen you want the information to appear, such as lower right
corner or above each slide.

SLIDE SHOW DIALOG BOX: MUSIC TAB

The Music tab allows you to add background music to a presentation using MIDI
and/or sound files (WAV). If you are playing only one file, make sure that you
check the Repeat continuously option so that the file doesn't stop while the
presentation continues.
Note: If you have the Synchronize with audio files option checked, the time
specified in the Delay option is used as a pause between each audio file.
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Locating thumbnails
Album brings with it a variety of commands and features giving you the most
efficient means of locating thumbnails and their associated files. For example,
you can use the Sort command in the Thumbnail menu to organize thumb-
nails according to various file properties such as filenames and file sizes.
Another method is to use the Search toolbar for quick, on-the-spot searches,
while for more complex and involved searches, you can use the Search dialog
box.

Before you begin performing searches, however, you need to have a clear idea
of some of the logic behind them. The following section explains this logic
and will help you better understand the power and possibilities of performing
searches with Album.

Search criteria and queries
Whenever you perform a search, you must first specify what it is you want to
search on. This is called the query. A query can consist of a single or multiple
number of items, or criteria. For example, if you have chosen the query,
filenames, the criteria would be the filename you are looking for.

Note: If the criteria consists of more than one word, you must encase it with a
delimiter, for example, “New York”.

Logical operators
One of the more powerful features of Album is its use of logical (Boolean)
operators: Not, And, Or and ( ). These allow you to search through a vast
number of files quickly, looking only for specific file features. Below is a brief
description of how each of the operators work.

Not, is used to define the opposite of the indicated criteria. This allows you
to isolate thumbnails whose attributes make it a minority in an album. For
example, in an album consisting largely of TIF files, performing a file format
search, “Not *.TIF”, results in all thumbnails, except those linked to TIF files,
being displayed.

And, allows you to specify more than one criteria to search on. (Matching
thumbnails must meet all of these criteria.) For example, to find thumbnails
about your holiday in Spain, you could perform a search on – “holidays And
Spain”. All thumbnails with the words holiday and Spain will be displayed.
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Or, allows you to match thumbnails that meet one or more of a specified
criteria. For example, performing a filename search on, “F*.* Or G*.*”,
will display all those thumbnails whose files begin with an F or G.

( ), the parenthesis are used to group criteria together. This is particularly
important if you have several criteria, some of which must be paired together.
For example, if you are searching on the values, A, B and C, then you could
define the search as, “A And (B Or C)”, or “(A And B) Or C”. In the first
example, the thumbnails must have A and either B or C. In the second
example, the thumbnails must have either A and B together, or C only.

Note: To use an operator, double-click (or select) the desired operator in any of
the dialog boxes that support this feature. The operator then appears in the
Query entry box. To add additional operators, simply repeat this procedure.

Search operators
Operators are characters or phrases that help define the range of a search.
Most of the search operators are quite self-explanatory – for example,
= (equals to), > (greater than), < (less than) and <> (not equal to).
However, there are two that require some clarification: “Contains” and
“Empty”. Both are operators that appear whenever you have a query
consisting of text, memo, list, mark, and keyword fields.

The Contains search operator instructs Album to find all thumbnails that
contain whatever is entered in the Query entry box in the searched field.
For keyword and list fields, the Start with option appears to the right of the
Query entry box. Selecting this option tells Album to search for thumbnails
that have keywords or values that begin with the entered text.

The Empty search operator, on the other hand, instructs Album to find all
thumbnails with nothing entered into the searched field. This is particularly
useful when you want to locate thumbnails that have empty fields you would
like to complete.

About delimiters

Whenever you enter a criteria description that exceeds one word, you must
encase it with a delimiter. For example, the word Holiday does not need a
delimiter, however, “Holiday in Hawaii” does. Delimiters work by instructing
Album to treat whatever it finds within the delimiter as a single string. In the
Album Preferences dialog box (see p.174) and Search dialog box, you can
specify the type of delimiter you want to use – for example, double quotes
(“ ”). This allows you to choose a key that is more familiar or easier to access.

Note: The delimiter you use in a criteria description must be the same as that
specified in the Album Preferences dialog box (see p.174).
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Match case and match whole word
When performing a search on text, many of the search options allow you to
“Match Case” or “Whole Word”. Matching case tells Album to find those
thumbnails matching the upper or lower case of the query. For example,
to match the case of “New York”, only New York would be selected, any
variations, such as “new York” or “NEW YORK” would be ignored.

Matching the whole word searches on occurrences of a defined word.
For example, to match the word “man”, only “man” would be selected, not
“woman”. If this option is left unchecked, any occurrence of the letters (not
the word), m-a-n would be selected, such as “man”, “manage” and “human”.

Note: Selecting Match whole word performs a search much quicker than leaving
this option unselected as Album only has to search for words, not sequences of
characters.

Start with

Check the Start with option if you want thumbnails with words that begin
with the entered text in the specified keyword or list field. For example,
if you entered “ch” in the Query entry box, then all thumbnails with words
that begin with “ch” in the specified keyword or list field will be displayed.

Performing a search
Performing a search can be as simple, or as complex, as you want to make it.
In most cases you will be performing simple, single criteria searches which are
best done from the Search toolbar. If you want more control over the search
process, choose the Search command in the Thumbnail menu.

Some notes before you start performing a search:
• Since it is not possible to itemize all the possible search variations here,

the best thing to do is to read the previous section on search basics and
then experiment with your own variations.

• Some queries and criteria can be very complex and involved. Try first
working out your search on paper before entering it

• Whenever you perform a search, the search is done only on the thumb-
nails in the current view of the active album. If you want to perform a
search on all thumbnails in an album, make sure you click on the View
All button or select the All command in the View menu. The next time
Album performs a search, all thumbnails in the album will be included,
irrespective of the results of the previous search or current view.
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To perform a search using the Search dialog box:

1. Click the Search button on the Standard toolbar or choose “Search”
[CTRL+F] from the Thumbnail menu. The Search dialog box opens.

2. Select the query you wish to search on from the Search Type combo box
in the Search criteria group box. Depending on the query chosen, define
your criteria.

To further edit a criteria, click the Edit Criteria button. The Edit Search
Criteria dialog box opens. Here you can specify to match the whole word
or its case, as well as use a logical operator and delimiter,
(if necessary).

3. Click the Add button. The query is now placed in the Search Criteria
window beneath.

To include additional criteria, repeat step 2. To change a query, select the
query in the Search criteria window and redefine the criteria and query in
the Search criteria group box. This time, when you are ready to add the
query, click the Change button. This replaces the query selected in the
Search criteria window with the new one. To remove a query, highlight it
and then click the Remove button.

4. To search on all albums in the workspace, check the Search all open
albums except minimized option in the Search option group box. Check
the Search entire folder option to search for all thumbnails in the current
folder.
To combine the thumbnails of successive searches, check the Add search
result to current view option. (You can also select and deselect these
options from the Thumbnail menu.)

Notice that when the Search all open albums except minimized option is
checked, the Search type combo box only lists the user-defined fields that
are common to all albums. Fields are considered as common if they have
the same field name, field type, and keyword/list definitions.

5. In the Action to take group box, check the View matched thumbnails
option to display the matching thumbnails or the Select matched thumb-
nails option to select the matching thumbnails.

6. Click the Save Query button to save the query for future use or editing.
This brings up the Save Query dialog box which prompts you for the query
name. Type in a name in the Query entry box and press Enter. To remove
an existing query, highlight it and click the Remove button. To edit a
query, select it from the Query entry box, the contents of the query are
displayed in the list box.
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7. Click OK. The search is performed and, if you defined a query, the query is
saved and any thumbnails matching the search criteria are displayed in the
album.

Note Depending on the media type and file format of the thumbnail files,
some search options may be disabled.

Using the Search toolbar
Many of the search criteria found in the Search dialog box can also be
accessed directly from the Search toolbar. You will find the Search toolbar a
much more convenient and quicker way of performing single criteria searches.
To use the Search toolbar, select a query to search on from  the Search type
combo box, the first on the left. The toolbar changes and, depending on the
query itself, displays a Search operator combo box as well as a Criteria entry
box. Select an operator and then enter in the description of the criteria you
want to search on. Clicking the Search button then performs the search, and
any thumbnails matching the search criteria are displayed in the album.

Note: To quickly perform a search using an existing query, choose Query from
the Search Type combo box. In the combo box that appears, select the query
and then click on the search button.

Defining marks
Marks serve as visual tags for thumbnails in albums. In a sense they are very
similar to keywords differing only in implementation. Whereas keywords work
“behind the scenes”, marks are clearly displayed on the thumbnail slide. You
will find marks particularly useful when you want to quickly navigate around
an album and pinpoint certain thumbnails for future operations.

Assigning marks
To assign marks, you need to use the Mark panel. This is a floating panel that
allows you to assign up to 26 marks to thumbnails. Each mark is represented
by a letter of the alphabet, and once assigned, the letter is displayed next to
the index number on the thumbnail slide.

Note: If the Mark panel is not open, choose the Toolbars & Panels command in
the View menu to open the Toolbars & Panels dialog box. Check the Mark panel
option, and the Mark panel opens. (The same command can also be accessed
by right mouse clicking on a toolbar.)



CHAPTER TEN220

To assign a mark:

1. Double-click on any letter in the Mark panel, the Edit Marks dialog box
opens.

2. Select the letter you want to assign from the Marks list box. In the Mark
name entry box, type in a description (up to 31 characters).

You can edit and assign descriptions to any mark by simply clicking on it
and then entering a description in the Mark name entry box. If you wish
to use marks already present in another album, select the album from the
Adopt marks from album combo box. The marks, if any, appear
immediately in the Marks list box.

3. Click OK. The dialog box closes, returning you to the Album window.
The mark description now appears in the Mark panel.

4. Click on the mark you want to assign in the Mark panel. The View Marks
and Assign Marks buttons are enabled.

To assign multiple marks, hold down the Ctrl key and click on each mark
to select it. (Clicking again deselects the mark.) To select a range of
marks, click on the first mark in the range, and, holding down the Shift
key, click on the last. All marks in the range are selected. (Dragging your
mouse over the marks performs the same function.)

5. Click the Assign Marks button, the button changes to Stop, and click on
the thumbnail you wish to mark. The letter of the mark is immediately
shown on the top left corner of the thumbnail slide, next to the index
number. (Clicking again removes the mark.) Repeat this step if you want
to assign the same mark to another thumbnail.

6. When you have finished assigning the current mark, click the Stop button
on the Mark panel, the button changes back to Assign Mark.

To assign another mark repeat steps 6 and 7. (You can assign more than
one mark to the same thumbnail.)

Note: To remove the Mark panel, double-click on the title bar or uncheck the
Mark Panel option in the Toolbars & Panels dialog box.
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Viewing marks
The advantage of using marks is that they are quick and easy to apply and
you can see which thumbnails have been marked accordingly. When you want
to view marked thumbnails the procedure is just as convenient.

Note: If the Mark panel is not opened, choose the Toolbars & Panels command
in the View menu to open the Toolbars & Panels dialog box. Check the  Mark
panel option, and the Mark panel opens. (The same command can also be
accessed by right mouse clicking on a toolbar.)

To view marked thumbnails:

1. Select the letter or letters in the Mark panel you wish to view.

To select individual marks, hold down the Ctrl key and click on the mark
to select it. (Clicking again deselects the mark.) To select a range of
marks, click on the first mark in the range, and holding down the Shift
key, click on the last. All marks in the range are selected. (Dragging your
mouse over the marks performs the same function.)

2. Click the View Marks button, a menu opens with the commands And, Or,
and View All. Choosing And immediately displays those thumbnails that
contain all the selected marks. For example, if you have selected the
marks A, B and C, only those thumbnails with the marks A, B and C are
displayed. Choosing the Or command displays those thumbnails with one
or more of the selected marks.

Managing marks
When it comes to managing marks in an album, you can choose from a
number of commands accessed by clicking the Mark panel Menu button on
the Mark panel. These commands are particularly helpful when you want to
perform batch operations over a large number of thumbnails.

Performing a batch mark assignment

To assign the same mark to many thumbnails, you can mark each one
individually, as demonstrated in the previous procedure, or first select them
and then use the Assign Selected command in the Mark panel Menu.
This automatically affixes the currently selected mark or marks to the selected
thumbnails.
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Removing marks

To remove specific marks from thumbnails, first select the marks you want
to remove and then select the thumbnails you want to remove them from.
Click the Mark panel Menu button in the Mark panel, and choose the
Clear Selected command. The selected marks are then removed from the
appropriate thumbnails. To remove all the selected marks in the active album,
choose the Clear All command.

Loading and saving marks

Whenever you assign a mark, it is recorded as an MRK file in the
ULEAD.DAT folder. If other people share the same album, you can send
this file to them and have them load it into their machine using the Load
command in the Mark panel menu. This provides you with a convenient
method of bringing to the attention of another user any thumbnails you may
want to highlight. To only send the marks of a few thumbnails, select the
concerned thumbnails and then save these as a new MRK file with the Save
command.

Converting marks to keywords

There may be times when you would like to use the same mark as a keyword.
The Convert to Keywords command in the Mark panel Menu allows you to
include the mark in a thumbnail’s properties, as well as use the mark when
performing more complex searches. You may also find it easier to define
keywords in this way rather then using the Data Entry mode.



Index
The index is a vital part of this user guide as it provides a quick and easy
reference to the commands, tools and features of PhotoImpact. At the end
of this index there are also menu and screen references which provide a
graphical way for you to find information about any of the screen elements
and menu commands in both PhotoImpact and PhotoImpact Album.

Index
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retouching   123
rotating   155
saving   80
saving from clipboard to disk   90
sending by e-mail   80
stitching   167
styling   101
transforming   150
warping   111
zooming   92

Importing field data   205
Index numbers, changing   210
Input devices, calibrating   164
Inserting thumbnails   198
Installing PhotoImpact   9

K

Keywords
assigning   203
creating list   202
loading   203
saving   203

L

Lasso tool   133
Layer Manager   141
Linking

editing objects   190
from Album   190
from PhotoImpact   95

G

Global Viewer   93
Gradient Gallery   128

H

Halftones   84

I

Image masks
creating   139
editing   140
using   140

Image source, selecting   162
Image styling, drag-and-drop   102
Images

acquiring from Album   200
acquiring from PhotoImpact   163
adjusting for video   114
changing dimensions   151
changing resolution   151
cloning   125
converting   152

B&W to Grayscale   152
CMYK to True Color   155
Grayscale to B&W   152
True Color to CMYK   154
True Color to 16-Color   153
True Color to 256-Color   154

creating   78
cropping   150
distorting   111
duplicating   79
enhancing   97
enhancing automatically   90
erasing colors from   124
filling with color   126
fitting to window   94
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Lists, assigning values   204
Loading

color tables   119
image files onto the clipboard   90
keywords   203
marks   222

Locating thumbnails   215
Logical operators   215

M

Magic Wand tool   134
Maintaining

source files   210
thumbnails   208

Mapping curves   104
Mark panel   219
Marks

assigning   219
assigning in batch form   221
converting to keywords   222
loading   222
managing   221
removing   222
saving   222
viewing   221

Mask Brush tool   135
Modes

attribute   180
compact   189
data entry   180
filename   180
normal   189
painting   122
path   158
sharing   195
thumbnail   179

Monitoring folder   198
My Gallery   122

N

Non-UFO files, saving   80
Normal mode   189
NTSC filter   114

O

Object Library   146
Objects   132

copying   88
cutting   88
filling with color   126

OLE
Album   189
PhotoImpact   95
representation in Album   176

Opening
albums   68
images   77
source files   211

P

Paint mode, specifying   122
Paint modes

Connected Lines   122
Freehand   122
Straight Lines   122

Paint tool attributes, saving   122
Paint tools

applying   120
selecting   120
using   120

Painting on selections   122
Panels

Color   116
Mark   219
Tool

Album   185
PhotoImpact   235

Quick Command   81
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Password, assigning   198
Pasting

as a new image   90
as an object   88
by mouse position   90
data into images   88
field data   184
into selection areas   89
to fit into selection areas   89

Path shape   158
Path tool   157
Paths

distorting   158
editing   158
filling   160

Performing searches   217
PhotoImpact

Album   13
Capture   14
CD Browser   183
Explorer   182
PhotoImpact   11
Viewer   211

Post-processing after scanning   165
Preferences

Album   174
PhotoImpact   72

Print Preview   82
Printers

calibrating   83
PostScript   86

Printing
images   82
options   85
source files   212
thumbnails   184

Printing images   82
Program association, changing   212
Program menus, removing   94

Q

Quick Command panel   81

R

Recovering from mistakes   81
Redo commands   82
Relinking thumbnails   209
Removing

annotations   210
program menus   94

Resampling images   151
Resizing images   150
Restoring

albums   194
images   82

Retouch tools   123
Retouching images   123
Rotating and flipping images   155

S

Saving
color tables   119
images   80
images from clipboard to disk   90
keywords   203
marks   222
non-UFO files   80
painting tool attributes   122
UFO files   80

Scanner   200
Scanning files   181
Scrolling albums   181
Search

simple   219
toolbar   219
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Searching   217
boolean operators   215
criteria and queries   215
logical operators   215
matching case   217
matching whole word   217
search operators   216

Search toolbar   219
Selecting

colors
with Eyedropper   118
with Ulead color picker   117
with Windows color picker   117

image source   162
Selection areas   132

copying   88
cutting   88
filling with color   126

Selection marquees   132
Sending

albums   195
images   80

Setting the size
cache area   81
custom area   81

Sharing albums   195
Sharpening images   111
Shelf

placing albums on   178
retrieving albums   178
using   178

Slide shows
creating   213

Sorting thumbnails   215
Sort toolbar   233
Source files

converting   212
opening   211
printing   212
viewing   211

Special effects   107

Standard Selection tool   133
Standard toolbar

Album   233
PhotoImpact   235

Status bar, Album   233
Stitching images

automatically   168, 169
by defining reference points   171
manually  170

Style Gallery   102
Styling images   101
Switching to

compact mode   189
normal mode   189

T

Tabs
changing category   181
changing width   175
displaying   181

Text
adding to images   130
manipulating   130

Text path, editing   130
Text shape, distorting   130
Text tool   130
Texture Gallery

custom   128
magic   128
natural   128

Thumbnails
adding annotations   210
assigning keywords   202
changing   208
checking   192
copying   184
cutting   184
inserting   198
locating   215
printing   184
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relinking   192, 209
removing annotations   210
searching   215
sorting   215
updating   192, 208

Tone mapper   104
Tone mapper curve   105
Tool panel, PhotoImpact

Clone tools   125
Eraser tools   124
Eyedropper tool   118
Fill tools   126
Lasso tool   133
Magic Wand tool   134
Mask Brush tool   135
Paint tools   120
Path tool   157
Retouch tools   123
Standard Selection tool   133
Text tool   130
Transform tool   155
Zoom tool   92

Tool panel, Album   185
adding program icons   186
removing program icons   186
repositioning   187

Tracing selection marquees   157
Transform tool   155
TWAIN   162

U

UFO files, saving   80
Ulead Color Picker   117
Undo/redo list

adjusting   72
clearing   82

Undoing commands   81
Updating albums   192

V

Value lists, assigning   204
View

adding   93
controlling   92

Viewing   179
album properties   196
Auto Scroll   181
by tabs   181
full screen   94
global viewer   93
in compact mode   189
in normal mode   189
marked thumbnails   221
Photo CDs   183
Scroll to   181
scrolling   181
slide shows   213
source files   211
source properties   213
zooming   92

Viewing mode
attribute   180
changing   179
data entry   180
filename   180
thumbnail   179

W

Wallpaper, changing   114
Warping images   111
Windows Color Picker   117
Working with halftones   84

Z

Zooming images   92
Zoom tool   92
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Album Menu Reference
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Create a new album

Open an album

Save thumbnail order

Print specified thumbnails

Preview before printing

Paste information from the
clipboard into a field

Copy thumbnails or field
data onto the clipboard

Move thumbnail from an
album to the clipboard

Perform
slide show

Display file
information

Open Sort dialog box

Open Search dialog box

View in filename mode

View in data entry mode

View in thumbnail
mode

View in attribute
mode

Edit search
criteria

View All

Perform Search

Search
Operator Query Search options

Sort by

Sort thumbnails by size

Sort thumbnails by type

Sort thumbnails by name

Sort thumbnails by date

Auto
Scroll
dial

Program
Icons

Configure

View Marks

Assign Marks

Mark Panel Menu

Acquire an
image from
a TWAIN
device

Mark panel

Search toolbar

Standard toolbar

Sort toolbar Tool panel

Number of selected thumbnails in tab

Number of thumbnails in tab

Number of thumbnails in album

Compact Mode/
Display Menu

Albums in
Workspace

Viewing Mode Layout
Thumbnail

Size

Albums on
Shelf

Status bar

Album Screen Reference

Search
Type
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PhotoImpact Menu Reference
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Create standard selection

Create freehand selection

Create selection area
based on similar colors

Select color

Change zoom level

Transform object or
selection
Retouch an image

Paint colors on
an image

Erase to another color

Fill an area with color

Edit vector paths

Place or edit text

Save image

Open a file

Create a new image

Print an image

Preview before
printing

Move selection
from PhotoImpact
onto the clipboard

Redo

Undo

Paste information from the
clipboard as a new object

Copy selection
onto the clipboard

Acquire an image

Auto Process

Color Balance

EasyPalette

Add frame and shadow

Brightness & Contrast

Zoom Level

Layout

Tile EasyPalette

Palette
Switch

Foreground
Color

Background
Color

Color
Cache

Color
Palette

Dynamic
Color

Control

Custom
Area

Cache
Area

Access
galleries,
Layer
Manager,
and
Object
Library

Standard toolbar

Color panel

EasyPalette

Quick Command panel

Select colors

Change zoom level

Transform an object
or selection
Retouch an image

Paint colors on
an image

Erase to another color

Fill an area with color

Edit vector paths

Place or edit text

Save image

Open a file

Create a new image

Print an image

Preview before
printing

Move selection
from PhotoImpact
onto the clipboard

Redo

Undo

Paste information from the
clipboard as a new object

Copy selection
onto the clipboard

Acquire an image

Auto Process

Color Balance

EasyPalette

Add frame and shadow

Brightness & Contrast

Zoom Level

Layout

Tile EasyPalette

Palette
Switch

Foreground
Color

Background
Color

Color
Cache

Color
Palette

Quick
Color

Control

Custom
Area

Cache
Area

Access
galleries,
Layer
Manager,
and
Object
Library

Standard toolbar

Color panel

EasyPalette

Quick Command panel

Tile with Album

PhotoImpact Screen Reference

Tool panel

Create freehand selection

Create standard selection

Paint a selection area

Create selection area
based on similar colors

Clone an image


